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Trwéce khi dung may tinh

DPoc muc nay truwéc

| Vé Hwéng dan sir dung nay

« CASIO Computer Co., Ltd. khéng chiju trach nhiém véi béat ky ai trong
bat ky sw ¢b nao vé nhirng hw hdng d&c biét, phu thém, tinh c& hay hé
luy c6 lién quan t&i hay phat sinh tir viéc mua hay dung san pham nay
va cac khoan muc di cung né. Hon nira, CASIO Computer Co., Ltd. sé
khéng chiju trach nhiém vé bét ki 1&i khiéu nai thudc bat ki loai nao vé
bat ki cai gi b&i bat ki bén nao nay sinh tr viéc dung sadn phadm nay va
cac khoan muc di cung né.

« C4c nodi dung trong hwéng dan st dung nay cé thé dwoc thay dbi ma
khéng can bao trwéc.

« C4c hién thi va hinh minh hoa (nhw cac nhan phim) dwoc trinh bay
trong hwéng dan sir dung nay chi dwoe dung véi muce dich minh hoa, va
c6 thé khac véi cac muc thue té ma chung thé hién.

* QR Code la nhan hiéu thwong mai da dwgc dang ky cia DENSO WAVE
INCORPORATED tai Nhat Ban va cac qudc gia khac.

« Tén codng ty va tén san phadm dwoc dung trong hwéng dan str dung
nay co thé 1a thwong hiéu da dang ky hay thwong hiéu cia chi s& hiru
twong ng.

| Cac thao tac phim

Vi du bén dwéi minh hoa cho cach thao tac phim dwoc dé cap trong
hwéng dan sir dung nay.

Vidutl: @@ @&

Phai nhan cac phim theo trinh tw dwa ra & trén (trai sang phai).

¥or @ ¥or [ i

! )

(Ac) —= —_—

@Q&

Vidu2: ® @ (n)*

Vi du trén chi ra rang ban nén nhan @® va sau dé 1a (@), thao tac nay sé
nhap ky hiéu z. T4t ca thao tdc nhap bang nhiéu phim dwoc biéu thi bang
cach nay. Cac nhan trén nat phim dwoc hién thi, tiép theo 1a ky tw nhap
hodc I&énh trong ddu ngodc don.



Voo [ Voo [

—_—

® D(n)

* Tham khao muc "Nhan phim" (trang 14) dé biét thém thong tin vé cac
biéu twong phim dwoc s dung trong vi du nay.

®,0,0,,ArAY

(1) (2)

« Céac phim con tré riéng dworc biéu thi chung 1a (1) sé dwoc thé hién duai
dang ®, ©, ©, ®.

» Cac phim cudn trang riéng dwoc biéu thi chung la (2) sé dwoc thé hién

dwai dang (), .
| Cac thao tac menu

Mot sé thao tac trong hwéng dan str dung nay st dung dang don gian hoa
clia cac thao tac trén menu, nhw thé hién trong cac vi du dudi day.

Vidu 1

— [Other] > [7]

hoac

Nhan @), sau dé chon [Other] > [x].

Thao tac thwc té 1

1. Nhadn @.
2. St dung ® va ) dé chon [Other], sau d6 nhan @.
3. Str dung @ va & dé chon [z], sau d6 nhan @,




Vi du 2

©) - Calculate

hoac

Nhan @), chon biéu twong trng dung Calculate, sau d6 nhan @K).

Thao tac thuc té 2

1.Nhan ©.
2. Sr dung cac phim con trd (A, @, X, ) dé chon biéu twong &ng
dung Calculate, sau d6 nhan @¥).

| Phim @ va Phim @

Phim @ va phim @ thwc hién cung mét thao tac. Trong hwéng dan sk
dung nay, duwoc sir dung dé Iwa chon hay ap dung cai dat, trong khi @
duoc st dung dé thwe hién tinh toan. Tuy nhién, lwu y rang khang cé gi
khac nhau néu ban nhan @) hodc @ cho cac thao tac cé hién thi @ hoic
€.

J Vidu

Néu ban khéng dwoc hwéng dan sir dung mot rng dung may tinh cu thé
ho&c dé& ciu hinh cac cai d&t cu thé cho thao tac vi du, ’ng dung va céac
cai dat dwdi day sé dugc gia dinh.

ng dung may tinh: Calculate

Cai dat: Cai dat may tinh méc dinh ban du
Dé biét thong tin vé cach dwa may tinh vé cai dat mac dinh ban dau, vui
long xem "Kh&i ddong may tinh" (trang 8).

Kh&i ddng may tinh

Quan trong!

* Quy trinh dwdi day sé khéi dong tat ca cai dat ciia may tinh, ngoai trir Contrast, Auto
Power Off, va Language. Ddng thoi ciling x6a tat ca di¥ liéu dwoc lwu trong bd nhé
may tinh.

1. Nhan @ dé hién thi man hinh HOME.

2. S dung cac phim con trd (A, @, X, ) dé chon biéu twong tng
dung may tinh, sau d6 nhan @%.

3. Nhan &), sau d6 chon [Reset] > [Initialize All] > [Yes].
« Thao tac nay sé hién thi man hinh HOME.



Man hinh "Get Started"” cua may tinh

Khi man hinh HOME dwoc hién thi, nhan phim & sé& hién thi man hinh

"Get Started", man hinh nay bao gdm céc thong tin dwéi day.

* QR Code dé truy cap trang web "Get Started" ctia Worldwide Education
Service (https://wes.casio.com/calc/cw/)
Trang web Get Started cip ban quyén truy cap vao Hwéng dan sir dung
va théng tin lién quan khac dé giup ban bat dau st dung may tinh cla
minh.

« M3 s6 ID may tinh (chudi 24 ky tw)

Nhan & dé tré vé man hinh HOME.

Lwuy

« Ban ciing c6 thé hién thi man hinh Get Started, bang cach chon man hinh dé tir menu
SETTINGS. Vui long xem "Str dung Menu SETTINGS" (trang 20).

Than trong

| Nhitng lwu y an toan

Cam on ban da mua sadn pham CASIO nay.

Hay d&m bao réng ban da doc "Nhirng lwu y an toan" trwéc khi st dung
san phadm nay dé dung san pham dung cach. Hay chac chan |a gilr tat ca
céc tai liéu ngudi dung trong tay dé tham khao trong twong lai.



Canh bao
Biéu thj diéu gi d6 c6 thé gay ra nguy co tir vong hodc thwong
tich ca nhan nghiém trong.

EMan hinh hién thj
® Khéng nhan vao hodc dé man hinh LCD bj va cham manh.

Lam nhw vay cé thé khién mét kinh LCD bi nirt, gay ra nguy co thuwong
tich ca nhan.

® Néu man hinh LCD bi nit, tuyét d6i khéng cham vao bét ky
chéat 16ng nao bén trong.

Chét 16ng clia man hinh LCD dinh 1&n da sé& gay ra nguy co kich &ng
da.

Néu chét 16ng ctia man hinh LCD roi vao miéng ctia ban, hay stc
miéng ngay va lién hé v&i bac si cla ban.

Néu chét 16ng ciia man hinh LCD dinh vao méat hodc da, hay rira sach
bang nwéc sach va sau do lién hé véi bac si cda ban.

EBién phap phong ngtra vé pin
Néu chét 16ng ro ri ttr pin dinh vao da hodc quan 4o cua ban,
hay ritra sach ngay bang nwéc sach.

Chét 16ng trong pin dinh vao mét sé gay nguy co suy gidm thj luc, v.v...
Vi vay, hay rira sach mat va sau do lién hé ngay véi bac si.

Can trong
Biéu thj diéu gi d6 c6 thé gay ra nguy co thwong tich ca nhan
nhe hodc thiét hai vat chét.

Hay tuan tha nhirng Iwu y dwéi day. Néu khéng lam nhw vay cé thé
khién pin bj v&, gay ra nguy co héa hoan, thwong tich ca nhan, va
lam ban cac vat xung quanh do ro ri chat Iéng.

« Khéng cb thao roi pin va tuyét dbi khéng dé pin bi doan mach.
* Khéng sac pin loai khéng sac dwgrc.

+ Khéng dé pin tiép xuc véi nhiét hodc ném pin vao Ira.

* Chi st dung loai pin dwgc chi dinh.

« Lap pin dung vé&i cac cuc (cwc dwong (+) va cuwc am (-)).

« Thay pin cang s&m cang tét sau khi hét pin.

10




A E]E Bién phap phong ngtra vé pin

o Hay tuan thua nhirng lwu y dwéi day. Khong lam nhw vay cé
thé gay né pin hoac lam ro ri chat 16ng hoic khi dé chay.

« Chi str dung loai pin dwoc chi dinh cho san pham nay.

« Khéng dbt ho&c virt bd pin vao 16 dbt rac, hay nghién hodc cat pin
bang may mac.

« Khéng dé pin & nhiét d6 qua cao hodc qua thap trong qua trinh st
dung, bdo quan hodc van chuyén.

« Khéng dé pin chiu ap suét khi quyén qué thap trong qua trinh st
dung, bdo quan hodc van chuyén.

| Nhitng lwu y sir dung

« Cho du may tinh dang hoat ddng binh thwdng, hay thay pin it nhat hai
nam mot lan (RO3).

« Ban sé phai tra phi dbi v&i truc trdc hodc hw hdng do rd ri pin ma khong
dwoc bao hanh.

« Pin di cung may tinh c6 thé bi hao hut trong thoi gian giao hang va cét
gitr. B&i vay tudi tho clia pin sé bj gidm dan dén viéc pin sé bj thay sém
hon dw kién.

« Tranh dung va cét giir may tinh trong khu vwc cé nhiét d6 cwe doan, va
moi trwdng Am wét va nhiéu bui.

« Blrng d& may tinh bj va cham, bj ép hay uén cong qua murc.

» Birng bao gi¢ thr thao r&i may tinh ra.

« Dung vai mém, khé dé lau bén ngoai may tinh tay.

« B4t ki khi ndao virt bd may tinh hay pin, hdy chac chan lam theo luat va
quy dinh cta khu vwc ban &.

Bat dau

| Gan va thao vé truwére

Pé thao vo trudc

Trwée khi st dung may tinh, thao vé trudc (1) ra va gan vao phia sau

(@).

1



o trwéc

z
<

éganv

b

Khi ban khéng s dung may tinh, thdo vé trwédc (1) ra va gén vao phia

truec (2)).

12



Quan trong!

« Luén gan v trwéc vao may tinh bat clr khi nao ban khéng str dung. Néu khong, viéc
vé tinh thao tac phim (1) co thé 1am bat ngudn va hét pin.

| Bat va tat nguon

Nhan (O dé bat may tinh.
Nhan ® @9 (OFF) dé tat may tinh.

Lwuy

« D& bat ngudn, nhan gitv (7). D& tranh v tinh bat ngudn, phan nat phim (1) sé thap
hon moét chuat so véi cac phim khac.

« Néu man hinh hién thi dwéi day xuét hién ngay sau khi ban bat nguén, cé nghia la
ngudn pin con lai yéu.

[

Néu man hinh nay xuét hién, hay thay pin cang sém cang tbt. Dé biét chi tiét vé viéc
thay pin, vui ldbng xem "Thay thé pin" (trang 167).

+ May tinh ciing sé tw déng t&t sau khoang 10 phut hodc 60 phut khéng dung. Nhan
phim (") @& bat lai may tinh.

13



| Man hinh HOME

Nhan @ sé hién thi man hinh HOME. Man hinh HOME sé& hién thj danh
sach cac &rng dung may tinh da cai dat.

YT [
X [k 4 | |
@ — | RENEY Statistics  Distribotion | ———
iz=] Xy=0
Spreadsheet  Table Equation
Man hinh HOME Man hinh &*ng dung
Calculate

Dé biét thong tin vé cac irng dung may tinh da cai dat, vui long xem
"Danh sach trng dung may tinh da cai dat" (trang 18).

| Diéu chinh dé twong phan hién thi

1. Nh&n ©), chon biéu twong rng dung may tinh, sau dé nhan @X.
2. Nhdn &), sau do chon [System Settings] > [Contrast].

Light Dark
L«] [»]

3. Dung phim & va & dé diéu chinh dé twong phan.
4. Sau khi thiét d&t theo y cia ban, nhan ®0).
Quan trong!

+ Néu diéu chinh d6 twong phan hién thj van khéng cai thién dwoc dd dé doc ctia man
hinh, cé nghia la ngudn pin yéu. Hay thay pin.

Nhan phim
[

Nhan phim @® réi nhan phim th( hai sé thwc hién chirc nang thay phién
cta phim th& hai. Chirc ndng thay phién dwoc biéu thj bang ndi dung in
phia trén phim, & bén trai.

(2)—er .
7

(1)
(1) Chirc nang nut phim: @
(2) Chirc nang thay phién: ® @ (x)

14



| Chi bao

-{5+242

Bang bén dwéi mé ta cac chi bao xuét hién & phia trén cing ctia man

hinh.
Chi bao: Y nghia:
Ban phim da dwoc thay dbi do nhan phim @ .
S| Ban phim sé& khéng thay déi va chi bao sé bién
méat khi ban nh&n phim nay.
/B Mathl/MathO hoac Mathl/DecimalO dwoc chon
* cho Input/Output trén menu SETTINGS.
DEE Cai dat hién tai cia Angle Unit ([8): Degree, [{:
Radian, hoac [€: Gradian) trén menu SETTINGS.
FIX An dinh s6 vi tri thap phan trong sé thap phan.
SCl An dinh s6 chir sb c6 nghia.
E On duwoc chon cho Engineer Symbol trén menu
SETTINGS.
., Cai dat hién tai cia Complex Result (i : a+bi hoac
! 2: r20) trén menu SETTINGS.
o Verify dwoc bat (bang cach chon "Verify ON" trén
menu TOOLS).
C4 lich st tinh toan trwdc (A ) hoac sau (V) cho
NE két qua tinh toan dwoc hién thj hién tai. V&i mot
sb trng dung may tinh, nhirng chi bao nay cho
biét c6 cac két qua tinh toan khac.

15




S dung menu
[

Nhiéu thao tac clia may tinh dwoc thuc hién bang cach sir dung man hinh
menu. Vi du bé&n dwéi cho thay cac thao tac bat dau tr man hinh menu
xuét hién khi ban nhan &.

Vo @
—a}
i}
ey }o
@ g Input/0utput |
System Settings » Angle Unit [
Reset » | «<—— |Number Format >
Get Started » ®» |Engineer Symbol »
®) 1o
wMathI /MathO
cMathI/Decimall
cLinel/LineO
cLinelI/DecimalO

Chon muc menu

DPé chon muc menu, st dung cac phim con trd (®, @, <, &) dé danh
d4u muc dé va sau dé nhan @. Lwu y rang <) va & chi dwoc st dung
khi cé nhiéu cét muc menu.

Diéu hwéng giira cac thir bac menu

Chi bao "k" & bén phai clia muc menu c6 nghia la cé cac cap thi bac
thap hon trong muc d8. Chon muc menu va nhan @ hoac & sé diéu
hwéng cép thap hon tiép theo trong thir bac nay. Dé tré vé cép cao hon
tiép theo trong thir bac nay, nhan ®.

Lwuy

« Néu ban dang & cap thap hon trong thir bac clia menu mét cot, ngoai phim (5 ban
con co thé nhan (<) dé tré vé cép cao hon tiép theo.

Chon muc menu bang nut radio (/@)

Khi man hinh hién thj danh sach céc tly chon, méi tuy chon sé& c6 mét nat
radio (O hodc ®) & bén trai. ® cho biét tiy chon dang dwoc chon.

16



Cach cau hinh cai dit cia muc menu nat radio
1. Danh diu muc menu phu hop va sau d6 nhan @.
« Didu gi xay ra tiép theo sé tly thudc vao loai muc menu ban da chon.

- Néu khéng con cai dat nao dé& cau hinh cho muc menu ban da chon,
nat radio bén canh sé& chuyén thanh ®.

- Muc menu ban da chon con nhiéu cai dat khac dé cau hinh, man
hinh chon cai d&t muc menu sé xuét hién. Trong trwdng hop nay,
chuyén sang buéc 2.

2. Trén man hinh cai d&t, danh diu cai dat ban mong muén va sau dé
nhan @K,
« Thao tac nay tré& vé man hinh muc menu & bwéc 1, trong d6 nut radio
bé&n canh muc menu ban da chon trwdc dé chuyén thanh &,

Cudn gitra cac man hinh

Mot thanh cudn sé xuat hién doc theo phia bén phai ciia man hinh khi cé
qua nhiéu muc menu khéng vira trén mot man hinh.

« Str dung (A va (¥ dé cuén gitra cac man hinh.

« Strdung ® va W dé cudn tirng dong.

DPé déng menu va tré vé man hinh hién thi trweéc menu

Nhan ®0).

Lwuy

« Ban co thé dong menu duoc hién thj bang cach nhan &), ¢3), (w), @), €9, hoac
bing cach nhan (&C). Néu menu duoc hién thj la menu xuét hién ngay sau khi
kh&i chay mét (rng dung may tinh cu thé hodc néu d6 1a menu danh riéng cho trng
dung, ban khong thé dong menu d6 béng cach nhan @C). Trong truong hop do, ban
phai nhan () dé& dong menu.
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Cac trng dung va menu cua
may tinh

Cac wrng dung may tinh

| Chon (rng dung may tinh

Chon mét ng dung may tinh phu hop véi kiéu tinh toan ban muén thuc
hién.
1. Nhan @ dé hién thi man hinh HOME.
« D& biét thdng tin vé tirng (rng dung may tinh, vui I6ng xem "Danh
sach rng dung may tinh da cai dat" (trang 18).

Y
+ -

ICINIELE]  Statistics  Distribution

X¥=0

Table  Equation

Spreadsheet

2. St dung cac phim con trd (B, O, K, &) dé chon biéu twong rng
dung may tinh ban muén.

3. Nh&n @ dé hién thi man hinh ban dau clta (rng dung may tinh cé biéu
twong ban da chon.

| Danh sach trng dung may tinh da cai dat

Biéu twong M6 ta

¥ =
R
alculate Tinh toan chung

(Calculate)*

51:4|E't|5t|':S Tinh toan théng ké va hdi quy

(Statistics)

A

Distribution Tinh toan phan phdi

(Distribution)

18



o

Spreadsheet

Tinh toan bang tinh

(Spreadsheet)
=]z
Table Tao mot bang s dwa trén mot hoac
hai ham
(Table)*

X¥=0
Equation

4

(Equation)*

Phwong trinh ddng thei, phwong
trinh bac cao hon, va Solver (ham
tim gia tri cGa bat ky bién nao co
trong phwong trinh dau vao)

Xy >0
Inequality

i

Tinh toan bat phwong trinh

(Inequality)
Comples Tinh toan sé phtrc
(Complex)*
16 A A
EB“’ \ Tinh toan lién quan dén hé thdng
d5E sb cu thé (nhj phan, bat phan, thap
o phan, thap luc phan)
[nn
oo |
hAatrix Tinh toan ma tran
(Matrix)

Vector

i

(Vector)

Tinh toan véc-to
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mHm \
Ratio

(Ratio)

Tinh toan ty 1&

B¢ \
hdath Box

Cac ham sau dé hé tro viéc hoc
toan.

Dice Roll, Coin Toss: M6 phdng xac
suét

Number Line: Biéu dd truc sé cho tbi
da ba dang thirc hodc bat dang thirc

(Math Box) Circle: Goc va gia tri lwgng giac
dworc thé hién bang hinh Unit Circle
hoac Half Circle. Cac géc cling co
thé dwoc thé hién bang hinh Clock.

Lwuy

« Verify, ham xac dinh tinh dung sai ciia phwong trinh hoac nghiém da nhap, kha dung

v&i cac (ring dung may tinh dwoc danh dau hoa thi (*) trong béng trén. Dé biét théng

tin vé Verify, vui long xem "Str dung Verify" (trang 73).

Swr dung menu SETTINGS

D& hién thi menu SETTINGS, nhan & trong khi st dung (rng dung may
tinh. Menu SETTINGS bao gdm cac muc menu dwéi day.

System Settings »
Reset >
Get Started >

Calc Settings

Bao gdm cac muc menu dé cAu hinh cac cai dat
tinh toan, chang han nhw dang thirc hién thi cho
két qua tinh toan.

System Settings

Bao gdm cac muc menu dé ciu hinh cac cai dat
thao tac cGia may tinh, chdng han nhw diéu chinh
do twong phan.

Reset

Bao gébm cac muc menu dé thuc hién cac thao
tac cai dat lai khac nhau.
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Hién thi man hinh Get Started. Dé biét thém
Get Started thong tin, vui Ibng xem "Man hinh "Get Started”
cua may tinh" (trang 9).

Lwuy

« Nhan @ trong khi man hinh HOME dwoc hién thi s& hién thi man hinh Get Started
thay cho menu SETTINGS.

- Ty thuéc vao man hinh dwoc hién thi bdi tng dung may tinh, nhan &) c6 thé khéng
hién thj menu SETTINGS.

| Thay déi cai dat caa may tinh

1. Nh&n @), chon biéu twong tng dung may tinh, sau dé nhan @K .
2. Nhan & dé hién thj menu SETTINGS.

System Settings »
Reset -
Get Started .

3. S dung ® va (» dé chon Calc Settings hoac System Settings, sau d6
nhan @K,
« Thao tac nay sé hién thj danh sach cac muc cai dat c6 trong menu da
chon.
Man hinh & day cho thay vi du vé man hinh xuét hién khi [Calc
Settings] dwgc chon.

Input/0Output -
Angle Unit >
Number Format >

Engineer Symbol »

« VUi long xem "Tuy chon cac muc va cai dit san c6" (trang 22)
dé biét vé cac muc cai dat sén co6 cho [Calc Settings] va [System
Settings].

4. St dung @ va » dé& danh dau muc c6 cai d&t ban mudn thay déi, sau

d6 nhan @).

* Thao tac nay sé hién thj danh sach cac tuy chon cai dat cho muc ban
da chon.
Man hinh & day cho thay vi du vé man hinh xuét hién khi [Input/
Output] dwoc chon.

wdathI/HathO
oMathI/Decimal0
olLinel/Line0
oLinel/Decimal0

5. St dung ® va () dé danh d4u tuy chon ban muén, sau d6 nhan @.
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6. Sau khi thiét d&t theo y ctia ban, nhan ®0).

| Tuy chon cac muc va cai dit san c6

"&" cho biét cai dat mac dinh ban dau.

Calc Settings > Input/Output

Chi dinh dinh dang d& may tinh s dung cho d4u vao biéu thirc va dau ra

két qua tinh toan.

Mathl/MathO*

Nhap vao: Dang sach giao khoa;
DPAau ra: Dinh dang c6 chra phan
sb, V', va/hoac =*'

Mathl/DecimalO

Nhap vao: Dang sach giao khoa;
Dau ra: Chuyén dbi thanh gi tri
thép phan

Linel/LineO

Nhap vao: Tuyén tinh*?; D4u ra:
S6 thap phan hoadc phan sb

Linel/DecimalO

Nhap vao: Tuyén tinh*2; Dau ra:
Chuyén ddi thanh gia tri thap phan

*1 Ap dung dau ra thap phan khi khéng thé xuét ra cac dinh dang nay vi ly

do nao dé.

*2 T4t ca cac phép tinh, gdm ca phan s6 va ham sb sé dwoc nhap trong
mot dong. Dinh dang dau ra twong tw nhw dinh dang cho cac mau may
khéng c6 Hién thi nhw sach gido khoa (cac mau may S-V.P.AM., v.v...)

Vi du vé hién thi dinh dang dau vao/dau ra:

Mathl/MathO

(cai d&t mac dinh ban dau)

Mathl/DecimalO
(Number Format: Norm 1)

(Number Format: Norm 2)

_1
200
_1
200
1
200
Sxw3
1
200
0.005
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Linel/LineO

11200

14200

Linel/DecimalO
(Number Format: Norm 1)

14200

Sxio3

Calc Settings > Angle Unit

Degree*®; Radian; Gradian

Chi dinh d6, radian ho&c gradian lam don vi géc cho hién thj gia tri nhap

va két qua tinh toan.

Calc Settings > Number Format

Chi dinh sé chir s6 cho hién thi két qua tinh toan.

Fix: Gia tri ban xac dinh (tlr 0 t&i 9) kiém soat s cac vi tri thap phan cho
két qua tinh toan dwoc hién thi. Két qua tinh toan dwoc lam tron téi chi

sb da xac dinh trwdc khi dwoc hién thi.

1+6
(Fix 3)

126®E (=)

0.167

Sci: Gia trj ban xac dinh (ttr 1 t&i 10) kiém soat sb cac chir sb cd nghia
cho két qua tinh toan dworc hién thi. Két qua tinh toan dwoc lam tron toi

ch¥ s6 da xac dinh trwdc khi dwoc hién thi.
1+6
(Sci 3)

1@6®E (=)

=18

1.67xi8"

Norm: Hién thi két qua tinh toan & dang sé mii khi ching nam trong

khoang bén dwéi.

Norm 1*: 102 > |x|, |x| 2 10"°, Norm 2: 10 > |, |x| = 1070

1+ 200
(Norm 1)
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¥o [ &
1--200
1®200® @) (=)*
Sxiw?
(Norm 2)
¥ [ &
1--200
1®200® @ (=)
0.005

* Nhadn (® @) (=) thay cho @ sau khi nhap phép tinh sé& hién thi két qua
tinh toan dwdéi dang thap phan.

Calc Settings > Engineer Symbol

On; Off*

Chi dinh c6 hién thj két qua tinh toan bang ky hiéu ky thuat hay khéng.
Lwuy

+ Chi bao (E) dwoc hién thi & phia trén cung cta man hinh trong khi On dwoc chon cho
cai dat nay.

Calc Settings > Fraction Result

Mixed Fraction; Improp Fraction®
Chi dinh hén sb hodc phan sé c6 thé viét thanh hén sé cho hién thi phan
sb trong két qua tinh toan.

Calc Settings > Complex Result

a+bi®; re6
Chi dinh toa d6 hinh chi* nhat hodc toa do cuwc cho két qua tinh toan cla
trng dung Complex va cac nghiém da thirc cia rng dung Equation.

Lwuy

« Chi bao i dwoc hién thi & phia trén cung cia man hinh trong khi a+bi dwoc chon cho
cai dat Complex Result. 2 s& hién thj khi 7260 dwoc chon.

Calc Settings > Decimal Mark

Dot®*: Comma
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Chi dinh s&r dung d4u chdm ho&c d4u phay cho dau thap phan trong két
qua tinh toan. D4u chdm luén dwoc hién thi trong qua trinh nhap. Khi dau
ch&m duwoc chon lam dau thap phan, d4u phan cach cho nhiéu két qua

la ddu phay (,). Khi ddu phdy dwoc chon, ddu phan cach sé 1a ddu chadm
phay (;).

Calc Settings > Digit Separator

On; Off*
Chi dinh c6 nén st dung ky tw phan cach trong két qua tinh toan hay
khoéng.

System Settings > Contrast

Vui 16ng xem "Diéu chinh d6 twong phan hién thi" (trang 14).

System Settings > Auto Power Off

10 Min.*; 60 Min.
Chi dinh khoang thei gian cho dén khi Auto Power Off dworc kich hoat.

System Settings > Language

English®; Tiéng Viét
Chi dinh ngdn nglr str dung cho cac menu va théng bao ctia may tinh.

System Settings > QR Code

Chi dinh phién ban clia QR Code hién thj khi nhdn ® @ (QR).
Version 3: Cho biét QR Code Phién ban 3.
Version 11*: Cho biét QR Code Phién ban 11.

Reset > Settings & Data

Vui Iong xem "Dé khé&i dong cac cai dit cta may tinh" (trang 26).

Reset > Variable Memory

Vui 1ong xem "Xoa ndi dung cua moi bé nhé" (trang 40).
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Reset > Initialize All

Vui long xem "Kh&i ddng may tinh" (trang 8).

Get Started

Vui 1dong xem "Man hinh "Get Started" cua may tinh" (trang 9).
DPé khéi dong cac cai dat cia may tinh

Quan trong!

* Quy trinh dwdi day sé khéi dong tat ca cai dat ciia may tinh, ngoai trir Contrast, Auto
Power Off, va Language. Ddng thoi cling xda tat ca di¥ liéu ngoai trir di liéu bd nhé
bién, Ans va PreAns.

1. Nh&n @), chon biéu twong ng dung may tinh, sau d6 nhan @%).

2. Nhan &), sau do chon [Reset] > [Settings & Data] > [Yes].
« Thao tac nay sé hién thi man hinh HOME.

Sty dung menu CATALOG

Nhan @ dé hién thi menu CATALOG. Menu nay hién thj cac danh muc

lénh, ham va ky hiéu phu hgp v&i rng dung may tinh ban dang st dung
va trang thai hién tai (man hinh dwoc hién thi hodc cai dat hién tai) cta

ng dung.

Func &nalysis .|

Probability >
Numeric Calc 2
Angle/Coord/Sexar

Vi du: Menu CATALOG cula &rng dung Calculate

Lwuy

« Dé biét thong tin vé cach nhap cac lénh, ham, va ky hiéu tir menu CATALOG, vui long
xem "Tinh toan nang cao” (trang 51).

« Dé biét théng tin vé cac 1énh, ham va ky hiéu cu thé cho tirng tng dung may tinh, vui
Iong tham khdo mo t& (rng dung may tinh trong "Str dung cac trvng dung may tinh"
(trang 79).
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Swr dung menu TOOLS

Menu TOOLS xuét hién khi ban nhan € s& bao gdm cac muc menu dung
dé thwe hién chirc ndng danh riéng cho tirng (rng dung may tinh va dé
c4u hinh céac cai dat.

CALC
Undo

Verify ON

Vi du: Menu TOOLS cho trng dung Calculate

Table Range
Define f{x)/g{x)»

Table Type -
Edit -

Vi du: Menu TOOLS cho &ng dung Table

Lwuy

+ Cac muc menu dudi day 1a muc chung cho nhiéu rng dung may tinh.
- Undo (Vui long xem "Hoan tac thao tac" (trang 30).)
- Verify ON, Verify OFF (Vui lobng xem “Str dung Verify" (trang 73).)
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Nhap biéu thirc va gia tr

Céac quy tac nhap co ban

Khi ban nhan @, th(r tw wu tién cla tinh toan diu vao sé dwoc danh gia
tw dong va két qua sé xuét hién trén man hinh.

4 x sin 30 x (30 + 10 x 3) =120
4% @30%)@)@30@10@3@@ 4X5in(30)x¢30+1 0w

™1
*2 *3

120

"1 Viéc nhap d4u ngodc déng la bat budc déi véi ham sin va cac ham khac
c6 chira dau ngodc don.

"2 C6 thé bd qua cac ky hiéu phép nhan (x).

"3 C6 thé bd qua dau ngodc déng ngay trwdc thao tac @,

Di chuyén con tré dén vi tri dau hoac cudi cua biéu thirc dau
vao

Khi nhap mét biéu thire, ban cé thé nhan (A) dé di chuyén con trd dén dau
biéu thirc, hodc nhan ¥ dé di chuyén con tré dén cubdi biéu thirc.

Biéu thirc dau vao va chi bao "Khac" cho két qua tinh toan
(=, =)

Néu ban thay biéu twong chi hwéng (- hodc [+) & bén phai ctia dong
biéu thirc diu vao hodc dong két qua tinh toan, nghia la dong hién thj van
con tiép tuc & bén phai. St dung < va & dé cudn dong nay sang trai va
phai.

« Khi ban thay & & d4u cubi bén phai ctia dong két qua tinh toan, ban
c6 thé chuyén dén cubi két qua bang cach nhan ¥). Bé chuyén dén dau
dong két qua tinh toan, nhan (A\.

« Lwu y rang néu ban mudn cudn biéu thirc dau vao trong khi ca hai chi
bao M va [+ cung dwoc hién thi, ban phai nhadn S hoac @0 truéc, sau
dé str dung K va & dé cuén.

vor @ A
Pol(1.414213562, &

r=2, 8=0.78539816%»
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Tw dong hoan thanh dau ngoac don

Néu ban thwc hién mét bai toan cé ca phép chia va phép nhan nhung dau
nhan da dwoc gian lwoc, khi dé cac ddu ngodc don sé dwoc tw ddng chén
vao nhv vi du dwéi day.
- Khi thiéu d4u nhan ngay trué'c ddu mé ngodc hodc sau dau dong ngoac.
Vidu:6+2(1+2)— 6+ (2(1 +2))
- Khi thiéu d4u nhan ngay truéc mét bién, mét hang sb, v.v...
Vidu: 6 + 27 — 6 + (2r)

Chi bao gi&i han dau vao

Con trd sé thay doi hinh dang thanh ll khi con lai tir 10 byte tré xudng gia
tri dau vao dwoc phép nhap. Néu diéu nay xay ra, hay dirng nhap phép
tinh va sau d6 nhan .

Nhap biéu thirc tinh toan sir dung
Pinh dang sach giao khoa (chi c6 &
Mathl/MathO hoac Mathl/DecimalO)

C6 thé nhap biéu thirc bao gém cac phan sb va/hodc cac ham déc biét
nhw " & dinh dang sach gido khoa béng cach s dung nhirng mau xuét
hién khi nhadn mét s6 phim nhat dinh, ho&c khi ban nhap vao mét s6 ham
nhat dinh t» menu CATALOG.
1 3
3 7 +5 7
1.Nhan ® & (=5).

« Thao tac nay sé& nhap mot mau hén sb.

]
05

2. Nhap céac gia tri vao vung nhap sb nguyén, t&r sé va mau sb clia mau.

301©2 3%

3. Thuc hién twong tw d& nhap phan con lai ca biéu thic.

34453
O@®E(=E)B3@2@ | 2 2
10
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Lwuy

« Khi con tré nhap vao nam trong viing nhap gia tri cia mau (hén s, tich phan (J), tdng
(Z) va tich (1)), nhdn () &) @& di chuyén con trd dén vi tri ngay sau (bén phai) mau,
hoac nhan () (<) @& di chuyén con tré dén vi tri ngay tredc (bén trai) mau.

+ Ban ludn c6 thé nhan ra vi tri hién tai ctia con tré trong mét mau, vi vi tri con tré &
viing c6 khung con tréng hodc ky tw s& c6 mau den dam. Nhitng phan khac trong biéu

thire tinh toan sé c6 mau xam dam.
Vo @

o
Og

0] Vit B

Ij’a
Dﬁ (1=

Y

| Hoan tac thao tac

DPé hoan tac thao tac phim cudi cung, nhan &9, chon [Undo], sau d6 nhan
©8).

Dé thuc hién lai thao tac phim ban vira hoan tac, nhan &9, chon [Undo],
sau dé nhan @ |an nira.

| St dung cac gia trj va biéu thirc nhw doi sé

2 ~ 7 z F 8 N 7
béenhdp 1+ 5 sau do doi thanh 1 + \/%

1®7@®6RQR ®@(INS) [1+£

@ 1+E

Thao tac nhan ® @ (INS) trong vi du trén sé lam cho % tré thanh dbi sé

ctia ham dwoc nhap vao bang thao tac phim tiép theo (V).

Phwong thirc nhap ghi de (Chi cé &
Linel/LineO hoac Linel/DecimalO)

Trong phwong thirc ghi d&, van ban ban nhap vao sé thay thé cho van ban
tai vi tri con tré hién tai. Ban cé thé chuyén dbi gitra phwong thirc chén
thém va ghi dé bang cach thyc hién cac thao tac: ® @ (INS). Con trd sé
xuét hién & dang "|" trong phwong thirc chén thém va & dang "=" trong
phuwong thire ghi de.
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Tinh toan co ban

Phép tinh s6 hoc

S dung cac phim @, ©, ®, va ® dé thuc hién cac phép tinh sé hoc.

Vidu:7x8-4x5=36

7XB-4X5
7X0804®56

36

Phép tinh phan so6

Lwu y rang phwong thire nhap cho phan s phu thudc vao cai dat Input/
Output hién tai trén menu SETTINGS.

Pé nhap % (phan sé cé thé viét thanh hén sd)

(Input/Output: Mathl/MathO hoac Mathl/DecimalO)

@73 hoac 7@3 3

(Input/Output: Linel/LineO hoac Linel/DecimalO)
713
7®3 / \
(a) (b)

(@) T sb, (b) Mau sb

DPé nhap 2 % (hdn sd)

(Input/Output: Mathl/MathO hoac Mathl/DecimalO)

®® (=2 20103 21

(Input/Output: Linel/LineO hoac Linel/DecimalO)
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3
201®3| (¢ 1. N(b)

(a) Tt sb, (b) MAu sbd, (c) Phan sb nguyén

(Input/Output: Mathl/MathO)

¥ [ -
2 .
Lay B
2830 D®E (=5 )1D1V26 (3 2 13
B
(Input/Output: Linel/LineO)
213+11142 “
203D 1®1@2 de=E

Lwuy

+ Phan s6 trong két qua tinh toan dwoc hién thj sau khi dwoc rat gon vé dang phan sé
tbi gian.

DPé chuyén ddi dang thirc két qua tinh toan sang phan sb cé thé viét
thanh hén s hodc hén s6, nhan @ . Dé biét thém thong tin, vui long xem
"Chuyén déi phan sé cé thé viét thanh hén sé va phan s6 hén hop"
(trang 47).

Két qua tinh toan dang phan sé

Khong thé hién thi két qua tinh toan cé téng sé chir s clia hén sb (bao
gdm ca sb nguyén, tlr sd, mau sb va ky hiéu phan tach d) Ién hon 10
bang dang phan sé. Trong trwéng hop nay, két qua tinh toan dwoc hién thi
dwéi dang gia tri thap phan.

Vidu 1: 1114123456 = 123457 1123456

(Input/Output: Linel/LineO)

1®1®123456€0 |114123R8, oo

Vi tbng sb chi sb cla gia tri 1111123456 |a 10, két qua duwoc hién thi
dwéi dang gia tri phan sb.
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14111234567 (= 1234568 11234567) = 1,00000081

(Input/Output: Linel/LineO)
1®1® 1234567 @

14121234567
1. 00000081

Vi téng s6 chir s6 cla gia tri 11111234567 1a 11, két qua dwoc hién thi

dwéi dang gia tri thap phan.

Lwuy

« Phép tinh cé hén sbé va gia tri thap phan sé hién thj két qua dwéi dang gia tri thap

phan khi chon mét ché do khac véi Mathl/MathO.

Lay thuwa, Iy thira can, va nghich

dao

S dung cac phim dwdi day dé nhap ham iy thira, ham Iy thira cén, va

ham nghich dao.

Cac ham Il thira: @(Iy thiva bac hai), @ (Idy thira bac n)
Cac ham liiy thira can: @) (can bac hai), ® @ (8/5) (can bac n)

Ham nghich dao: ® @ (w™)

(52)3 = 15625

O5@ O ®3@

Vidu2: (1+1)**2=16

O1P10@2@26

Vi du 3: V2 x 3 = 3v2 = 4,242640687....
(Input/Output: Mathl/MathO)

@2 X3@

(Input/Output: Linel/LineO)
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5y32=2

(Input/Output: Mathl/MathO)

(Input/Output: Linel/LineO)

1

_1=
10 10

(Input/Output: Mathl/MathO)

Phim @ (Liy thira cta 10)

@20 ®36

®@(Wo) 532@

5@ (Vo) 320 @&

100 @ (w") €

F's

4.242640687

O]
v{23x3

Viéc nhan phim @) gibng nhw nhdn X M © @ . Ca hai thao tadc nhap
"x10™" (Mathl/MathO hoac Mathl/DecimalO) hoac "x10”(" (Linel/LineO

hoac Linel/DecimalO).

1,23 x 10% = 1230

Mién tinh toan dang '

1()23@ 30

5 o [ 'y
{32
2
O] .
S5z {32)
2
¥or @ .
107
1
10
v [ -
1.23%10°
1230

Mié&n hién thi cho phép ctia két qua tinh toan dang V' dwoc thé hién dwsi

day.

1<a<100,1<bH<1000,1=c<100
0=<d<100,0=¢<1000,1=<£<100
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Vi du:

« 10V2 + 15 x 3V3 = 45v3 + 1012 ... Puoc thé hién & dang V'

* 99999 (= 297+111) = 3129,089165 ... Dwoc hién thi dwdi dang gia tri
thap phan

So6 Pi, co’ so ldgarit tw nhién e

IS6 Pi

Nhap 7 bang cach nhan ® @ (x).

& dwoc hién thi 1a 3,141592654, nhwng gié tri 7 =
3,1415926535897932384626 duwoc sir dung dé tinh toan ndi bo.
| Co s6 I6garit tw nhién e

Nhap e bang cach nhdn ® (@) (e).
Co s6 16garit tw nhién e dwoc hién thj 1a 2,718281828, nhwng gia tri e =
2,7182818284590452353602 duwoc st dung dé tinh toan noi bo.

Lich str va hién thj lai phép tinh

| Lich st tinh toan

DAu A va/hodc ¥ & phia trén cung cla man hinh chi ra rang c6 thém noi
dung lich st tinh toan & trén va/hoac du¢i. Ban co thé cudn cac noi dung
lich st tinh toan bang cach st dung ® va .

ng dung hé tro lich st tinh toan:
Calculate, Complex, Base-N

Vi du
2+2=4
¥ [ &
2+2
2®269
4
3+3=6
+o [ &
3+3
3D3E
B
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2+3
®

(Cubn lai.)

Lwuy

- T4t ca dir liéu lich st tinh toan déu bj x6a bét ct khi nao ban nhan (7) hoac @), khi
ban thay ddi cai d&t Input/Output, hodc bat cv khi nao ban thuwc hién thao tac Reset
("Settings & Data" hoac "Initialize All").

| Hién thi lai

Khi két qua tinh toan hién thj trén man hinh, ban c6 thé nhan <), & hoac
(® dé chinh slra biéu thirc ban da dung cho phép tinh trwéc dé.

4x3+2=14
+or @ &
4%3+2
4X3® 2@
14
4x3-7=5
¥ B L
] 4x3-7
(Tiep tuc) Q@@ 7@
5
Lwuy

+ Néu dau <« (trai) hoac P> (phai) hién thi & mét trong hai dau hoac ca hai dau cua
dong két qua tinh toan, ban c6 thé st dung (<) va (>) dé cudn dong sang trai va phai.
Néu didu nay xay ra, nhan () hoac @0 trwdc tién, sau do st dung (<) va &) dé
chinh stra biéu thirc dé.

St dung chirc nang bé nhé

| B4 nhé tra 1&i (Ans)/B6 nhé tra 1&i trwéde d6
(PreAns)

Két qua tinh toan cudi cung thu dwoc sé dwoc lwu trong bd nhé Ans (trd
Ii). Két qué tinh toan thu dwoc trudc két qua cudi cung sé duoc lwu trong
bd nhé PreAns (trd 1&i trwdre d6). Hién thi két qué cia phép tinh mai sé
lam chuyén ndi dung hién tai trong bd nhé Ans sang bd nhé PreAns va
lwu két qua phép tinh méi vao trong bd nhé Ans.
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Lwuy

+ B6 nh& PreAns chi cé thé dwoc st dung trong trng dung Calculate.

« N6i dung trong bd nhé PreAns sé bi x6a bat ct khi nao ban chuyén sang mét (rng

dung khac ngoai rng dung Calculate.

Str dung boé nhé Ans dé thwe hién mét loat cac phép tinh

Dé chia két qua cta 3 x 4 cho 30

Nhap néi dung trong bé nhé& Ans vao biéu thirc

Dé thuc hién phép tinh dudi day:

3X4E0 | 12|

ANS<30 ‘
(Tiép tuc) @306 5
5

123+456 =579  789-579 =210
/N

12345660 | 579]

785-Ans ‘

(Tiép tuc) 789 @ @

210

St dung bé nh& PreAns

1: D6i v&i Ty = Tye1 + Tk (ddy Fibonacci), xac dinh trinh tw day sé tw
T1 dén T5. Lwu y réng T1 =1va T2 =1.

T1=1

T3=T2+T1=1+1

160 | 1]
(Ans =T1=1)
169 | 1]

(Ans=T2=1,PreAns =T =1)

Yo M
Ans+PreAns

® ® @ (PreAns) @
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(Ans =T3=2,PreAns=T2=1)

Ta=Tz+T2=2+1

¥ B
Ans+Prefns

&

3

(Ans =T4 =3, PreAns = T3 = 2)

Tg=Ts+T3=3+2

+o [
Ans+Preflns
(@
5
Két qua: Day sé la {1, 1, 2, 3, 5}.
ICéc bién (A,B,C,D,E,F, x,y,2)
Ban c6 thé lwu cac gia tri cho cac bién va sir dung céac bién trong tinh
toan.
Man hinh danh sach bién
] B=12345Ek
C=1234567 [=12345673
E=123456739 F=1234567330
¥=1, 234501 =0
z=]
Nhén ¢ sé& hién thi man hinh hién thj cac gia tri hién dang dwoc lwu cho
cacbién A, B, C, D, E, F, x, v, va z. Trén man hinh nay, cac gia tri luén
dwoc hién thi bang cach st dung Number Format |a "Norm 1". D& doéng
man hinh, nhan 45 hodc @0.
Pé Iwu két qua cla 3 + 5 cho bién A
1. Thwc hién phép tinh.
+or © l
3+5
3@B56
8

2. Nhan @), sau do6 chon [A=] > [Store].
« Thao tac nay sé lwu triv két qua ctia 3 + 5 (1a 8) cho bién A.
3. Nhan @.

[E=E
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Dé thay dbi ndi dung ctia bién A thanh 1
1. Nhé&n @, sau do danh déu vao [A=].

[E=E

2. Nhan (.
« Thao tac nay sé hién thi man hinh chinh stra v&i 1 dwoc nhap vao.

[&=11

3. Nhan €.

[EE— -

Lwuy

+ Thay cho thao tac & budc 2 néu trén, ban cé thé nhan ©OK) va sau d6 chon [Edit]. Thao
tac nay sé hién thi man hinh chinh stra ma khéng c6 sé nao duoc nhap vao. Nhap gia
tri ban mudn va sau d6 nhan €.

+ Néu biéu twong khoa (ll) xuét hién khi ban danh d4du mét bién trén man hinh danh
sach bién, diéu dé c6 nghia la khéng thé chinh stra bién dwoc danh dau.

f=0.12345673 B=I(22
C=3.14135265 0=5.3
E=1.23456709 assl]
x=0 =0
z=0

Dé xem lai gia tri ctia bién nhé A va danh sach gia tri da lwu &
cac bién nh& con lai
(Tiép tuc tlr buwéc 2 clia Vi du 1)
1. Nhan &, sau d6 chon [A=] > [Recall].
* Thao tac nay sé nhap "A".

(Al

2. Nhan @.
« Thao tac nay sé hién thi lai gia tri ctia bién A.

¥or [ Y

Dé& nhan noi dung cua bién A v&i 10
(Tiép tuc tr bwérc 2 ctia Vi du 1)

39



® @A) @109

80

* Nhap bién nhw da minh hoa & day: nhdn (® va sau d6 nhan phim twong
rng v&i tén bién mong muébn. D& nhap x [am tén bién, ban c6 thé nhan

® ©(x) hodc ®.
| Xoa ndi dung cua moi bd nhé

B& nhé Ans va ndi dung bién van duoc lwu lai ngay ca khi ban nhan @9,
thay ddi (rng dung may tinh, hodc tat may tinh.

N6i dung bd nhé PreAns van duoc lwu lai ngay ca khi ban nhan @9 va tat
may tinh ma khoéng thoat khéi trng dung Calculate.

Thuwce hién quy trinh sau khi ban mudn xoa néi dung cla tat ca cac bd nhé.
1. Nhan ©), chon biéu twong ng dung may tinh, sau dé nhan @K.

2. Nhan &), sau d6 chon [Reset] > [Variable Memory] > [Yes].

S dung CALC

CALC cho phép ban nhap céac biéu thirc tinh toan bao gbm mét hoac
nhiéu bién, lwu cac gia tri cho cac bién, va tinh toan két qua.
CALC chi c6 thé dwoc sir dung trong trng dung Calculate.
Dinh dang cla biéu thirc cé thé dworc tinh toan véi CALC dwoc thé hién
dwdi day.
A+3, 2x + 3y, 2Ax + 3By + C, V.v...
Dé nhap 3A + B roi thé vao cac gia tri sau dé thuwc hién tinh toan: A

= 5, B = 10 (Input/Output: Mathl/MathQ)
1. S dung theo thao tac phim bén dwdi dé nhap 3A+B.

3®OA)D®O(B)[3a+EI

2. Nhan &9, sau dé chon [CALC].

7o
3A+B

3. Nhap gia tri cho A va B, sau do thyc hién tinh toan.

o O
3JA+B

569106 @

25
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« Thao tac nay sé hién thi man hinh két qua tinh toan CALC. Ban c6
thé nhan @ trong khi man hinh nay dwoc hién thj dé tré vé man hinh
& budc 2, bwdc ma ban c6 thé lwu mot gia tri khac cho bién va 1ap lai
phép tinh.

Lwuy

* Khi lvu mét gia tri cho bién trong buéc 3 & trén, viéc nhap sé ludn la nhap tuyén
tinh bat ké& cai dat Input/Output ciia menu SETTINGS. D& biét théng tin vé cai dat
Input/Output, vui ldng xem "Tluy chon cac muc va cai dat san cé” (trang 22).
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Thay déi dang thirc két qua
tinh toan

Swr dung menu FORMAT

Ban c6 thé st dung menu FORMAT xuét hién khi ban nhan & dé chuyén
dbi két qua tinh toan dwoc hién thj sang cac dang thirc khac nhau.

Decimal
ENG Notation
Sexagesimal

| Danh sach menu FORMAT

Muc menu nay: Chuyén déi sang dang thirc nay:

Standard Standard (Gém dang thirc phan sé, ,
V)

Decimal Théap phan

Prime Factor Phan tich thanh thira s6 nguyén t6

Recurring Decimal Sé thap phan tuan hoan

Rectangular Coord Toa dd hinh chir nhat

Polar Coord Toa dod cuc

Improper Fraction Phan sb c6 thé viét thanh hén sb

Mixed Fraction Hon sb

ENG Notation K}’/.phép i()"/ ttluét' (da?g thieec ax10”,
v@i n = sO mi chia hét cho 3)

Sexagesimal Do, phut, gidy (Hé luc thap phan)
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Lwuy

+ Cac muc menu xuét hién khi nhan sé tuy thudc vao két qua tinh toan dang dwoc
hién thi. Ngoai ra, néu két qua tinh toan khong thé chuyén dbi dwoc hién thi, menu sé
khong xuét hién khi ban nhan ).

| Thao tic m3u vé chuyén doéi

3 1

3+2=7=1,5=17

Trong vi du nay, chung ta sé chuyén dbi két qua tinh toan dwoc hién thi

dwéi dang phan sb cé thé viét thanh hén sb sang mét gia tri thap phan,

sau do sang hén sb. Cudi cuing, chung ta sé hdy chuyén dbi va quay lai
két qua tinh toan ban dau.

(Input/Output: Mathl/MathO, Fraction Result: Improp Fraction)

1. Thwc hién phép tinh 3 + 2.

¥or [ &
32
326 3
2
2. D& chuyén dbi két qua tinh toan sang gia tri thap phan, nhin &, chon
[Decimal], sau d6 nhan @®.
¥ [ l
32
1.5
3. D& chuyén ddi két qua tinh toan sang hén sb, nhan @, chon [Mixed
Fraction], sau d6 nhan @®.
¥or [ &
32
1
12
4. D& hiy chuyén dbi, nhan €.
« Thao tac nay sé hién thj két qua tinh toan ban dau & buwéc 1.
+o [ l
32
3
2
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Chuyén déi Standard va Decimal

Standard la mét dang thire hién thi két qua tinh toan dwdi dang ¢ chira
phan sb, V', hodc = néu cé thé. Decimal 1a mét dang thirc hién thi két qua
tinh toan dwdi dang gia tri thap phan.

Lwuy

+ C6 thé chuyén ddi sang dang thirc Standard c6 chira V' hodc = khi Mathl/MathO hoac
Mathl/DecimalO dwoc chon cho cai dat Input/Output trén menu SETTINGS.

Ban c6 thé st dung thao tac bén duwdi dé chuyén dbi két qua tinh toan
sang dang thirc Standard hoac Decimal.

T+6= % 7 = 0,5235987756 (Input/Output: Mathl/MathO)
¥ [ &
rb
®DMO6® :
Eﬂ.’

@ Standard

(Chon [Decimal].) |[ENG Notation
Sexagesimal

AT x
m+b

®

(Chuyén dbi sang gia tri thap phan.)
0.52359877586

Decimal
ENG Notation

Sexagesimal

¥ @ .
nb
(Chuyén dbi sang dang thirc Standard.)

|

Quan trong!

« V&i mot sb két qua tinh toan, viéc chon [Standard] trén menu FORMAT sé khong
chuyén ddi gia tri da hién thi.

Pé thu dwoc két qua hién thj 1a s6 thap phan khi dang & ché
doé Mathl/MathO hoac Linel/LineO

Nhan ® @ (=) thay vi @ sau khi nhap mét phép tinh.
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Phan tich thanh thira s6 nguyén to

Trong &ng dung Calculate, s6 nguyén dwong dai khéng qua 10 chi s6 cd
thé dwoc phan tich thanh thira sé6 nguyén té.

Dé thyc hién phan tich thanh thira sé nguyén t6 déi véi 1014

¥ @ .
1014
1014 @
1014
+o [ -
1014
— [Prime Factor]
2x3%13°

Lwuy

« Khong thé phan tich cac loai gia tri dwgc mé ta bén dwéi, cho du ching cé tir 10 chi®

s6 tré xubng.

- Mét thira sb trong cac thira s6 nguyén t6 cé gia tri tir 1.018.081 tré lén.

- Hai hay nhiéu thira sb trong céac thira s6 nguyén té cta gia tri c6 nhiéu hon ba chi®

s6.
« Phan khong thé phan tich sé dwoc dét trong dau ngodc don trén man hinh.
2036162 =2 x (1018081)*
*1018081 = 10092

2036162 *
2036162 @D

— [Prime Factor]

2x{1018081>

Chuyén doi s6 thap phan tuan hoan
(Phép tinh s6 thap phan tuan hoan)

May tinh nay cho phép ban chuyén déi két qua tinh toan sang dang thirc
thap phan tuan hoan trong &ng dung Calculate, néu cé thé. Ban ciing cé
thé nhap maot gia tri thap phan tuan hoan va thyc hién tinh toan.

| Chuyén doi két qua tinh toan sang gia tri thap

phan tuan hoan
Dé chuyén dbi két qua tinh toan sang gia tri thap phan tuan hoan, nhan
@, sau do chon [Recurring Decimal] tr menu FORMAT xuét hién. Dé biét

thao tac thuc t&, vui long xem "Vi du vé phép tinh sé thap phan tuan
hoan" (trang 46).
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| Nhap s6 thap phan tuan hoan

Dé nhap mét gia tri thap phan tuan hoan, str dung muc menu CATALOG
nhw dwdi day.

@— [Numeric Calc] > [Recurring Decimal]
Dé biét thao tac thuc té, vui long xem "Vi du vé phép tinh s6 thap phan
tuan hoan" (trang 46).

Quan trong!

+ Néu gié tri b4t ddu bang mot phan sd nguyén (nhw: 12,3123123...), khéng dwa phan
sb nguyén vao khi thém d&u phan cach (12.(312)).

+ Chi c6 thé nhap sb thap phan tuan hoan khi Mathl/MathO hodc Mathl/DecimalO dwoc
chon cho Input/Output trén menu SETTINGS.

] Vi du vé phép tinh so thap phan tuan hoan

P& tinh 3.(021) + 0.(312) (Input/Output: Mathl/MathO)
1. Thwe hién thao tac sau dé nhap biéu thire tinh toan.

¥ [
3() ® — [Numeric Calc] > 3..:021,H
[Recurring Decimal] 0213 @

¥or [0 .
00 @ — [Numeric Calc] > |3+ ¢021>%0. 312,

[Recurring Decimal] 312&® 10
3

« Thao tac nay sé hién thj két qua tinh toan dwéi dang phan sé.

2. Nhan @), sau d6 chon [Recurring Decimal].
« Didu nay sé thay dbi dang thirc két qua sang sé thap phan tuan hoan.

¥ [ &
31- tu21 J+u-|- C3121

31- tBJ

« Dé tra két qua tinh toan vé dang phan sb, chon @ — [Standard].

Lwuy

« Chi c6 két qua tinh toan théa man cac diéu kién sau maéi co thé dwoc hién thi dwéi
dang sb thap phan tuan hoan.
- Téng sb chir s6 dwoc str dung trong hdn sé (bao gébm s nguyén, t&r sb, mau sb va
ky hiéu phan tach) khdng dwoc I&n hon 10.
- Kich thwée div liéu cla gia tri khi hién thi dwgi dang sb thap phan tuan hoan khong
duoc Ién hon 99 byte, dwoc tinh nhw sau: [s6 chiv sb (mbi chir s6 1 byte)] + [1 byte
cho dau thap phan] + [3 byte cho ma quan ly sé thap phan tuan hoan). Vi du, kich
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thwdc div liéu ctia s6 0.(123) sé gdbm 4 byte cho cac chiv sb, 1 byte cho dau thap
phan, va 3 byte cho ma quan ly sé thap phan tuan hoan, téng cong la 8 byte.

Chuyén déi toa dé hinh chir nhat va
toa do cuc

Ban c6 thé chuyén dbi két qua tinh toan sé phirc sang toa do hinh chi
nhat (@ — [Rectangular Coord]) hoac toa dé cwc (@) — [Polar Coord]). Co
thé thwc hién thao tac chuyén déi nay dbi véi mét trong cac trwdng hop
sau:

» Khi mét nghiém phwong trinh bac cao hon ctia &rng dung Equation
dwoc hién thj (v&i diéu kién 1a On dwoc chon cho cai dat ¢ — [Complex
Roots] ctia (rng dung Equation)

« Khi két qua tinh toan (rng dung Complex dwoc hién thi

Dé biét thao tac chuyén déi mau thyc té, vui long xem cac phan bén dudi.
"Chuyén dbi nghiém s6 phirc thanh toa dd hinh chir nhat hoac toa
do cwc” (trang 119)

"Chuyén doéi két qua tinh toan sé phirc thanh toa dé hinh chir nhat
hoac toa dd cwc" (trang 127)

Chuyén doi phan so c6 thé viet
thanh hoén so6 va phan so6 hon hop

Ban c6 thé chuyén dbi két qua tinh toan & dang phan sb hodc gia tri thap
phan (gia tri thap phan c6 thé déi thanh phan sé bang may tinh nay) dang
dwoc hién thi thanh mot hdn sd hodc phan sb cé thé viét thanh hén sé.

; 13_, 1
Vidu 1: 7 3 7
(Input/Output: Mathl/MathO, Fraction Result: Improp Fraction)
13@4@ 13
— [Mixed Fraction] 3%
— [Improper Fraction] 14—3
; _13_, 1 . ,
Vidu 2: 3,25 = 7 3 e (Input/Output: Linel/LineO)
30256 | 3. 25|
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— [Improper Fraction] | 13.4]
— [Mixed Fraction] | 311.4]

Ky phap ky thuat

Ban c6 thé chuyén dbi phan sb mii cla gia tri két qua tinh toan dwoc hién
thi thanh mi muoi va la bdi sé cta 3, sau do hién thj két qua.

Bién dbi gia tri 1234 sang ky phap k¥ thuat, dich chuyén d4u thap
phan sang phai, sau dé sang trai.
1. Nhap 1234, sau d6 nhan .

1234

2. Thye hién thao tac duoi day dé vao Ché dd chuyén dbi ENG.

1254
— [ENG Notation]
1.234 %35

« Viéc vao Ché do chuyén déi ENG sé& lam chuyén déi két qua tinh toan
sang ky phap ky thuat va lam cho d4u % xuét hién bén phai.

« Trong Ché d6 chuyén dbi ENG, ban c6 thé sir dung  va & dé thay
ddi diu thap phan cla phan dinh tri.

+T [ Iy
1234
>
1234 x10°%
¥or [ Y
1234
Q)
1.234x10%%
+T [ Iy
1234
©
0.0012348x05%

3. Dé thoat khdi Ché do chuyén déi ENG, nhan ®.
« Thao tac nay sé thoat khdi Ché dd chuyén dbi ENG va lam cho dau %
bién méat khdi man hinh.

0.001234x10"
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« Ban ciing c6 thé thoat khdi Ché dd chuyén dbi ENG bang cach nhan
hodc (0.
Lwuy

+ Khong thé thyc hién cac phép tinh toan théng thwdng khi dang & Ché do chuyén déi
ENG. D& bat dau phép tinh m&i, hay thoat khéi Ché do chuyén déi ENG.

« Ky phap ky thuat ciing cé thé dwoc hién thi bang ky hiéu ky thuat. Dé biét chi tiét, vui
Iong xem "Ky hiéu ky thuat" (trang 64).

Chuyén déi hé luc thap phan (Phép
tinh do, phut, giay)

Ban c6 thé chuyén dbi két qua tinh toan gia tri thap phan sang gia tri luc

thap phan.

| Chuyén doi két qua tinh toan gia tri thap phan
sang gia tri luc thap phan

1,25 =1°150"
¥ [ e
1.25
1025 5
q
¥ [ e
1.25
— [Sexagesimal]
1°15'0"

| Nhap va tinh bang gia tri luc thap phan

Ngoai viéc chuyén ddi gia tri dwoc hién thi sang gia tri luc thap phan, ban
cling c6 thé nhap cac gia tri luc thap phan va str dung chung trong cac
phép tinh.
Cu phap sau dung d& nhap mét gia tri luc thap phan:

{d6} ® @ (°999) {phut} ® D(°999) {gidy} ® D (°999)
Lwu y rang ban phai ludn nhap ndi dung cho dé va phut, ngay cé khi
ching bang khong.

Dé thyc hién phép tinh 2°20°30” + 9'30”. Tiép theo, chuyén dbi két
qua tinh toan sang gia tri thap phan.

2@ @(o,,,)ZO@ @(o,,,)BO@ @(o,,,)@ EU?DED 30°+4+0° g- Bﬁn
0® @D (°999)9® @ (°999)30® @D (°999)@

2°30'0"
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N "
(Chuyén déi sang gia trj thap phan.) [2 207 30°+0°9730
@ — [Decimal] -

vor [ "
(Tra v& dang hién thi hé luc thap phan.) | 20" 30°+0°3°30

— [Sexagesimal]
2°30'0"
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Tinh toan nang cao

Phan nay mé ta cac lénh, ham va ky hiéu chung cho tat c& rng dung cla
may tinh. Th tw dwoc str dung & day trinh bay cac Iénh, ham, va ky hiéu
giébng nhw thir tw ma ching dwoc hién thi trén menu CATALOG xuét hién
khi ban nhan @).

Lwuy

» Ngoai ra con co cac muc menu CATALOG danh riéng cho (rng dung ctia may tinh,
khong dwoc hién thi & day. Vui long xem chwong danh cho tirng tng dung may tinh
dé biét thém thong tin v& cac muc menu danh riéng cho &ng dung.

« Tuy thudc vao ng dung may tinh ban dang st dung va man hinh dwoc hién thi b&i
trng dung may tinh, ban cé thé khoéng nhap dwgc moét sb Iénh, ham hodc ky hiéu. Cac
lénh, ham va ky hiéu khong thé nhap sé khong xuét hién trén menu CATALOG.

» Céac Iénh, ham va ky hiéu dwgc mo tad & day khong kha dung trong trng dung Base-N.

Giai tich ham

Phan nay sé gidi thich cac 1énh va ham ban c6 thé nhap sau khi thwc hién
thao tac: @ — [Func Analysis].

| Derivative(d/dx)
Derivative(d/dx) 14y hé sé vi phan gan dung tai toa do x dwoc chi dinh (a)
trong biéu thirc f{x) dau vao.

Lwuy

+ Ham nay c6 thé dwoc st dung véi bat ky (rng dung may tinh nao sau day: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.

Cu phap nhap

Cu phap nhap phu thudc vao cai dat Input/Output trén menu SETTINGS,
nhw dwoc thé hién trong bang bén duéi.

Cai dat Input/Output Cu phap nhéap

Mathl/MathO hoac Mathl/DecimalO d—i(f(x))lm
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Linel/LineO hosc Linel/DecimalO d—i(ﬂx), a, tol)*

* tol chi dinh dung sai, sé tré thanh 1 x 107" khi khéng nhéap gi cho fol.

Nhirng Iwu y khi tinh toan dao ham

* Khi str dung ham lwgng giac trong f(x), hay chi dinh "Radian" lam Angle
Unit trén menu SETTINGS.

« Gia tri fol nhé hon cho dé chinh xac cao hon, nhwng ciing lam mét
nhiéu th&i gian tinh toan hon. Khi chi dinh 1o/, hay st dung gia tri ttr 1 x
102 tr& Ién.

« Két qua khong chinh xac va 16i co thé xay ra do nhirng yéu tb sau day:
- cac diém khong ké tiép trong cac gia tri x
- sy thay déi dot ngoét trong cac gia tri x
- bao ham diém cwc dai va diém cuc tiéu trong cac gia tri x
- bao ham diém udn trong céc gia tri x
- bao ham cac diém khéng vi phan dwoc trong gia tri x
- két qua phép tinh vi phan gan bang khéng

Vi du vé phép tinh dao ham

Xac dinh f’(%) khi A(x) = sin(x) (B qua dic ta tol.)
(Input/Output: Mathl/MathO, Angle Unit: Radian)

I B 1
— [Func Analysis] > [Derivative(d/dx)] %{sin{x) L

@BHOO®D(1)E26 ’

(Input/Output: Linel/LineO, Angle Unit: Radian)

FII &
— [Func Analysis] > [Derivative(d/dx)] [9/9%¢s1n(x3. 712>

@HOO®O()®DTE20 €

| Integration(()

May tinh nay thwc hién tinh tich phan theo phwong phap Gauss-Kronrod
cua tich phan sb.

Lwuy

+ Ham nay c6 thé dwoc st dung vé&i bat ky ting dung may tinh nao sau day: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.
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Cu phap nhap

Cu phap nhap phu thudc vao cai dat Input/Output trén menu SETTINGS,
nhw dwoc thé hién trong bang bén duéi.

Cai dat Input/Output Cu phap nhéap
b
Mathl/MathO hozc Mathl/DecimalO Jfﬁ%ﬁf
a
Linel/LineO hodc Linel/DecimalO j(f (x), a, b, tol)*

* tol chi dinh dung sai, sé tré thanh 1 x 107'° khi khéng nhéap gi cho fol.

Lwu y khi tinh toan tich phan

* Khi str dung ham lwgng giac trong f(x), hay chi dinh "Radian" lam Angle
Unit trén menu SETTINGS.

« Gia tri fol nhé hon cho dd chinh xac cao hon, nhwng ciing lam mét
nhiéu thdi gian tinh todan hon. Khi chi dinh o, hay st dung gia tri ttr 1 x
102 trd Ién.

« Tuy vao ndi dung cua f{x), cac gia tri dwong va am trong khoang lay
tich phan hodc khodng |4y tich phan, 16i I&n cé thé xay ra trong cac gia
tri tich phan dwoec tinh toan. (Vi du: Khi c6 cac phan co6 diém khéng ké
tiép hoac thay dbéi dot ngdt. Khi khodng 14y tich phan qua réng.) Trong
nhirng trwdng hop nhw vay, viéc chia khodng lay tich phan thanh nhiéu
phan va sau dé thuc hién tinh toan c6 thé cai thién do chinh xac tinh
toan.

Vi du vé phép tinh tich phan

j(ln(x), 1,e¢)=1 (Bo6 qua dac ta rol.)
(Input/Output: Mathl/MathO)

— [Func Analysis] > [Integration(/)] J: I:m{x} dx ’
®E@(IN)@OOV1O® @ ()&

(Input/Output: Linel/LineO)

— [Func Analysis] > [Integration(f)] ;{1nm(x), 1, e)
®@INOO®ONT®OL)D®()®
@

53



| Summation(x)

V&i Z(, ban cé thé tinh dwoc tdng clia mét biéu thirc f{x) dau vao cho moét
mién cu thé.

Lwuy

+ Ham nay c6 thé dwoc st dung véi bat ky (rng dung may tinh ndo sau day: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation (ngoai trir Solver), Inequality,
Matrix, Vector, Ratio.

Cu phap nhap

Cu phap nhap phu thudc vao cai dat Input/Output trén menu SETTINGS,
nhw dwoc thé hién trong bang bén duéi.

Cai dat Input/Output Cu phap nhap
b
Mathl/MathO hoac Mathl/DecimalO Z (f(x))
X=a
Linel/LineO hoac Linel/DecimalO Z(f(x), a, b)*

* a va b 1a cac sb nguyén cé thé dwoc chi dinh trong mién -1 x 100 <4 <b
<1x10'

Vi du vé phép tinh =

5

Y (x+1)=20
x=1
(Input/Output: Mathl/MathO)
¥ @ e
— [Func Analysis] > [Summation(Z)] i (et+1)
®D1O1®56 |7
20
(Input/Output: Linel/LineO)
= e
— [Func Analysis] > [Summation(Z)] 2(x+1.1.5) 20
OD1IOON®OL)BOE®

| Product(1n)

V&i [](, ban c6 thé tinh dworc tich ctia mét biéu thire f{x) dau vao cho mét
mién cu thé.
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Lwuy

« Ham nay c6 thé dwoc st dung véi bat ky ('ng dung may tinh ndo sau day: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation (ngoai trir Solver), Inequality,
Matrix, Vector, Ratio.

Cu phap nhap

Cu phap nhap phu thudc vao cai dat Input/Output trén menu SETTINGS,
nhuw dwoc thé hién trong bang bén dudi.

Cai dat Input/Output Cu phap nhap
b
Mathl/MathO hoac Mathl/DecimalO ﬂ(f(x))
Linel/LineO hoac Linel/DecimalO I(A(x), a, b)*

* a va b la cac sb nguyén cé thé dwoc chi dinh trong miéna <1 x 100, <
1 %109 4 <b.

Vi du vé phép tinh []

5

[+ 1)=720
x=1
(Input/Output: Mathl/MathQ)
5 Yo E &
— [Func Analysis] > [Product(IM)] [ ¢x+1)
@®@®101056 |~ 720

(Input/Output: Linel/LineO)

— [Func Analysis] > [Product(I)] M¢x+1,1,5) ‘?El:l
@R1DON DO

| Remainder

Ban c6 thé s& dung ham +R dé tinh thwong sb va sb du trong phép chia.
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Lwuy

« Ham nay c6 thé dwoc st dung trén man hinh tinh toan ctia cac (rng dung may tinh
bén duwdi.
Calculate, Statistics, Matrix, Vector

Dé tinh thwong sb va sb dw cta 5 + 2 (thwong s6 = 2, s6 dw = 1)

A -
5 @ — [Func Analysis] > [Remainder] |>*}2

269

2. R=

Lwuy

+ Khi ban thyc hién phép tinh s dw, thwong sé duwoc lwu trong bién E, trong khi gia tri
sb6 dw duwoc lwu trong bién F.

+ Chi c6 gia tri thwong sé ctia phép tinh +R méi dwoc lwu trong bé nhé Ans.

+ Két qua tinh toan duwgc hién thi nhw minh hoa trén man hinh & bén phai khi
Linel/LineO hoac Linel/DecimalO dwgc chon cho cai dat Input/Output trén menu
SETTINGS.

[
5+R2

== J

Trwong hop khi phép chia c6 dw tré thanh phép chia khéng
dw

Néu phép chia c6 dw tén tai mét trong nhirng diéu kién sau thi phép tinh

sé dwoc thwe hién nhw phép chia binh thuwdng (phép chia khong dw).

« Khi s6 bi chia hodc s chia c6 gia tri qua lon.

« Khi thwong sé khéng phai la s6 nguyén dwong, hodc néu sb du khéng
phai 1a sb nguyén dwong hoac gié tri phan sé dwong.

| Logarithm(logab), Logarithm(log)

S dung ® @ (log) hodc @ — [Func Analysis] > [Logarithm(log)] dé& nhap
logab dwdi dang log (@, b). Co sb 10 la cai d&t mac dinh ban dau néu ban
khéng nhap gi cho a.

log101000 = log 1000 = 3

7o B
log(1000>

® @(log)10000) €
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Vidu 2: log216 =4

7o 1
log(2, 163

®@(log)2® O(,)16 D @

Phim @ (hodc @ — [Func Analysis] > [Logarithm(logab)]) ciing cé thé
dwoc str dung d& nhap, nhwng chi trong khi Mathl/MathO ho&c Mathl/
DecimalO duwogc chon cho Input/Output trén menu SETTINGS. Trong
trwdng ho'p nay, ban phai nhap mét gia tri cho co s nay.

Vidu 3: log216 = 4

¥ [
108,¢16)

@2 1669

| Natural Logarithm

S dung ® @ (In) hodc @ — [Func Analysis] > [Natural Logarithm] dé&
nhap "In".

Vi du: In 90 (= log.90) = 4,49980967

7
1n<{390>

® @)(In)o0 QO &

4.43980967

Xac suat

Phan nay sé giai thich cac 1énh va ham ban c6 thé nhap sau khi thwc hién
thao tac: @ — [Probability].

1%
Viéc nhap mét gia tri sau Iénh % sé bién gia tri nhap thanh phan tram.

Lwuy

« Ban khéng thé nhap % béng (ng dung Complex.

Vidu 1: 150 x 20% = 30

150®20 |156%20% :
— [Probability] > [%]
@ 30
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Tim phan trdm cla 880 dé thu dwoc két qua la 660. (75%)

660880
— [Probability] > [%]
&

Tim két qua con lai khi giam di 25% cta 3500. (2625)

35003500%)25
— [Probability] > [%]
@

| Factorial(!)

Ham nay thu dwoc giai thira ctia mét gia tri bang khéng hodc mot s

nguyén dwong.
(5 +3)!=40320

O5®30
— [Probability] > [Factorial(!)]
®

| Permutation(P), Combination(C)

Ham hoan vi (nPr) va ham t6 hop (nCr)

¥o [
660-+-880%
79
¥or [ Y
3500-3500x25%
2625
r=AD Y
{5+3>!
40320

DPé xac dinh sb cac hoan vi va td hop co thé tim duwoc khi lwa bén

nguwoi tr mot nhém 10 nguoi.
Hoan vi:

10
— [Probability] > [Permutation(P)]
4@

T4 hop:

10
— [Probability] > [Combination(C)]
469

| Random Number

¥T [ Y
10P4
2040
+T [ Iy
10C4
210

Ham nay tao ra mét sb gid ngau nhién trong khoang t 0,000 dén 0,999.
Két qua dwoc hién thi nhw mot phan sé khi Mathl/MathO dwoc chon cho

Input/Output trén menu SETTINGS.
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Lwuy

« Khong thé nhap Ran# bang Solver clia trng dung Equation.

Vi du: P& 14y sb nguyén ngu nhién cé ba chir sb

1000 (1000Ran#
— [Probability] > [Random Number]

€@ 312

(M@i 1an thye hién sé cho két qua khac nhau.)

| Random Integer

Ham nay tao ra mét sé nguyén ngau nhién gia gitra gia tri bat dau va gia
tri két thuc da xac dinh.

Lwuy

« Khong thé nhap RanlInt# bang Solver clia (ng dung Equation.

Vi du: P& tao ra sb nguyén ngau nhién trong khoang t» 1 dén 6

— [Probability] > [Random Integer] |RanInt#¢1, 6}
1®O)BO
@ 5

(Méi Ian thuwe hién sé cho két qua khac nhau.)

Tinh toan so

Phan nay sé giai thich cac Iénh va ham ban c6 thé nhap sau khi thyc hién
thao tac: @ — [Numeric Calc].

| GCD, LCM

GCD xac dinh wéc chung I&n nhét cla hai gia tri, trong khi LCM x&c dinh
bdi chung nhd nhét.

Vi du 1: D& xac dinh wéc chung I&n nhét cta 28 va 35

v [
— [Numeric Calc] > [GcD] |6CD¢28: 33>

28 0()350 @

Vi du 2: D& xéac dinh bdi chung nhé nhét ctia 9 va 15
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— [Numeric Calc] > [LCM] '—Cﬁ(ﬁﬂr 15
IDO()150

45

| Absolute Value

Khi ban dang thwc hién tinh toan mét s thwe, ham nay sé chi lay gia tri
truyét dbi.

Vidu:|2-7|=Abs(2-7)=5
(Input/Output: Mathl/MathO)

Vo @ "
_ [Numeric Calc] > [Absolute Value] |27
207
5
(Input/Output: Linel/LineO)
B i
— [Numeric Calc] > [Absolute Value] |#8S¢2=7? c
2070 ®

| Recurring Decimal

Ban c6 thé s& dung muc menu bén dwdi dé nhap sb thap phan tuan hoan.
— [Numeric Calc] > [Recurring Decimal]

D& biét chi tiét, vui long xem "Chuyén doi s6 thap phan tuan hoan

(Phép tinh s6 thap phan tuan hoan)" (trang 45).

| Integer Part
Ham nay trich phan sb nguyén cua gia tri.

Vi du: D& trich phan sé nguyén cla -3,5

¥ [
_ [Numeric Calc] > [Integer Part] 1"t ¢=3-5}

®O(()BO50@®

| Round Off

S dung ham Round Off (Rnd) lam cho cac gia tri phan sé thap phan cla
dbi sbé dwoc 1am tron theo cai dat Number Format hién tai. Vi du, két qua
bén trong va dugc hién thj cla Rnd(10 + 3) 1a 3,333 khi cai dat Number
Format la Fix 3. S& dung cai dat Norm 1 hoac Norm 2 l1am cho dbi sé
dwoc lam tron & chir sb thir 11 ctia phan dinh trj.
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Pé thuc hién cac phép tinh sau day khi Fix 3 dwoc chon cho sb cac
chiv s hién thi: 10 + 3 x 3 va Rnd(10 + 3) x 3
(Input/Output: Mathl/DecimalO, Number Format: Fix 3)

¥o [ Fl &

10+3%3
103X 3@

10.000

Vo [ Fl¥.
— [Numeric Calc] > [Round Off] |Rnd¢10+3)x3
10®30 ®3e

9.988

| Largest Integer
Ham nay xac dinh sb nguyén I&n nhat khéng vuot qua gia tri.

Dé xac dinh sb nguyén I&n nhéat khéng vwot qua -3,5

¥ [
_ [Numeric Calc] > [Largest Integer] [ZNt8¢-3.53

® ()OO0

Pon vi goc, toa do cwc/toa do hinh
chir nhat, hé luc thap phan

Phan nay sé gidi thich cac 1énh, ham, va ky hiéu ban c6 thé nhap sau khi
thwc hién thao tac: @ — [Angle/Coord/Sexal.

| Degrees, Radians, Gradians

Cac ham nay chi dinh don vi géc.
° chi dinh d6, " radian, va ¢ gradian.
Ban c6 thé nhap tirng chirc ndng bang cach sir dung cdc muc menu bén
dudi.
— [Angle/Coord/Sexa] > [Degrees]
— [Angle/Coord/Sexa] > [Radians]
— [Angle/Coord/Sexa] > [Gradians]

n/2 radian = 90° (Angle Unit: Degree)

®D0®2 |r,”" ‘
— [Angle/Coord/Sexa] > [Radians]

(@ :1i]

M
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| Rect to Polar, Polar to Rect

"Pol(" chuyén ddi toa d hinh chir nhat sang toa dd cwc, trong khi "Rec("
chuyén dbi toa dd cwc sang toa d hinh chir nhat.

Pol(x, y) = (r, ) Rec(r, 0) = (x, y)
Yl p(xy) Yl p(r.6)
""""""" _Pol ,
Y Rec f
0 X X 0 X

* Chi dinh Angle Unit trén menu SETTINGS trwéc khi thwee hién tinh toan.

« Két qua tinh toan cho » va 6 va cho x va y 1an lwot duwoc lwu cho cac
bién x va y.

« Két qua tinh toan 6 dwoc hién thi trong mién -180° < 0 < 180°.

Lwuy

» Pol( va Rec( c6 thé dwoc siv dung trén man hinh tinh toan ctia cac (r‘ng dung may tinh
bén dudi.
Calculate*, Statistics, Matrix, Vector
* Khi tat Verify (Verify OFF).

Vi du 1: D& chuyén déi toa do hinh chi nhat (v2, V2) sang toa dd cuc
(Input/Output: Mathl/MathO, Angle Unit: Degree)

— [Angle/Coord/Sexa] > [Rect to Polar] PU?(EE- {2)
@20®O()@®20 0@

r=2, 8=45

Vi du 2: Bé chuyén ddi toa dd cuc (12, 45°) sang toa dd hinh chi nhat
(Input/Output: Mathl/MathO, Angle Unit: Degree)

— [Angle/Coord/Sexa] > [Polar to Rect] |Rec({2,45)
@20 ®O(,) 4506

=1, y=1

| D6, Phat, Giay

Ban c6 thé str dung cac phim hodc muc menu bén dwéi dé nhap cac ky
hi€u hé luc thap phan (7).

® D(°99)

— [Angle/Coord/Sexa] > [Degs Mins Secs]
Dé biét chi tiét, vui ldng xem "Chuyén doi hé luc thap phan (Phép tinh
do, phut, giay)" (trang 49).
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Ham hyperbolic, lwo'ng giac

Phan nay sé giai thich v& cac ham hyperbolic va ham lwong gidc.
| Cac ham hyperbolic
C6 thé nhap cac ham hyperbolic bang cach str dung cac muc menu bén
duoi.
— [Hyperbolic/Trig] > [sinh], [cosh], [tanh], [sinh™'], [cosh™"], hodc
[tanh™]

Cai d&t don vi géc khéng anh hwéng dén tinh toan.

sinh 1 =1,175201194

sinh¢1)
— [Hyperbolic/Trig] > [sinh] 10) @
1.1752011894

| Cac ham lwong giac

C6 thé nhap cac ham lwong giac bang cac phim hodc cac muc menu bén
dwoi.

Phim Muc menu
D) — [Hyperbolic/Trig] > [sin]
— [Hyperbolic/Trig] > [cos]
— [Hyperbolic/Trig] > [tan]
® @ (sin™) — [Hyperbolic/Trig] > [sin™"]
® @ (cos™) — [Hyperbolic/Trig] > [cos™]
® @ (tan™) — [Hyperbolic/Trig] > [tan™]

Chi dinh Angle Unit trén menu SETTINGS trwdc khi thye hién tinh toan.

sin 30 = % (Angle Unit: Degree)

+o [
sin<30)

D300 @

M=
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Ky hiéu kj thuat

May tinh cGa ban hé tro st dung 11 ky hiéu ky thuat (m, «, n, p, f, k, M, G,

T, P, E) ban c6 thé dung dé nhap gia tri hodc dé hién thi két qua tinh toan.

« C6 thé nhap ky hiéu k¥ thuat sau khi thwc hién thao tac: — [Engineer
Symbol].

« D& hién thj két qua tinh toan cé ky hiéu k¥ thuat, hay thwc hién thao tac
sau: & — [Calc Settings] > [Engineer Symbol] > [On].

Vi du vé nhap va tinh toan cé dung ky hiéu ky thuat

Vi du 1: Nhap 500k
(Engineer Symbol: On)

500 @ — [Engineer Symbol] > [Kilo]

500k

Vi du 2: Dé tinh 999k (kilo) + 25k (kilo) = 1,024M (Mega) = 1024k (kilo) =
1024000
(Engineer Symbol: On)

Yo [ E
999 ® — [Engineer Symbol] > [Kilo] @ [399k+25k
25 @ — [Engineer Symbol] > [Kilo] @
1.024H
995k+25k
— [ENG Notation]
(Nhap Ché d6 chuyén déi ENG.)
1024k%
Yo [ E
999k+25k
)
1024000 =%
+o [ E
999k+25k
®
1024k%

« Nh4dn ®), @, hoac @0 sé thoat Ché dd chuyén dbi ENG va lam &
bién mat khai man hinh. D& bt dau phép tinh mai, hay thoat khdi
Ché d6 chuyén dbi ENG.

« D& biét chi tiét vé Ché d6 chuyén dbi ENG, vui long xem "Ky phap k¥
thuat" (trang 48).
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Hang so khoa hoc

May tinh ctia ban cé tich hop 1én dén 47 hang sb khoa hoc. Céac gia tri nay
déu dwa trén cac gia tri dwoc CODATA khuyén nghi (2018).

D& nhap hang sbé khoa hoc ¢ (tbc 6 anh sang trong chan khéng),
va hién thj gia tri ciia nd
1. Nh&dn @), chon [Sci Constants], sau d6 nhan @&).
« Thao tac nay sé hién thi menu danh muc hang s khoa hoc*.

Universal >
Electromagnetic »
Atomic&Nuclear »
Physico—Chem -

2. Chon [Universal], sau d6 nhan @R,
« Thao tac nay sé hién thi menu cac hang sé khoa hoc trong danh muc

Universal.
f
C £0
o fo
G 1r
tp
3. Chon [c], sau d6 nhan @R.
[cl |
4. Nhan @.
+or [ "
c
299792458

* Bang dwdi day trinh bay cac hang s khoa hoc c6 trong méi danh muc.

Danh muc Hang s6 khoa hoc
Universal h, 4, c, €0, po, Zo, G, Ip, tp
Electromagnetic HN, 1B, €, Po, Go, Kj, Rk

m b m H m H m b a b (X” r b )\' 1 H
Atomic&Nuclear pr TTin, e, T, €0, & Te, AC. T
ch’ }\‘Cn’ R°°1 Mp’ l’le’ Hn’ H}ls m‘[

Physico-Chem My, F, Na, k, Vm, R, €1, C2,

Adopted Values On, atm, Rk-g0, Kj-90
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Other t

Chuyén déi don vi

Ban c6 thé s dung cac Iénh chuyén dbi don vi dé chuyén dbi tr don vi do
lwéng nay sang don vi do lworng khac. D liéu cong thire chuyén déi dwa
trén "NIST Special Publication 811 (2008)".

Dé chuyén dbi 5 cm thanh inch (Input/Output: Linel/LineO)
1. Nhap gia tri can dwoc chuyén ddi.

5 [5i

2. Nhdn @, chon [Unit Conversions], sau d6 nhan @R,
« Thao tac nay sé hién thi menu cac danh muc chuyén déi don vi*.

Length  »]
Area >
Yolume >
Mass -

3. Chon [Length], sau d6 nhan ©R.
« Thao tac nay sé hién thi menu cac lénh chuyén ddi trong danh muc
Length.

inrcn  Wwilly
ftem me .
wdr Tesd
milerkm kmrmile
n milerm men mile

4. Chon [cm»in] (Iénh chuyén ddi tr centimet thanh inch) réi sau d6 nhan

@.

[Scmrinl |

5. Nhan @b.

Scmrin
1.968503937

* Bang dwdi day trinh bay cac 1énh chuyén dbéi don vi c6 trong mdi danh
muc.

Danh muc Lénh chuyén déi don vi

inscm, cmuein, ftem, meft, ydem, m
Length » yd, mile» km, km» mile, n mile» m,
m» n mile, pc» km, km»pc
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Area acre» m2, m?» acre

gal(US)» L, L»gal(US), gal(UK)» L, L

Volume

» gal(UK)
Mass oz» g, gr 0z, Ib»kg, kgrlb
Velocity km/h» m/s, m/s» km/h

atm» Pa, Pa» atm, mmHg» Pa, Pa
Pressure » mmHg, kgf/cm?» Pa, Pa» kgf/cm?,
Ibf/in2» kPa, kPa» Ibf/in?

Energy kgfe mw» J, J» kgfe m, J»calys, calis» J
Power hp» kW, KW» hp
Temperature °F»°C, °C»°F

Khoi lwong nguyén tir va bang tuan
hoan héa hoc

B& nhé may tinh cGa ban cé chira cac gia tri cho khéi lwong nguyén tir
ctia 118 nguyén t6. Ban co thé hién thi mét gia tri cu thé trén man hinh va
tham chi st dung céc gia tri trong tinh toan. Khéi lwong nguyén tlr do may
tinh clia ban tao ra dwa trén khéi lwgng dwoc IUPAC (Lién minh Québc té
vé Héa hoc thuan tay va Héa hoc &ng dung) cdng bd cho ndm 2019.

DPé xem lai khéi lwong nguyén tir tir bang tuan hoan héa hoc

Dé hién thj khéi lwong nguyén t&r ciia scandi (Ky hiéu hoa hoc: Sc,
S6 nguyén tor: 21)

1. Hién thi man hinh bang tuan hoan héa hoc.
— [Atomic Table] > [Periodic Table]

!qllllllllll ] 1 _(2)
S He —1-(3)
e R e

(1) Con tré
(2) S6 nguyén tw
(3) Ky hiéu héa hoc
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(4) Khéi lwgng nguyén to*

* Gia trj khéi lwong nguyén tr trong ngodc vuéng ([ ]) thé hién khéi
lwong nguyén tlr ctia nguyén té dwoc biét dén nhiéu nhéat trong cac
déng vi.

2. Di chuyén con tré dén 6 scandi.

000006 [mmiE
Pissassasassassy 44, 955908

3. Nhan €.
« Thao tac nay sé& nhap lénh xem lai khdi lwong nguyén t& (AtWt) theo
sau la s6 nguyén t&r scandi (21).

[AtWt 21 |

4. Nhan @ lai lan nova.
« Thao tac nay sé hién thj khéi lwong nguyén t&r ctia scandi.

7 0
AtWt 21

44.355908

Dé xem lai khéi lwong nguyén tir bang cach nhap sé nguyén
tw

1. Nhdn @), sau dé chon [Atomic Table] > [Atomic Weight].
« Thao tac nay sé nhap lénh xem lai khdi lwong nguyén tor (AtWh).
2. Nhap sb nguyén t&r mong mudn, sau d6 nhan @.

Cac muc khac

Céac ham va ky hiéu cé thé nhap bang cac phim may tinh ciing cé thé
dwoc nhap bang menu [Other]. S dung @ — [Other] dé hién thi menu
ham va ky hiéu. Vi du, d& nhap Ans, ban cé thé nhan @ hodc thwc hién
thao tac sau: @ — [Other] > [Ans].

Bang dwai day thé hién muc menu [Other] twong (rng véi tirng thao tac
phim.
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Muc menu

Phim

Ans

PreAns

® @) (PreAns)

T

®D()

e

®®(e)

V(

O

x\/_(

®@"0)

-1 *1

®@m™

2 *2

@

N

*3

®O((-)

®0O()

©

®

*1 Nghich dao
*2 Binh phuwong
*3 D4u trwv
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Pang ky va st dung phwong
trinh xac dinh cho f{x) va g(x)

Pang ky va str dung phwong trinh
xac dinh cho f{x) va g(x)

May tinh nay cé cac ham "f(" va "g(" ma ban c6 thé sir dung sau khi déng
ky phwong trinh xac dinh cho cac ham dé. Vi du, sau khi dang ky f(x) = x?
+ 1 lam phwong trinh xac dinh cho ham "f(", ban cé thé tinh dwoc f(0) = 1
va f(5) = 26.

Nhén (=) dé hién thi menu dang ky phwong trinh xac dinh cta f{x) hodc
2(x), va dé nhap "f(" hoac "g(".

g{x)
Define f<{x>
Define g{x)

Lwuy

+ Cac phwong trinh xac dinh cla f{x) va g(x) cling dwoc st dung bang f(x) va g(x) trong
&ng dung Table. Dé biét thong tin vé (rng dung Table, vui ldng xem "Tao mét bang
s6" (trang 108).

| Dang ky phwong trinh xac dinh

DPé dang ky flx) = x* + 1
1. Nhé&n ©), chon biéu twong &rng dung Calculate, sau d6 nhan @X.
2. Nhén (=), sau dé chon [Define f(x)].
« Thao tac nay sé hién thi man hinh dang ky phwong trinh f(x).

[f(x>d |

3. Nhap x2 + 1.

@@ D1 [f xr=2+1 |

4. Nhan @®.
« Thao tac nay sé dang ky biéu thirc ban nhap vao, va man hinh hién
thi trwdc khi ban nhan () & bwédc 2 cha quy trinh nay sé xuét hién lai.

Lwuy

« Phwong trinh xac dinh c6 thé dwoc dang ky tir bat ky (’ng dung may tinh nao, ngoai
trir Distribution, Equation (Simul Equation/Polynomial), Inequality, Base-N, Ratio va
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Math Box. Tuy nhién, tiy vao man hinh dwoc hién thi b&i (rng dung may tinh (vi du,
néu man hinh menu dwoc hién thi), menu co thé khong xuét hién khi ban nhan ().

| Thwc hién tinh toan bang cach gan gia tri cho
phwong trinh xac dinh da dang ky

Vi du 2: D& gan gia tri x = 3 cho f{x) ma ban da dang ky trong Vi du 1
(Tiép tuc ttr Vi du 1)
1. Nhén @), sau dé chon [f(x)].

* Thao tac nay sé nhap "f(".

(£

2. Gan gia tri la 3, sau d6 thyc hién tinh toan.

30 @

10

| Dang ky ham hop

Vi du 3: D& chén ham f{x) da dwoc xac dinh trong Vi du 1 vao g(x) dé
dang ky g(x) = flx) x 2 - x
(Tiép tuc tor Vi du 1)
1. Nhan (), sau d6 chon [Define g(x)].
« Thao tac nay sé& hién thi man hinh dang ky phwong trinh g(x).

HEZE]

2. Nhap f{x) x 2 - x.

@*@ @O X200 ® [gtxr=F(x)X2—

*Nhan () khi man hinh d&ng ky phuwong trinh g(x) dwoc hién thi, muc
menu duy nhét xuat hién la [f(x)]. Twong tw nhw vay, nhan () khi man
hinh dang ky phwong trinh f{x) dwoc hién thi, muc menu duy nhét xuét
hién 1a [g(x)].

3. Nhan @.

« Thao tac nay sé dang ky phuong trinh ban nhap vao va quay vé man

hinh hién thj trwéc khi ban bat dau thao tac & bwéc 1.

Lwuy

+ Thao tac dé gan gia tri cho x cia ham g(x) va tinh toan két qua sé twong tw nhu trong
phan "Thwe hién tinh toan bang cach gan gia tri cho phwong trinh xac dinh da
dang ky" (trang 71). Tuy nhién, lu y rang thay vi chon [f(x)] & buéc 1, ban nén chon
[9()]-

* Trong thao tac & Vi du 3, ban nhap f{x) vao phwong trinh xac dinh cla g(x). Ngwoc lai,
ban ciing cé thé nhap g(x) vao phuong trinh xac dinh cta f{x). Tuy nhién, ban khéng
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dwoc nhap g(x) vao f{(x), va nhap f{x) vao g(x) cing mét luc. Néu ban lam nhw vay, 16i
Circular ERROR sé xay ra khi ban thyc hién tinh toan str dung ham f{x) hoac g(x).

| Gitr lai dir liéu
Thuc hién bt ky thao tac nao dwdi day sé lam cac phwong trinh xac dinh
dwoc dang ky cho f(x) va g(x) bi xéa.
« Nhan O
« Str dung menu SETTINGS dé chuyén déi cai d&t Input/Output gitra
Mathl*! va Linel*2.
*1 Mathl/MathO hodc Mathl/DecimalO
*2 |inel/LineO hodc Linel/DecimalO

* Thue hién & — [Reset] > [Settings & Data] hodc @ — [Reset] >
[Initialize All]
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Sw dung Verify

Téng quan vé Verify

Verify sé& kiém tra tinh dung dan ctia mot dang thirc hodc bat dang thirc
dau vao.

Vo [E
242 =48
True
Vo [ ] &
2{2 <{6
False

Verify cé thé st dung v&i cac (rng dung may tinh sau day.
Calculate, Table, Equation, Complex

Lwuy

+ Muc tiéu va quy trinh can thiét cho thao tac Verify sé phu thudc vao (rng dung may
tinh str dung thao tac. Dé biét chi tiét, vui Iong xem cac phan bén duéi.
Str dung Verify vé&i trng dung Calculate (trang 74)
Str dung Verify vé&i trng dung Table (trang 111)
Str dung Verify vé&i trng dung Equation (trang 121)
Str dung Verify vé&i i’lng dung Complex (trang 128)

| Bat va tat Verify

Dé st dung Verify, trwdc tién ban can bat tinh ndng nay bang cach chon
[Verify ON] trén menu TOOLS cla trng dung may tinh.

Quan trong!

« Viéc chuyén dbi gitra bat va tét Verify trong tng dung Calculate hodc Complex sé x6a
toan bo lich str tinh toan.

* Trong khi Verify dwgc bat, mét (’ng dung may tinh chi co thé dwoc st dung cho cac
thao tac Verify. Khong thé dwoc st dung cho céc tinh toan binh thwdng. Tat Verify khi
ban khéng st dung.
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Lwuy

« Verify thwérng bi tat sau khi ban khéi chay mét (eng dung may tinh. Tuy nhién, néu
ban tr& vé man hinh HOME t&» mét (rng dung may tinh sau khi bat Verify, sau dé khéi
chay lai cung (rng dung may tinh d6 trwdc khi khéi chay mot (rng dung may tinh khac,
Verify van dwoc bat.

Dé bat Verify

1. Nhan ©), chon biéu twong cia rng dung may tinh ban mudn kh&i chay,
sau d6 nhan @X).
* Chon mét rng dung may tinh cé thé st dung Verify.
2. Nhén ¢ dé hién thi menu TOOLS.
« Tuy thudc vao man hinh dwoc hién thj bdi (’ng dung may tinh, menu
c6 thé khodng xuét hién khi ban nhan €.
3. Chon [Verify ON], sau d6 nhan @).
« Thao tac nay sé tré vé man hinh dwoc hién thj trwdc khi ban nhan
€. LGc nay, mot chi bao @ sé xuét hién & phia trén cung ctia man
hinh cho biét Verify dwoc bat.

Dé tat Verify

1. Nhan @9 dé hién thi menu TOOLS.
2. Chon [Verify OFF], sau dé nhan @R.
« Thao tac nay sé tré vé& man hinh dwoc hién thi trudc khi ban nhan
€9, va chi bdo @ sé& bién mat khadi phia trén cung cia man hinh.

Lwuy

« Verify sé bi tat khi ban thwc hién bat ky thao tac nao sau day.
-Nhan ()
-Nhéan @) (hodc (5)) dé tré v& man hinh HOME tir (rng dung may tinh hién tai, sau
do khéi chay trng dung may tinh khac
- Thyc hién @ — [Reset] > [Settings & Data] hoac @ — [Reset] > [Initialize All]

St dung Verify vé&i (rng dung
Calculate

Sau khi bat Verify trong irng dung Calculate, ban cé thé kiém tra xem mot
phwong trinh hodc b4t phwong trinh c6 dung hay khéng. "True" xuét hién
trén man hinh néu phwong trinh hodc bat phwong trinh ban nhap trén may
tinh 1a dung, con "False" s& xuat hién néu sai.
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| Thao tac méau véi Verify

Bat Verify trong rng dung Calculate trwéc khi thye hién thao tac bén duwdi.
Dé biét thong tin vé cach bat Verify, vui Iong xem "Dé bat Verify" (trang
74).

Vi du 1: D& kiém tra xem 49 = 12 14 dung hay sai

4@9® |g45=12 °
— [Verify] > [=]*
12@ True

* Ban c6 thé chon biéu twong dang thirc hodc biéu twong bat déng thirc
tr menu xuat hién khi ban nhan @), sau d6 chon [Verify].

Vi du 2: Dé kiém tra xem 0 < (% 2 - % dung hay sai.
v"Eszﬁl -] e
0 @ — [Verify] > [<] I:la% —%
8@®IO®O8®I® -
dalse

| Biéu thire c6 thé xac minh

Ban c6 thé nhap cac biéu thirc sau dé kiém tra.

« Céac dang thirc hodc bat déng thirc bao gdm mot toan tlr quan hé
4=+16,4#3,7>3,1+2<5,(3x6)<(2+6)x2, V...

« C4c dang thirc hodc bat déng thirc bao gdm nhiéu toan t& quan hé
1<1<1+1,3<7<4,22=2+2=4,2+3=5#2+5=8,v.v...

Nhirng Iwu y khi nhap biéu thirc vao

« Céc loai biéu thirc sau gay ra Syntax ERROR va khéng thé kiém tra
duwoc.
- M6t biéu thire trong d6 nhiéu toan t&r quan hé khéng duoc dinh hwéng
theo cung mét hwdng (Vidu: 5 <6 = 4)
- M6t biéu thire trong d6 c6 hai toan t&r sau day trong bat ky t6 hop nao
(Vidu:4 <6 #8)

« M6t sé biéu thirc khdng twong tng véi nhirng biéu thire dwoc mo ta &
trén ciing cé thé tao ra Syntax ERROR va khéng thé kiém tra dwoc.

| Thuwc hién thao tac xac minh tuan tw & phia bén
phai cua bieu thirc

Khi két qua kiém tra dung sai ciia dang thirc hodc bat dang thirc c6 chira
toan t&r quan hé dwoc hién thi, viéc chon mét toan t& quan hé tir menu
CATALOG sé& nhap vao phia bén phai cla biéu thirc dwoc kiém tra lam
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dong tiép theo. C6 thé sir dung kha ndng nay dé thwc hién kiém tra ding
sai lién tiép ctia dang thirc hodc bat dang thirc.

Thuwe hién danh gia dung sai lién tuc déi v&i (x + 1)(x + 5) = x%2 + x +
Sx+5vax?+x+5x+5=x>+6x+5

OCODIOO@D5D) [ x41) (x+5) =2 +x+5>
@ - [Verify] > [=]
@@ DX D50 D569 True

— [Verify] > [=] [x?+x+5x+5d

+or [ L] "
2 +x+5x+5=x° +6x+5

D@ D6® D569

True

Lwuy

+ Két qua kiém tra sé lwu 1 vao bd nhé Ans khi True va 0 khi False.

« Khi Verify dwoc bat (Verify ON), may tinh s& thuc hién thao tac toan hoc trén biéu
thirc dau vao, sau d6 hién thj True hodc False dwa trén két qua. Do do, sai sb tinh
toan cé thé xay ra hodc két qua toan hoc chinh xac cé thé khong dwoc hién thi khi
biéu thirc tinh toan dau vao bao gém tinh toan gan t&i diém ky di hodc diém udn cla
ham, hodc khi biéu thirc dau vao chira nhiéu thao tac tinh toan. Ngoai ra, nghiém
dwoc hién thi khi Verify tat (Verify OFF) cé thé khong dwoc danh gia 1a True, vi két
qua co thé khac véi div liéu ndi bd do 1am tron va do gidi han sb chiv s6 dwoc hién thi.
Diéu nay ciing &p dung dbi v&i cac (rng dung khac ngoai trng dung Calculate.
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St dung cac chirc nang QR
Code

St dung cac churc nang QR Code

May tinh ctia ban c6 thé hién thi cac biéu twong QR Code c6 thé doc
dwoc bang thiét bi théng minh.

Quan trong!

+ C4c thao tac trong phan nay gia dinh rang thiét bj théng minh dang dwoc st dung
c6 trinh doc QR Code c6 thé doc nhiéu biéu twong QR Code, va co thé két néi véi
Internet.

« Viéc quét QR Code dwoc may tinh nay hién thi bang thiét bj thong minh sé lam thiét bi
thdng minh dé truy cap trang web CASIO.

Lwuy

« QR Code s& xuét hién trén man hinh méi khi ban nhan (#) X)(QR) trong khi bét ky
man hinh nao dwéi day dwoc hién thi.
- Man hinh HOME
- Man hinh menu SETTINGS
- Man hinh 16i
- Man hinh két qua tinh toan trong bt ky (rng dung may tinh nao
- Man hinh bang trong bét ky (r’ng dung may tinh nao
- Man hinh &rng dung Spreadsheet
Dé biét chi tiét, vui long truy cap trang web ctia CASIO (https://wes.casio.com).

| Hién thi QR Code

Vi du: D& hién thi QR Code cho két qua tinh toan trong trng dung
Calculate ctia may tinh va quét bang thiét bi théng minh
1. Trong rng dung Calculate, thwc hién mot sb tinh toan.
2. Nhadn ® @ (QR) dé hién thi QR Code.
« Cac sb & goéc dudi bén phai ciia man hinh thé hién s QR Code hién
tai va tbng sb biéu twong QR Code. D& hién thi QR Code tiép theo,
nhan ) hodc @X.

Lwuy

- D& tré v& QR Code trwdc d6, hay nhan (V) hoac @K nhiéu 13n néu can dé cudn vé
trwdc cho dén khi QR Code xuét hién.

3. Str dung thiét bi théng minh dé& quét QR Code trén man hinh may tinh.
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- Dé biét thong tin vé cach quét QR Code, vui long tham khao tai liéu
ngudi dung vé trinh doc QR Code ban dang s dung.

| Néu ban gép khé khan khi quét QR Code

Khi QR Code dworc hién thi, str dung < va & dé diéu chinh do twong
phan hién thj cia QR Code. Viéc diéu chinh dd twong phan nay chi anh
hwéng dén man hinh QR Code.

Quan trong!

« Tuy vao thiét bi thdng minh va/hodc trng dung doc QR Code duoc st dung, ban c6
thé gap van dé trong viéc quét cac biéu twong QR Code duoc tao béi may tinh nay.

« Khi cai dat "QR Code" trén menu SETTINGS la "Version 3", nhirng trng dung may
tinh c6 thé hién thi cac biéu twong QR Code sé bj han ché. Néu ban cb hién thi QR
Code trong mét (rng dung khéng hé tro hién thi QR Code, théng bao "Not Supported
(Version 3)" s& xuét hién. Tuy nhién, QR Code dwoc tao bdi cai dat nay sé dé quét
bang thiét bi théng minh hon.

+ D& biét thém thong tin, vui long truy cap trang web ctia CASIO (https:/
wes.casio.com).
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Sw dung cac irng dung may
tinh

Tinh toan thong ké

ng dung Statistics tinh toan cac gia tri théng ké khac nhau dwa trén di
liéu bién don (x) hoac bién dai (x, ).

| Quy trinh chung dé thwe hién tinh toan théng ké

1. Nh&n @), chon biéu twong &ng dung Statistics, sau d6 nhan @.

2. Trén menu xuét hién, chon [1-Variable] (bién don) hodc [2-Variable]
(bién d6i), sau d6 nhan @%).
« Thao tac nay sé hién thj Bo soan thao théng ké.

=
H
1|
2
3
4
Bién don
H L
1|
2
3
4
Bién doi

3. Hién thi cot Freq (tan sd) néu can.
« D& biét chi tiét, vui Ibng xem "Cot Freq (Tan s6)" (trang 80).
4. Nhap di¥ liéu.
« D& biét chi tiét, vui Iong xem "Nhap div liéu biang B6 soan thao
théng ké" (trang 80).
5. Sau khi ban nhap di liéu xong, hay nhan @X.
« Thao tac nay sé lam cho menu bén dudi xuat hién.

1-Var Results

Statistics Calc

Bién don
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2—Var Results
Reg Results -

Statistics Calc »

Bién doi
6. Chon muc menu cho thao tac ban muén thyc hién.

« Chon [1-Var Results], [2-Var Results], hodc [Reg Results] d& xem
danh sach két qua tinh toan dwa trén dir liéu ban da nhap. Dé biét chi
tiét, vui Iong xem "Hién thi két qua tinh toan théng ké" (trang 83).

« D& hién thi man hinh tinh toan théng ké cho viéc thwc hién cac phép
tinh dwa trén di¥ liéu nhap, chon [Statistics Calc]. D& biét chi tiét, vui
lbng xem "S& dung man hinh tinh toan théng ké" (trang 87).

Lwuy

« Dé tré vé Bo soan thao théng ké tlr man hinh tinh toan théng ké, nhan (A0) sau dé

nhan .

| Nhap dir liéu bang Bb soan thao thong ké

B& soan thdo théng ké hién thj mét, hai, hodc ba cot: bién don (x), bién

don va tan sb (x, Freq), bién déi (x, y), bién ddi va tan sé (x, y, Freq). S6
lwong hang di liéu co thé dwoc nhap phu thudc vao sbé lwong cét: 160

hang cho mét cét, 80 hang cho hai cét, 53 hang cho ba cét.

Quan trong!

+ TAt ca di¥ liéu hién dang dwoc nhap vao B soan thao thdng ké sé bi xéa bat ct khi
nao ban thwc hién bat ky thao tac nao dw¢i day.
- Chuyén dbi kiéu tinh toan théng ké gitra bién don va bién déi
- Thay dbi cai d&t Frequency trén menu TOOLS

+ Viéc tinh toan thdng ké cé thé mat nhiéu thoi gian khi cé mét sé lwong 16n cac muc
dir liéu.

Cot Freq (Tan sb)

Néu ban bat cai dat Frequency trén menu TOOLS, mét cot c6 nhan "Freq"
ciing sé& dwoc dwa vao Bo soan thao thdng ké. Ban cé thé str dung cot
Freq dé chi dinh tan s6 (sb Ian xuat hién trong nhém di liéu cGia cing mot
mau) cta mdi gia tri mau.
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® Freaq

1
2
2
dq
Bién don
# 1 Freaq
1| I
2
3
4
Bién doi

Dé hién thi cot Freq

1. Trong khi Bd soan thao thong ké duoc hién thi, hay nhan va sau do
chon [Frequency] > [On].

2. Nhan @0 dé tr& vé Bo soan thao théng ké.

Pé an cot Freq

1. Trong khi Bd soan thao thong ké duoc hién thi, hay nhan va sau do
chon [Frequency] > [Off].

2. Nhan @0 dé tr& vé Bo soan thao théng ké.

Quy tac nhap dir liéu mau trén B soan thao théng ké

D@ liéu ban nhap dwoc chén vao 6 co6 con tré. St dung cac phim con tré
dé di chuyén con tré gitra cac 6.

Bood by —

|
Con tré

Sau khi nhap mét gia tri, nhan @. Thao tac nay dang ky gia tri va hién thi
t6i da sau chir sb trong 6.

Dé Iya chon bién doi va nhap div liéu sau: (170, 66), (179, 75),
(173, 68)
1. Nhan ©), chon biéu twong (ng dung Statistics, sau d6 nhan ©R.
2. Chon [2-Variable], sau d6 nhan @R.
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3. Str dung theo thao tac bén dwéi dé nhap di liéu.

1708179@173@ O |
66E 75668 | ;

Lwuy

« Trén Bo soan thdo théng ké, ban c6 thé lwu gia tri trong mét 6 vao bién. Vi du, néu
thye hién thao tac sau khi man hinh trong bwéc 3 & trén hién thi, may sé luvu 68 vao
bién A: (M) €2 — [A=] > [Store]. D& biét chi tiét vé& cac bién s6, vui long xem "Cac bién
(A,B,C,D, E,F x,y, z)" (trang 38).

Soan thao div liéu mau

Dé thay thé dir liéu trong mét 6
Trén Bo soan thdo thdng k&, di chuyén con tré dén 6 chira di¥ liéu ban
mudn chinh slra, nhap di¥ liéu m&i, sau dé nhan €.

Dé x6a mét hang
Trén Bo soan thao thdng ké, di chuyén con tré dén hang ban muén xoéa va
sau d6 nhan @.

Dé chén mét hang

1. Trén Bo soan thdo théng ké, di chuyén con tré dén hang sé nam dudi
hang ban sé chen.

2. Thyce hién thao tac sau: ¢ — [Edit] > [Insert Row].

Dé xoa tat ca néi dung cua B6 soan thao thong ké
Trén Bd soan thao théng ké, thuc hién thao tac sau: — [Edit] > [Delete
Alll.

Sap xép dir liéu

Ban c6 thé sap xép di liéu clia Bd soan thdo théng ké theo thir tw téng
dan hodc gidm dan trén cac gia trj x, v, hoac cot Freq.

Quan trong!

« Lwu y réng sau khi ban thay ddi trinh tw sdp xép di¥ liéu, ban sé khong thé tra vé trinh
tw gbc.
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Dé sap xép dir liéu nhap trong Vi du 1 (trang 81) theo thir tw
tang dan & cot x, va sau dé theo thir ty gidm dan & cot y
1. Str dung quy trinh trong Vi du 1 dé nhap di liéu.

2. Sép xép di¥ liéu theo thir tw tdng dan trén cot x.

o}
1 -le yEE
—[Sort] > [x Ascending] | 5 3| %2
) 170
3. Sap xép dir liéu theo th tw gidm dan trén cot y.
D]
. 1 x1_|"‘E| ﬂ
—[Sort] > [y Descending] | 3 13| &2
i
75

| Hién thi két qua tinh toan théng ké

Hién thij két qua tinh toan théng ké bién don

Man hinh 1-Var Results thé hién mét danh sach cac gia tri théng ké khac
nhau (vi du nhw gié tri trung binh va dd I&ch chuan khéng gian méau) dwoc
tinh toan dwa trén di¥ liéu bién don. Phan nay mé ta thao tac can thiét dé
hién thi man hinh 1-Var Results.

Dé nhap dir lieu dwsi day va hién thj cac két qua tinh toan théng
ké bién don

X 1 2 3 4 5 6 7 8 9 |10

Freq 1 2 1 2 2 2 3 4 2 1

1. Nhan ©), chon biéu twong (ng dung Statistics, sau d6 nhan ©R.
2. Chon [1-Variable], sau d6 nhan @R.
« Thao tac nay sé hién thi B6 soan thdo théng ké.
3. Nhan va sau doé chon [Frequency] > [On].
« Nhéan @0 dé tré vé Bo soan thao thdng ké.
4. Nhap di¥ liéu vao cot x.

1692693604 E@)56ED6 607 G869 @D 10ED

5. Nhap di¥ liéu vao cét Freq.
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©002@02@262@3@4@2@

6. Nhan @.

1-Var Results

Statistics Calc

7. Chon [1-Var Results], sau d6 nhan @R,
« Thao tac nay sé hién thj man hinh 1-Var Results.

i3 =5.95

I =119

e =337

2% =h. 4475

T =2.539192785

2K =G, 7oe842105

[c]

ﬁx f5ﬁ505155829
O (hodc ¥) fince) =1

Hed =6.5

b= =3

o]

maxx) =10
O (hoac )

« Dé biét y nghia ctia cac bién dwoc thé hién trén man hinh 1-Var
Results, vui ldng xem "Danh sach cac bién gia tri thong ké va ham

tinh toan théng ké" (trang 90).
8. Nhan ® hoéc @) dé tré vé Bo soan thao théng ké.

Hién thj két qua tinh toan théng ké bién doi

Man hinh 2-Var Results thé hién mét danh sach cac gia tri théng ké khac
nhau (vi du nhw gié tri trung binh va dd I&ch chuan khéng gian mau) dwoc
tinh toan dwa trén di liéu bién déi. Phan nay mé ta thao tac can thiét dé
hién thi man hinh 2-Var Results.

Vi du 4: D& nhap di liéu dwéi day va hién thi cac két qua tinh toan théng
ké bién doi

10112 (15|16 |19 |21 |24 | 25| 27 | 3,0

¥ 10|11 (12|13 |14 (15|16 |17 | 18 | 20

1. Nhan ©), chon biéu twong (ng dung Statistics, sau d6 nhan ©R.
2. Chon [2-Variable], sau d6 nhan @R.

« Thao tac nay sé hién thi B6 soan thdo théng ké.
3. Nhap di¥ liéu vao cét x.
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1810210561061 | = % T o
2018204920520 7E@3E | |l °

4. Nhap dir liéu vao cot y.
QOI@IO1@102@103@104@ | %1 %2
1051066 1O761(O8E26 [ T

5. Nhéan @K).

2—=Var Results
Reg Results -
Statistics Calc »

6. Chon [2-Var Results], sau d6 nhan @.
« Thao tac nay sé hién thi man hinh 2-Var Results.

[
% =1.499
ZH =19.9
ZHE =43,57
Ty =0, 3369
T =[.63
52 =0, 441
=
S =?ﬁEE4D?BSDBE
n =
& (hoac ¥)) A
ZyE =22.24
T2y =0.0324
o]
Ty =0, 3039736531

- 2y fU.1UEEEEEEE?
& (hoac ¥) S 3ol

it
Buzy =01, 243

© (hoéc ) nacsy

magcy) =2

« D& biét y nghia cta cac bién dwoc thé hién trén man hinh 2-Var
Results, vui long xem "Danh sach cac bién gia tri thong ké va ham
tinh toan théng ké" (trang 90).

7. Nhan ® hoac @0 dé tré vé Bd soan thdo théng ké.

Hién thj két qua tinh toan hoi quy

Man hinh Reg Results hién thj mét danh sach cac két qua tinh toan hoi
quy (hé s cta phwong trinh héi quy) dwa trén di liéu bién d6i. Phan nay
mo ta& thao tac can thiét dé hién thi man hinh Reg Results.
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Vi du 5: D& st dung d@ liéu bién doi nhap trong Vi du 4 (trang 84) va

hién thj két qua cta hai phép tinh hdi quy trinh bay bén dwdi

« Phwong trinh héi quy "y = a + bx" hé sb (a, b), va hé sb twong quan (r)
khi héi quy tuyén tinh dwoc thwe hién trén div liéu

« Phwong trinh héi quy "y = a + bx + cx®" hé sb (a, b, ¢) khi héi quy bac hai
dwoc thwe hién trén div liéu

Lwuy

+ D& biét thong tin vé cac kiéu tinh toan héi quy dwoc hd tro béi (rng dung Statistics, vui
lobng xem "Danh sach kiéu hdi quy dwoc hd tro™ (trang 86).

1. Thuc hién cac budc tr 1 dén 5 clia quy trinh trong Vi du 4 (trang 84).
2. Chon [Reg Results], sau d6 nhan @%.
« Thao tac nay sé hién thi menu kiéu hbi quy.

y=a+bx+cx?2
vy=at+b-+1nd{x}
y=a+e~{bx>

3. Chon [y=a+bx], sau d6 nhan @R,
« Thao tac nay sé hién thi man hinh Reg Results héi quy tuyén tinh.

4. Nhan ® hoac &0 dé tré vé Bo soan thao thong ké.
5. Nhan @, sau d6 chon [Reg Results] > [y=a+bx+cx?].
« Thao tac nay sé hién thi man hinh Reg Results hdi quy bac hai.

6. Nhan ® hoac @0 dé tré vé Bo soan thao théng ké.
« Dé biét y nghia ctia cac bién duoc thé hién trén man hinh Reg
Results, vui long xem "Danh sach cac bién gia tri thong ké va ham
tinh toan théng ké" (trang 90).

Danh sach kiéu héi quy dwoc hé tro

. Phwong trinh héi quy
Kieu hoi quy (2 LA
(muc menu kieu hoi quy)
Hbi quy tuyén tinh y=a+bx
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Hbi quy bac hai y=a+bx+cx?
Hbi quy l6garit y=a+b-In(x)
Hoi quy mii cla e y = a-e?(bx)
Hbi quy mi cla ab y=a-bM

Hbi quy Iy thira y=a-x"b

Hbi quy nghich dao y=a+blx

| St&r dung man hinh tinh toan thong ké

Ban c6 thé st dung man hinh tinh toan théng ké dé xem lai cac gia tri
thdng keé riéng 1& va st dung cac gia trj trong tinh toan.

Statistics
1-Variable

Man hinh khéng c6 dau vao biéu thirc tinh toan

maxfk}—min{x}

4.4

Phép tinh vi du

Dé xem lai gia tri théng ké, hay st dung bién thé hién gia tri théng ké ban
muén xem lai (vi du, gia tri trung binh x: X, d léch chun khéng gian mau
x: Oy, gida tri t&i da x: max(x), v.v...). D& biét thém théng tin vé cac bién nay,
vui ldbng xem "Danh sach cac bién gia tri thong ké va ham tinh toan

théng ké" (trang 90).

Hién thi man hinh tinh toan thong ké

Bién don

1. Trong khi Bo soan thao thdng ké dwoc hién thi, nhan ©R.
2. Trén menu xuét hién, chon [Statistics Calc] va sau d6 nhan @.

Statistics
1-Variable
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Bién doi
1. Trong khi B6 soan thao théng ké dwoc hién thi, nhan @X).
2. Trén menu xuét hién, chon [Statistics Calc] va sau d6 nhan @%.
« Thao tac nay sé hién thj menu kiéu hdi quy ( vui long xem "Danh
sach kiéu hoi quy hé tro™ (trang 86)).

y=a+bx+cx?2
y=a+b-+1lnd{x>}
y=a+e"~{bx}

3. Trén menu, chon kiéu hdi quy ban muén va sau d6 nhan @).

Statistics
y=a+bx

« Vi du trén st dung menu hién thi dé chon [y=a+bx] (H6i quy tuyén
tinh).

Dé tr& vé Bd soan thao thong ké tir man hinh tinh toan théng ké
Nhén @9, sau d6 nhan 3.

Vi du phép tinh str dung man hinh tinh toan théng ké

Vi du 6: Dé xac dinh téng di¥ liéu mau (2x) va gia tri trung binh (x) ctia dir
liéu bién don nhap trong Vi du 3 (trang 83)

1. Thwe hién cac buéc tr 1 dén 6 clia quy trinh trong Vi du 3 (trang 83).
2. Chon [Statistics Calc], sau d& nhan @K.

3. Tinh téng di¥ liéu mau (Zx).

— [Statistics] > [Summation] > [ié] 2x 119

4. Tinh gia tri trung binh ().

@ - [Statistics] > [sx °
[Mean/Var/Dev--] > [x] 118

® 5. 95

Ml
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Lwuy

« D& hién thi man hinh 1-Var Results tir man hinh tinh toan théng ké & trén, hay nhan
va sau d6 chon [1-Var Results]. D& tr& vé man hinh tinh toan thdng ké tlr man
hinh 1-Var Results, nhan (5) hoac &0).

Dé xac dinh cac hé sb (a, b) va hé sé twong quan (r) ctia phwong
trinh héi quy tuyén tinh "y = @ + bx" dwa trén di liéu bién d6i nhap trong Vi
du 4 (trang 84)
1. Thue hién cac budc tir 1 dén 5 clia quy trinh trong Vi du 4 (trang 84).
2. Chon [Statistics Calc], sau d6 nhan @K.
« Thao tac nay sé hién thi menu kiéu hbi quy.

y=a+bx+cx?
v=a+b-+1nd{x}
y=a+e™~{bx)

3. Chon [y=a+bx], sau d6 nhan @R,

Statistics
y=a+bx

4. Xac dinh cac hé sb (a, b) va hé sé twong quan (r) cla phwong trinh hoi
quy "y =a + bx".

D]
— [Statistics] > [Regression] >Eé] 8 0.5043587805
D]
— [Statistics] > [Regression] > [/] Z 0.5043587805
& 0.4802217183
D]
~ [Statistics] > [Regression] >[1|® g, 4802217183
r
& 0.89952824846

« D& chon kiéu hdi quy khac, nhan ¢ va sau dé chon [Select Reg
Type]. Thao tac nay sé& hién thi menu kiéu héi quy tir buwéc 2.

Dé hién thi man hinh 2-Var Results tir man hinh tinh toan théng ké
Nhén ¢ va sau dé chon [2-Var Results].

Dé hién thi man hinh Reg Results ttr man hinh tinh toan thong ké
Nhén ¢ va sau dé chon [Reg Results].
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Danh sach cac bién gia tri thng ké va ham tinh toan théng ké

Ban c6 thé st dung menu CATALOG dé xem lai cac bién thé hién cac gia
tri théng ké va cac ham dwoc st dung cho tinh toan thdng ké.

Lwuy

+ Dbi v6i cac tinh toan thdng ké bién don, cac bién dwoc danh dau bang dau hoa thi (*)
la bién c6 san.

« Dbi v&i cong thire tinh toan dwoc st dung cho méi bién va 1énh, vui Ibng xem "Céng
thirc tinh toan théng ké" (trang 93).

— [Statistics] > [Summation]
Tt Ty tbng cla di¥ liéu mau

2 52 tdng binh phwong cta dir liéu mau
¥xy ...... tbng cha tich di liéu x va di liéu y
3 tdng cla ldy thira ba cta div liéu x

%y tdng cla (binh phwong di¥ liéu x x di liéu y)
Tt tbng trung phwong cta div liéu x

— [Statistics] > [Mean/Var/Dev-]
XY e gia trj trung binh
2, 0Py . Phwong sai cta téng thé chung

0%y Oy . d6 léch chuan khéng gian mau
s2.*, 82, ... phwong sai mau

S*, Sy v do léch chuan mau

n* ... s cac khoan muc

— [Statistics] > [Min/Max/Quartile] (Chi ap dung vé&i di¥ liéu bién don)
min(x)* ...... gia tri téi thiéu
Q* ... t& phan vi thir nhat

Med* ...... sb trung Vi
Qs* ...... t&r phan vi thir ba
max(x)* ...... gia trj ti da

— [Statistics] > [Norm Dist] (Chi &p dung v&i dir liéu bién don)
P(*, Q(*, R(*, »1* ...... Céac ham dé thuc hién tinh toan phan phdi chuan.
Dé biét thém thong tin vé cac ham nay, vui long xem "Thuwe hién tinh
toan phan phéi chuan (Chi ap dung v&i dir liéu bién don)" (trang
91).

— [Statistics] > [Min/Max] (Chi ap dung v&i div liéu bién déi)
min(x), min(y) ...... gia tri tbi thiéu
max(x), max(y) ...... gia trj tbi da

— [Statistics] > [Regression] (Chi ap dung vé&i di¥ liéu bién doi)
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Péi voi hdi quy bac hai

a, b, c ...... hé s hdi quy déi voi hdi quy bac hai

X1, X2 oo Cac ham dé xac dinh gia tri wéc lwong xq va xo dbi vai gia tri y
da nhap. Bdi voi dbi sb, nhap gia tri ciia y ngay trwdc ham i1 hodc *o.
A Ham dé xac dinh gié tri woc lwong y dbi véi gia tri x da nhap. Do
v&i dbi sb, nhap gia tri clia x ngay trwdc ham nay.

Déi voi hdi quy khéng phai bac hai

a,b.... cac hé sbé hoi quy

P, hé sé twong quan

R Ham dé xac dinh gia tri wéc lwong x dbi vai gia tri y da nhap. Doi
v&i dbi sb, nhap gia tri cGia y ngay trwdc ham nay.

P Ham dé xac dinh gia tri wéc lwong y dbi véi gia tri x da nhap. Dbi

v&i dbi sb, nhap gia tri clia x ngay trwdc ham nay.

Dé biét vi du vé thao tac xac dinh gia tri wéc lwong, vui long xem "Tinh
toan gia tri wéc lwong (Chi ap dung véi div liéu bién déi)" (trang
92).

Thwc hién tinh toan phan phéi chuan (Chi ap dung véi div liéu
bién don)

Trong khi tinh toan thdng ké bién don dwoc chon, ban cé thé thwc hién
tinh toan phan phéi chuan bang cach sir dung cac ham duéi day tir menu
xuat hién khi ban nhan @ va sau dé chon [Statistics] > [Norm Dist].

P(, Q(, R( ... Nhirtng ham nay 1y dbi sé ¢ va xac dinh xac suét phan phbi
chuan nhw anh minh hoa bén dwéi.

ﬁp&m /K M
0 1 0 1 0 1

... Ham nay c6 dbi s6 x dirng trwdc. Ham tinh toan dai lwong ngau
nhién chuan cho gia tri di¥ liéu x st dung gia tri trung binh (x) va dd l&ch
chuan khéng gian mau (o) cla di liéu nhap bang B6 soan thao théng ké.

xX»t = XO_—X.X

Vi du 8: V&i di¥ liéu bién don nhap trong Vi du 3 (trang 83), xac dinh bién
thién da chuan hoéa khi x = 2, va P(¢) tai thoi diém dé.

1. Thue hién cac budc tir 1 dén 6 clia quy trinh trong Vi du 3 (trang 83).
2. Chon [Statistics Calc], sau d6 nhan @K.
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1-Variable
3. Tinh bién thién da chuan hoa khi x = 2.
2 (2wt ®
— [Statistics] > [Norm Dist] > [»1] -1.5556124886
@

4. Tinh P(2).

m

— [Statistics] > [Norm Dist] > [P(] z{: ~1.555612486
ns

®@ 0.05499

Tinh toan gia tri wéc lwong (Chi ap dung véi div liéu bién déi)

Dwa trén phwong trinh héi quy thu dwoc bang tinh toan thdng ké bién doi,
gia tri wéc lwong cla y cé thé dwoc tinh dbi vai gia tri x cho trwdc. Gia tri x
twong &ng (hai gia tri, x1 va xa, trong trwérng hop héi quy bac hai) ciing ¢6
thé dwoc tinh dbi vai gia tri cia y trong phwong trinh hoi quy.

Dé xac dinh gia tri wéc lwong dbi véi y khi x = 5,5 trong phwong
trinh hoéi quy dwoc tao ra bdi hdi quy tuyén tinh cta di¥ liéu nhap trong Vi
du 4 (trang 84)
1. Thwe hién cac buéc tr 1 dén 5 clia quy trinh trong Vi du 4 (trang 84).
2. Chon [Statistics Calc], sau d6 nhan @.
« Thao tac nay sé hién thi menu kiéu héi quy.

y=a+bx+cx?2
y=a+b-+1lnd{x)
y=a+e~{bx>

3. Chon [y=a+bx], sau d6 nhan @%.

Statistics
y=a+bx

nan

4. Nhap gia tri x (5,5), sau d6 nhap "}", day 1a ham dé xac dinh gia tri wéc
lwong cla y.

— [Statistics] > [Regression] > [}]
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5. Nhan €.

| Céng thire tinh toan thong ké

Céng thirc tinh toan théng ké bién don

0x= Z(xn—)'c)
Sy= Eg{jf)

Coéng thirc tinh toan hoéi quy

Hbi quy tuyén tinh (y = a + bx)

a= ZV— b-Xx

n
b= n-Xxy — 2x-2y
- ()
a n-Xxy — Xx-2y
V{2 — (20" Zy* — (By)*)

g=2-8

b
j\)=a+bx

r

Hbi quy bac hai (y = a + bx + cx?)

93

. 9%

3.145578231




o 22 of)

n
_ Sxy'Sx°x*- Sx’y-Sxx’
T Sxr S — (Sxx?)?
_ Sx®y-Sxx — Sxy-Sxx®
T SxrSK— (SxxP)

Sxx = Xx’~ —(%lx)z
=Yy Cx2y)

Sy =2y = ===

Sxx® = X~ (Zx-2x)

n

Sx’y = Tx’y — —(ZxZZy )

- b+Vb*-4c(a-y)

X1=

2C
. —b-+vb*-4c@-y
2=

2C

y=a+bx+cx

Hbi quy l6garit (v = a + b*In(x))

Yy - b-Zinx

e

_ nX(Inx)y — Zlnx-Xy

T X(nx)’— (Sinx)?
n-X(Inx)y — Zlnx-Xy

() — G Sy — ()

Hbi quy mii cGa e (y = a-e”(bx))
a= CXp( le’ly :l bZX)
n-2xIny — 2x-2lny
n-Xx’— (Xx)?
_ n-2xIny — 2x-2lny
V{n-Z¥ = (Cx02H{n-Z(ny)’ - (Zlny)?}
Iny — Ina
b

=ae®™

b=

r

X=

<>

Hoi quy mii cGa ab (y = a-b™x)
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n
n-2xIny — 2x-2lny )
nXx— (Xx)?
n-2xIny — 2x-2lny

B N (Zx)*}{n-Z(lny)’— (Zlny)*}

a= exp(

b= exp(

r

Iny — Ina
Inb
9 =ab*

X=

Hbi quy Idy thira (y = a-x"b)

a= exp( Zlny —nb-Zlnx)

_ n-ZInxlny — Xlnx-XIny
T nZ(nx)*— (Slnx)®
n-Xlnxlny — Xinx-Xlny
V{n-Z(1nx)*— (Zlnx)?H{n-X(1ny)*—~(Zlny)*}
Iny—Ina
e P
ax®

b

=

RSN
I

Hbi quy nghich dao (y = a + b/x)

Xy - b-Zx’
a= = —
Sxy
b= Sxx
_ Sy
\Sxx-Syy
Sxx =272 - (Z‘Z_ )
Syy = Xy*- _(Zny )
Sxy =Z(x")y - Zx"n-Zy
. b
= ——
y—a
y=a+ %

Tinh toan phan phoi

Trong (rng dung Distribution, ban cé thé thu dwoc gia tri xac suat bang
cach chon kiéu tinh toan phan phéi va nhap cac tham sb khac nhau.*
Dwé&i day la bang cac kiéu tinh toan phan phéi cé thé thuc hién.
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Kiéu tinh toan phan phoi Muc menu
Xac suat nhj thtre Binomial PD
Xac suét tich Ity nhi thirc Binomial CD
Mat do xac suat chuan Normal PD
Xac suét tich Ity chudn Normal CD

Phan phéi tich Ity chuan nghich dao*

Inverse Normal

Xac suét Poisson

Poisson PD

Xac suét tich Ity Poisson

Poisson CD

* "Inverse Normal" thyc hién tinh toan nghich d&o dé xac dinh gia tri div

liéu (xInv) tr gia tri xac suat (Area).

| Quy trinh chung dé thwe hién tinh toan phan phéi

P& tinh xac suét tich Iy nhj thiec déi vai diF liéu x {2, 3, 4, 5} khi N

(sb lan thir) = 5 va p (xac suét thanh céng) = 0,5

1. Nh&n ©), chon biéu twong ng dung Distribution, sau dé nhan @R,
« Thao tac nay sé hién thj menu kiéu tinh toan phan phéi.

2. Trén menu, chon kiéu tinh toan phan phéi.

Binomial PD -
Binomial CD .
Normal PD
Normal CD

« O day chung ta mudn tinh xac suét tich Iy nhj thirc. Chon [Binomial

CD], sau d4 nhan @.

3. Trén menu xuét hién, chon phwong phap nhap di liéu (x).

Variable

[List] ... Chon d& nhap nhiéu muc di¥ liéu x cung ltc. Thao tac chon muc
menu nay sé& lam cho man hinh danh sach xuét hién.

[Variable] ... Chon d& nhap mdt muc di liéu x. Thao tadc chon muc menu
nay s& lam cho man hinh nhap tham sé xuét hién.

« Tai day chung ta mudn nhap nhiéu muc di liéu x ciing ltc, chon [List]

va sau dé nhan @X).

4. Trén man hinh danh sach, nhap di liéu x {2, 3, 4, 5}.
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5. Nhan @®.

Binomial

« Thao tac nay sé hién thi man hinh nhap tham sé Binomial CD.

6. Nhap gia tri cho cac tham sb (N =5, p = 0,5).

56056

Binomial CD

N :5
P 0.5
eExecute 0|

« Céac tham sbé yé&u cau nhap dir liéu sé tuy thudc vao kiéu tinh toan
ban da chon & bwdc 2 clia quy trinh nay. Dé biét chi tiét, vui long xem

"Danh sach tham sé" (trang 98).

7. Sau khi nhap gia tri cho tat ca cac bién, chon [Execute] va sau d6 nhan

@.

« Thao tac nay sé hién thi man hinh két qua tinh toan.

F.s/Binomial

2

« Néu ban da chon [List] trong buéc 3, két qua tinh toan (cot P) sé xuét
hién trén man hinh danh sach. Dé biét chi tiét, vui long xem "Man

hinh danh sach" (trang 98).

« Néu ban thuc hién bat ky thao tac chinh stra nao (xem "Soan thao
noi dung man hinh danh sach” (trang 99)) trén man hinh danh
séach trong khi két qua tinh toan dwoc hién thi, tAt ca cac két qua tinh
toan sé bj xda. Danh sach sé tré vé trang thai trong buéc 4 (hoan tat
nhap di liéu man hinh danh sach) cua quy trinh nay.

« M6t théng bao 16i xuét hién néu gia tri nhap nam ngoai mién cho
phép. "ERROR" sé& xuét hién trong cot P clia man hinh két qua tinh
toan khi gia tri nhap cho dir liéu twong (rng ndm ngoai mién cho phép.

« Néu nhan @ trong khi man hinh két qua tinh toan dwoc hién thi, may

sé& tré v& man hinh nhap tham sb.

Lwuy

+ Néu ban da chon Normal PD, Normal CD, hodc Inverse Normal trong bwdc 2 & trén,

phuong phap nhap di liéu (x) sé ludn la "Variable" (nhap mét muc di liéu x). Do do,

menu & buéc 3 sé khong hién thj vao luc nay.

+ Néu phwong phap nhap dir liéu (x) la "Variable", két qua tinh toan sé dwoc lwu trong

b6 nh& Ans.

« D6 chinh xac tinh phan toan phéi Ién dén 6 chir s6 c6 nghia.
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| Danh sach tham s6

Danh sach dwéi day cho biét y nghia clia cac ky hiéu xuét hién trén man
hinh nhap tham sé.

Binomial PD, Binomial CD

x ...d@ liéu

N ... s 1an tht

p ... Xac suat thanh cong (0<p < 1)

Normal PD
x ... d liéu
i ... gia tri trung binh clia khéng gian mau
o ... do 1éch chuan khoéng gian mau (o > 0)

Normal CD

Lower ... bién dw¢i

Upper ... bién trén

4 ... gid tri trung binh cGa khéng gian mau
o ... 6 léch chuan khéng gian mau (o > 0)

Inverse Normal

Area = gia tri xac suat (0 < Area < 1)

A ... gié tri trung binh cta khéng gian mau
o ... d6 léch chuan khéng gian mau (o > 0)
(Cai dat phan dw luén & bén trai.)

Poisson PD, Poisson CD
x ... d liéu
A ... gia tri trung binh

Lwuy

+ Gi4 tri cubi cuing nhap vao cho tirng tén tham sé dwoc gilr lai, bat k& man hinh nhap &
noi nhap. Vi duy, viéc nhap mot gia tri cho N trén man hinh nhap tham sb Binomial PD
cling sé thay ddi gia tri ciia N trén man hinh nhap tham sé Binomial CD.

« Céc gia tri ban nhap vao cho tirng tham sb dwoc gilr lai, chi cin ban khéng thuc hién
mot trong cac thao tac sau: @ — [Reset] > [Settings & Data] hoac @ — [Reset] >
[Initialize All].

| Man hinh danh sach

Ban c6 thé s& dung man hinh danh sach dé nhap tbi da 45 muc di liéu x.
Két qua tinh toan cling dwoc hién thj trén man hinh danh sach.
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(1) Kiéu tinh toan phan phéi

(2) Gia tri tai vi tri con trd hién tai
(3) D liéu (x)

(4) Két qua tinh toan (P)

Lwuy

+ Trén man hinh danh sach, ban cé thé lwu gia tri trong mét 6 vao bién. Vi du, néu thyc
hién thao tac sau khi man hinh trén dwoc hién thi, may sé lwu 1 vao bién A: @ —[A=]
> [Store]. D& biét chi tiét vé& cac bién sb, vui lobng xem "Cac bién (A, B, C, D, E, F, x, y,
z)" (trang 38).

Néu thyc hién mét trong cac thao tac dudi day, may sé xoa tat ca div liéu x nhap trén

man hinh danh sach.

- Tr& v& man hinh HOME va khéi chay (rng dung may tinh khac

- Thuc hién [Delete All] (Xem "Dé xéa tat ca néi dung trén man hinh danh sach"
(trang 100).)

- Thyc hién &) — [Reset] > [Settings & Data] hoac &) — [Reset] > [Initialize All]

] Soan thao ndi dung man hinh danh sach

Pé thay déi dir liéu x trong mot 6

Trén man hinh danh sach, di chuyén con tré dén 6 chira di¥ li&u ban mudn
thay ddi, nhap di liéu mai, sau d6 nhan @ .

DPé x6a moét hang

Trén man hinh danh sach, di chuyén con trd dén hang ban muén xéa va
sau d6 nhan @).

DPé chén mét hang

1. Trén man hinh danh séach, di chuyén con tré dén hang sé nam dudi
hang ban sé chen.
2. Thwce hién thao tac sau: ¢ — [Edit] > [Insert Row].
» Thao tac nay sé chén mét hang v&i 0 dwgrec nhap vao lam gia tri mac
dinh ban dau.
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3. Nhap dir liéu.

Dé xo6a tat ca ndi dung trén man hinh danh sach

Trén man hinh danh sach, thwc hién thao tac sau: ¢9 — [Edit] > [Delete
All].

| Vi du vé phép tinh

Dé tinh mat d6 xac suat chuan khix = 36, x =35, 6 = 2

1. Nh&n ©), chon biéu twong ng dung Distribution, sau dé nhan @R,

2. Trén menu kiéu tinh toan phan phdi xuét hién, chon [Normal PD], sau
dé nhan ©X.
« Thao tac nay sé& hién thi man hinh nhap tham sé Normal PD.

3. Nhap gia tri cho cac tham sb (x = 36, u = 35, 6 = 2).

Normal PD
B@@2@ | # 135

4. Nhan @®).

0.1760326634

« Nhan @® lai l4n nira hodc nhan & ho&c @9 sé trd lai man hinh nhap
tham sé trong bwéc 3 cla quy trinh nay.

« Ban c6 thé lwu két qua tinh toan dang dwoc hién thj vao mét bién. Vi
du, néu thwc hién thao tac sau khi man hinh trong buéc 4 & trén hién
thi, may sé lwu két qua tinh toan vao bién A: ¢ — [A=] > [Store]. Dé&
biét chi tiét vé cac bién sb, vui ldng xem "Cac bién (A, B, C, D, E, F,
x, y,z)" (trang 38).

Str dung bang tinh

Yng dung Spreadsheet cho phép thuwc hién cac phép tinh bang cach st
dung bang tinh 45 hang x 5 cot (6 A1 dén E45).

Dé thuc hién cac thao tac trong phan nay, trwdce tién hay khéi chay tng
dung Spreadsheet. Nhan @), chon biéu twong (ng dung Spreadsheet,
sau d6 nhan @X. Thao tac nay sé& hién thi man hinh bang tinh.

100



|
] ] (3) (4)

(1) Sé hang (1 dén 45)

(2) Chir cai cot (A dén E)

(3) Con trd: Cho biét 6 dang dwoc chon. Sé hang va chir cai cot ctia &
hién dang dwoc chon dwoc hién thi bang mau den, sé hang va chiv
céi cot ciia 6 khac dwoc hién thi bang mau xam dam.

(4) O chinh slra: Hién thi néi dung cta 6 noi con tré dang dwoc dat.

Quan trong!

« Bat ky Iuc nao ban tit may tinh hodc nhan phim ("), moi néi dung da nhap vao bang

tinh sé bi xda.

| Nhap va chinh stra ndi dung trong 6

Ban c6 thé nhap mot hang sé hodc mét cong thirc vao méi 6.

Hang sé: Hang sb 1a mot ndi dung bat ky cé gia tri dwoc cd dinh ngay sau
khi ban nhap vao thanh céng. Hang s6 c6 thé [a mét gia tri sb, hodc mot
biéu thirc tinh toan (chdng han nhw 7+3, sin30, A1x2, v.v...) khéng cé dau
bang (=) & phia trudec.

Céng thirc: Cong thirc bat ddu bang dau bang (=), chang han nhuw
=A1x2, dwoc thwe hién khi dwoc viét ra.

Lwuy

+ C6 thé nhap tbi da 49 byte vao moét 6 (sb byte truvéc khi ndi dung nhap vao dwoc xac
nhan béng cach nhan @B) dang dwoc chinh stra. Dwdi day 1a cach dém sé byte.
- S, bién, ky hiéu: 1 byte trén méi ky tw
- Céc Iénh, ham: 1 byte cho méi Iénh hodc ham
Toan bé mot Iénh hoac ham dworc tinh 1a moét byte. Vi duy, sau day la mét byte: "\/_(",
"Sum(".
 Dwéi day 1a sé byte st dung sau khi néi dung nhap vao duoc xac nhan, theo ndi dung
dwoc nhap vao méi 6.
- Hang sb: 14 byte, bt ké sb lwgng chir sb nhap vao*
- Cong thire: S6 byte nhap vao (tdi da 49 byte) + 15 byte
* Néu ban nhap hang sé véi 11 chir sb ¢ nghia tré 1én, gia tri s& dwoc chuyén thanh
10 chir sb cé nghia khi viéc nhap duwgc xac nhan.
Vi du: Néu ban nhap 12345678915 (11 chir sb), gia tri s& dwoc chuyén dbi thanh
1,234567892 x 10° (10 chir sb).
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Pé hién thi dung lwong c6 thé nhap vao con lai
Nhéan ¢, chon [Available Memory], sau d6 nhan @R,
| Nhap hang s6 va céng thirc vao 6

Vi du 1: Vao cac 6 A1, A2, va A3, lan luvot nhap cac hang sb 7x5, 7x6, va
A2+7 vao cac 6. Sau do, nhap cong thirc sau vao 6 B1: =A1+7.

1. Di chuyén con trd t&i 6 A1,

2. Thyc hién thao tac phim duwdi day.

N N I Y
7X5607X6E® @A) QD760 B

(s s |

®OEF®OADOD76

Lwuy

+ Trén man hinh bang tinh, ban cé thé lwu gia tri trong mét 6 vao bién. Vi du, néu thyc
hién thao tac sau khi man hinh trong bwéc 3 hién thi, may sé lwu 42 (két qua tinh toan
clia cong thire dwoc dwa vao 6 B1) vao bién A: (A) €3) — [A=] > [Store]. D& biét chi tiét
v& cac bién sé, vui 1dng xem "Céac bién (A, B, C, D, E, F, x, y, 2)" (trang 38).

+ Ban c6 thé chi dinh d& mot cong thirc trong 6 chinh sira sé dwoc hién thj 14 cong thirc
ho&c 1a gia tri két qua tinh toan clia cong thirc d6. Vui long xem "Cac muc cai dat
trng dung Spreadsheet” (trang 107).

Pé chinh stra di¥ liéu 6 hién cé

1. Di chuyén con tré dén 6 cé ndi dung ban mudn chinh stra, sau d6 nhan
©8).

« Thay vi nhan @), ban ciing c6 thé thuc hién thao tac dwdi day.

— [Edit Cell]

« Noi dung 6 trong 6 chinh sira sé thay dbi tir can phai sang can trai.
Con tré van ban (|) sé xuat hién trong 6 chinh sira dé& ban co thé
chinh stra ndi dung cua no.

2. Str dung X va (& dé di chuyén con tré van ban quanh ndi dung cda 9,
va chinh sira theo mong muén.
3. D& hoan tat va ap dung céac chinh stra, nhan @.
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Dé nhap tén tham chiéu 6 bang cach str dung lénh Grab

Lénh Grab c6 thé dwoc sir dung thay cho tén tham chiéu tha cdng (chang
han nhu A1) dwoc nhap bang cach st dung thao tac phim dé chon va
nhap vao 6 ma ban mudn tham chiéu.

Vi du 2: Tiép tuc tir Vi du 1, nhap cdng thirc sau vao 6 B2: =A2+7.
1. Di chuyén con tré t&i 6 B2.
2. Thyc hién thao tac dwéi day.

® (O(=) @ — [Spreadsheet] > [Grab]
®

I o

® D76

| Tham chiéu 6 twong d6i va tuyét doi

C6 hai kiéu tham chiéu 6: twong déi va tuyét dbi.

Tham chiéu 6 twong déi

Tham chiéu 6 (A1) trong mét cong thirc nhw =A1+7 1a tham chiéu twong
dbi, nghta la né sé thay déi tuy thudc vao 6 noi cong thirc dwoc dat. Vi du,
néu coéng thirc =A1+7 nam trong 6 B1, viéc sao chép va sau do6 dan vao 6
C3 sé cho ra két qua 1a =B3+7 dwoc nhap vao 6 C3. Vi thao tac sao chép
va dan lam di chuyén céng thire di mét cot (B téi C) va hai hang (1 dén 3),
nén tham chiéu 6 twong déi A1 trong céng thirc dwoc di chuyén mot cot
va hai hang dén B3. Néu két qua cla thao tac sao chép va dan khién tén
tham chiéu 6 twong déi bj thay déi thanh ndi dung bat ky nam ngoai pham
vi clia cac 6 bang tinh, chir cai cot va/hoac sd hang ap dung sé duwoc thay
thé bang d4u hai (?), va "ERROR" s& duoc hién thi dudi dang di lidu clia
0.

Tham chiéu 6 tuyét déi

Néu ban muédn hang hoac cét, hodc ca phan hang va cot cta tén tham
chiéu 6 van gi» nguyén khi dan, ban can tao tén tham chiéu 6 tuyét dbi.
Dé tao tham chiéu 6 tuyét dbi, hay dat mot dau d6 la ($) & phia truwdc tén
cot va/hodc sb hang. Ban co thé sir dung mét trong ba tham chiéu 6 tuyét
dbi khac nhau: cot tuyét déi véi hang twong dbi ($ A1), cot twong dbi voi
hang tuyét déi (A$ 1), hodc hang va cot déu tuyét déi (SAS 1).
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Dé nhap ky hiéu tham chiéu 6 tuyét déi ($)

Khi nhap mét cdng thirc vao 6, hdy nhan @ va sau doé chon
[Spreadsheet] > [$].

Cach cat va dan div liéu bang tinh

1. Di chuyén con tré dén 6 ban muédn cat di liéu.
2. Nhan €9, chon [Cut & Paste], sau d6 nhan @%.
« Thao tac nay sé dwa ndi dung vao ché dd chd dan. Bé hay ché do
ch® dan, nhan ® hodc ®0).
3. Di chuyén con tré dén 6 ban muén dan di¥ liéu vira cat, sau d6 nhan
©8).
» Thao tac dan di¥ liéu ciling sé x6a di liéu khdi 6 noi ban da thwc hién
thao tac cat, va tw dong hly ché dod chd dan.

Lwuy
« Trong trwéng hop thao tac cat va dan, cac tham chiéu 6 khong thay ddi khi dan, bt
ké chung la twong dbi hay tuyét dbi.
Cach sao chép va dan dir liéu bang tinh

1. Di chuyén con tré dén 6 ban mudn sao chép di liéu.
2. Nhén €3, chon [Copy & Paste], sau d6 nhan @R,
« Thao tac nay sé dwa ndi dung vao ché dd ché dan. Bé hay ché do
ch® dan, nhan ® hoac &0).
3. Di chuyén con tré dén 6 ban muén dan di¥ liéu vira sao chép, sau do6
nhan @K,
« Ché d6 cho dan dwoc duy tri cho dén khi ban nhan & hodc @9, vi
vay ban c6 thé dan di¥ liéu da sao chép vao cac 6 khac néu muén.

Lwuy

« Khi ban sao chép néi dung ctia 6 chira cong thirc véi tham chiéu twong déi, tham
chiéu twong déi sé thay déi theo vi tri ctia 6 noi ndi dung dwoc dan.

Cach x6a dir lieu nhap vao tir mét 6 cu thé

Di chuyén con tré t&i & c¢é ndi dung ban mubn xéa va nhan @.

Cach x6a ndi dung cua tat ca cac 6 trong mét bang tinh

Nhén €3, chon [Delete All], sau d4 nhan @%.
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|Sl’f dung cac lénh dac biét caa &rng dung
Spreadsheet
Trong (rng dung Spreadsheet, cac 1&nh duéi day co6 thé dwoc sir dung

trong cdng thirc hodc hang sé. Nhirng I&nh nay nam trén menu xuét hién
khi ban nhan va sau dé chon [Spreadsheet].

Min(
Tra vé gia tri nhd nhat trong pham vi 6 dwoc chi dinh.
Ca phap: Min(6 bt dau:6 két thuc)

Max(
Tra vé gia tri I&n nhét trong pham vi 6 dwoc chi dinh.
Cu phap: Max(6 bat dau:6 két thuc)

Mean(
Tra vé gia tri trung binh trong pham vi & dwoc chi dinh.
Cu phap: Mean(d bat dau:6 két thuc)

Sum(
Tra vé gia tri tdng trong pham vi 6 dwoc chi dinh.
Cu phap: Sum(é bat dau:6 két thuc)

Tiép tuc tlr Vi du 1, nhap céng thirc =Sum(A1:A3), tirc tinh tbng
cac 6 A1, A2, va A3, vao 6 A4.
1. Di chuyén con tré t&i 6 A4.
2. Nhap =Sum(A1:A3).

® (O(=) @ — [Spreadsheet] > [Sum] e ————
DOWD B o —
— [Spreadsheet] > ['] —

DDA O =Sum{A1:A3|

3. Nhan @,

| Nhap hang loat cing mét céng thirc hodc hang sé
vao nhieu 6

Ban c6 thé str dung cac quy trinh trong phan nay d& nhap cung mét céng

thirc hodc hang s vao mét chubi cac 6 cu thé. St dung lénh Fill Formula

dé nhap hang loat mét cong thire, hodc Fill Value d& nhap hang loat mot
hang sb.
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Lwuy

« Néu cong thirc hodc hdng sb nhap vao chiva tham chiéu twong ddi, tham chiéu twong
dbi s& dwoc nhap vao theo 6 phia trén bén trai ctia pham vi chi dinh. Néu cong thirc
ho&c hang sd nhap vao chira tham chiéu tuyét déi, tham chiéu tuyét déi sé dwoc nhap
vao tat ca cac 6 trong pham vi chi dinh.

DPé nhap hang loat cing mét cong thirc vao mét loat cac 6

Tiép tuc tv Vi du 1, nhap hang loat vao cac 6 B1, B2, va B3 mét

cong thirc nhan ddi gia tri ctia 6 bén trai roi trir di 3.
1. Di chuyén con trd t&i 6 B1.
2. Nhan €9, chon [Fill Formula], sau d6 nhan @%).

« Thao tac nay sé hién thi man hinh Fill Formula.
3. Trong dong "Form", nhap cong thirc =2A1-3: 2® @ (A)D O 3@.

« Khéng can nhap ky hiéu bang (=) & dau.
4. Trong dong "Range", chi dinh B1:B3 lam pham vi nhap vao hang loat.

Fill Formula
Form =2A1-3
®@®@ Range :B1:B3

5. Dé ap dung nhap vao, nhan @.
* Thao tac nay sé nhap = 2A1-3 vao 6 B1, =2A2-3 vao 6 B2, va =2A3-3
vao 6 B3.

DPé nhap hang loat cing mét hang s6 vao mét loat cac 6

Tiép tuc tir Vi du 4, nhap hang loat vao cac 6 C1, C2, va C3 cac
gia tri gap ba lan gia tri trong cac & bén trai chung.
1. Di chuyén con tré t&i 6 C1.
2. Nhén &3, chon [Fill Value], sau d6 nhan @R,
« Thao tac nay sé hién thi man hinh Fill Value.
3. Trong dong "Value", nhap hang s6 B1x3: ® & (B)(D X 3@,
4. Trong dong "Range", chi dinh C1:C3 lam pham vi nhap vao hang loat.

Fill Value
Value ::B1x3
®@®@ Range :C1:C3
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5. Dé ap dung nhap vao, nhan @.
« Thao tac nay sé& nhap gia tri cia mébi két qua tinh toan vao cac 6 C1,
C2,va C3.

5]
 —— o) m—
25 E7 N
iz =1 243
[ 3] 49 g5 2es
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| Cac muc cai dat wrng dung Spreadsheet

Céac muc cai dat duwoi day dwoc bao gébm trong menu TOOLS.
"&" cho biét cai dat mac dinh ban dau.

Auto Calc

Chi dinh c6 nén ty dong tinh lai cac cong thirc hay khéng.
On*: Cho phép tw dong tinh lai.

Off: Tat tw ddng tinh lai.

Show Cell

Chi dinh mét céng thirc trong 6 chinh sira sé dwoc hién thj 1a cong thirc
hodc la gia tri két qua tinh toan cla céng thirc dé.

Formula®: Hién thi cdng thirc.

Value: Hién thij gia tri két qua tinh toan cla céng thirc.

| Auto Calc va Recalculate

"Auto Calc" la muc cai dat trén menu TOOLS (vui long xem "Cac muc cai
dat &rng dung Spreadsheet” (trang 107)).

V&i cai dat mac dinh ban dau cta ng dung Spreadsheet (Auto Calc: On),
céng thire trong mot 6 dwoe tw ddng tinh lai mbi khi ndi dung 6 dwoc
chinh stra. Tuy thudc vao ndi dung ctia bang tinh, viéc tinh lai tw dong co6
thé mét nhiéu thoi gian dé hoan thanh. Khi tat Auto Calc (Off), ban cn
thwe hién tinh lai theo cach tha cong.

Pé thwc hién tinh lai theo cach thu cong

Nhan €9, chon [Recalculate], sau d6 nhan @.

Lwuy

» Ngay ca khi cai dat Auto Calc la On, ban cling nén thiwc hién [Recalculate] trong cac
trwdng hop dwdi day.
- Khi menu SETTINGS duwoc st dung dé thay dbi cai dat Angle Unit
- Khi 6 chira codng thirc str dung ham "f(" hoac "g(" va phwong trinh xac dinh twong
trng (f{x) hoac g(x)) dwgrc cap nhat
- Khi 6 chira cong thirc sir dung bién va bién twong (rng dwoc cap nhat
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Tao mét bang so

Ban c6 thé s dung rng dung Table dé tao mét bang sb dya trén cac
phwong trinh xac dinh dwgc dang ky cho cac ham f{x) va g(x).

| Quy trinh chung dé tao mét bang sé

Vi du: Dé tao bang s cho ham f{x) = x2 + % va g(x) = x? - % cho mién -1

<x <1, bwéc tang 0,5

1. Nhan ©), chon biéu twong &ng dung Table, sau d6 nhan ©X.

» Thao tac nay sé hién thi man hinh bang sé.

« Néu mét phwong trinh xac dinh chwa duwgc déng ky cho mét hoac ca
hai ham f{x) va g(x), di liéu & vi tri chon con trd tréng, mot théng bao
sé xuat hién & cudi man hinh cho biét rang phwong trinh xac dinh
chwa dwoc dang ky.

D]
i flmd E14-3)

1
2
3
4
{

fi{x)/g{x) :None

2. CAu hinh cai d&t dé tao bang sé tir hai ham.
(1) Nhan @9, sau d6 chon [Table Type] > [f(x)/g(x)].
(2) Nhan @9,
« Dé biét thong tin vé cac cai dat, vui long xem "S6 hang toi da trong
bang sé theo Table Type" (trang 109).
3. Bang ky phuwong trinh xac dinh cho f{x).

— [Define f(x)/g(x)] > [Define f(x)] [£ (23 =241
@@ D102 2

(Man hinh ngay trwéc khi ban nhan @)

4. Bang ky phwong trinh xac dinh cho g(x).

— [Define f(x)/g(x)] > [Define g(x)] |g ¢z =x2—1
®@O1®2@ 2l

(Man hinh ngay trwéc khi ban nhan @)

« Ban ciing c6 thé str dung (=) & dang ky biéu thirc xac dinh. Dé&
biét thém théng tin, vui long xem "Dang ky phwong trinh xac dinh”
(trang 109).
5. CAu hinh cai dat pham vi bang sb.
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®O(()I®1®OO5E | Step :0.5

¥T B
— [Table Range] [T2Dle Ranse
‘

6. Nhan @.
« Thao tac nay sé hién thi cac két qua trong man hinh bang sé.

« Thao tac tao bang sé lam cho ndi dung clia bién x bj thay dbi.

Lwuy

« Trén man hinh bang sé, ban c6 thé lwu gia tri trong mét 6 vao bién. Vi du, néu thuc
hién thao tac sau khi man hinh trong bwéc 6 & trén hién thi, may sé lwu -1 vao bién A:
€3 — [A=] > [Store]. D& biét chi tiét v& cac bién sé, vui long xem "Cac bién (A, B, C,
D, E, F, x, y, z)" (trang 38).

| S6 hang t6i da trong bang so6 theo Table Type

Ban c6 thé cau hinh cac cai dat man hinh sé dé hién thi cot cho ca f(x) va
2(x), hodc cho mét trong hai. Dé thiét 1ap, hay st dung menu xuét hién khi
ban nhan ¢ — [Table Type] trong khi man hinh bang sé dwoc hién thj.

@F () FE(x)
OF ()
Qg ()

f(x)/g(x) ... Hién thi ca cot f{x) va g(x) (cai d&t mac dinh ban dau)

f(x) ... Chi hién thi cot f{x)

g(x) ... Chi hién thj cot g(x)
S6 hang tbi da trong bang s dwoc tao phu thudc vao cai dat Table Type.
Téi da 45 hang dwoc hé tror dbi véi cai dat "f(x)" hodc "g(x)", va 30 hang
duoc hd tro dbi voi cai dat "f(x)/g(x)".

| Dang ky phwong trinh xac dinh

C6 hai cach dé dang ky cac phwong trinh xac dinh cho f(x) va g(x).

« Khi man hinh bang sb ctia ng dung Table dwoc hién thi, d&ng ky mot
phwong trinh béng cach nhan
— [Define f(x)/g(x)] > [Define f(x)]
— [Define f(x)/g(x)] > [Define g(x)]

« Khi man hinh bang sé cla trng dung Table dwoc hién thi, hodc khi st
dung bat ky 'ng dung may tinh nao ngoai trr Distribution, Equation
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(Simul Equation/Polynomial), Inequality, Base-N, Ratio va Math Box,

dang ky mét phwong trinh bang cach nhan @2

(= — [Define f(x)]

) — [Define g(x)]
Man hinh dang ky phwong trinh f{x) hodc g(x) gibng nhau sé xuét hién, bat
ké thao tac ndo trong hai thao tac trén dwoc siv dung dé dang ky phuong
trinh xac dinh.

Lwuy

« D& biét chi tiét v& cac thao tac st dung (), vui long xem "Piang ky va sir dung
phwong trinh xac dinh cho f{x) va g(x)" (trang 70).

] Soan thao dir liéu man hinh bang s6
Pé x6a moét hang

1. Trén man hinh bang s6, di chuyén con tré dén hang ban muén xéa.
2. Nhan @.

DPé chén mét hang

1. Trén man hinh bang sé, di chuyén con tré dén hang sé nam dwdi hang
ban sé cheén.
2. Thyc hién thao tac sau: ¢9 — [Edit] > [Insert Row].

Dé xoa tat ca cac néi dung man hinh bang sé

Trén man hinh bang s, thuc hién thao tac sau: — [Edit] > [Delete All].

Pé thay doi gia tri nhap cho 6 trong cot x

Ban c6 thé thay dbi gia tri trong & x dang dwoc danh dau. Viéc thay déi gia
tri x sé lam cho cac gia tri f(x) va g(x) trong cung mét hang dwoc cap nhat
twong ng.

DPé nhap mét gia tri vao 6 cot x dworc danh dau bang cach sir
dung: {gia tri cua 6 & trén} +/- {gia tri bwéc}

Néu c6 gia tri trong 6 x phia trén 6 x dang dwoc danh dau, viéc nhan @
hodc @ sé& tw déng nhap vao 6 dwoc danh dau mét gia tri bang véi gia
tri cia 6 & trén cong véi gia tri buwdc. Ngoai ra, viéc nhan O sé tw dong
nhap vao gia tri bang v&i gia tri ciia 6 trén trr gia tri budc. Céc gia tri f{x)
va g(x) trong cung mét hang cling dwgc cap nhat twong rng.
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| Thoi diém cap nhat f(x) va g(x)

Gia tri f{x) va g(x) hién thj trén man hinh bang sb dwoc cap nhat khi bat ky

diéu ndo sau day xay ra.

« Khi nhan & trong khi [Execute] dwoc chon trén man hinh Table Range.

» Khi cac phwong trinh xac dinh cho f{x) va g(x) dwgrc cap nhat (ngoai trw
khi phwong trinh xac dinh la ham hop).

« Khi nhap sb vao cét x (bao gébm ca thao tac nhdn @, ©, @ trong cot
X).

« Khi Verify dwoc chuyén tir bat sang tat (69 — [Verify OFF]).

Tuy nhién, lwu y rang cac gia tri khéng dwoc cap nhat tw ddng sau cac
thao tac sau day.

« Khi menu SETTINGS dwoc str dung dé thay dbi cai dat Angle Unit.

« Khi bién clia mét phwong trinh xac dinh dwoc cap nhat (gia tri sé moi
duwoc lwu trir) khi mot phwong trinh xac dinh 6 chira mét bién (vi du:
flx) = 2x + A) dwoc dang ky.

* Khi phwong trinh xac dinh ctia ham hop (Vi du: g(x) = f{x) x 2 - x) dwoc
dang ky, va phwong trinh xac dinh ctia ham tham chiéu (Vi du: f{x) cia
g(x) = flx) x 2 - x) dwoc cap nhat (phwong trinh xac dinh méi dwgc dang
ky).

Trong nhirng trrd'ng hop nay, hay thwc hién 69 — [Recalculate] trong khi
man hinh bang sé dwoc hién thi dé cap nhat cac gia tri.

| Str dung Verify v&i (rng dung Table

Néu Verify dwoc bat trong ng dung Table, mbi khi ban nhap gia tri f{x)
(hodc gia tri g(x)) twong (rng v&i x trén man hinh bang s6, may tinh sé xac
dinh xem gia tri c6 dung hay khong.

Lwuy

+ C6 thé st dung Verify véi nhiéu (r’ng dung may tinh khac nhau. Trwéc khi thuc hién
céac thao tac trong phan nay, vui ldng doc théng tin trong "Téng quan vé Verify"
(trang 73) truéece.

Thao tac mau véi Verify

Thao tac mau nay bat diu véi bang sb duoc tao theo cac cai dat sau.
Phwong trinh xac dinh ...... f{x) = x? + % g(x) =x?- L

2
Table Range ......... Start: -1, End: 1, Step: 0,5
Thuwce hién quy trinh tiép tuc tlr bwdc 6 trong phan "Quy trinh chung dé
tao mét bang sé" (trang 108).
1. Dé bat Verify, nhan & va sau d6 chon [Verify ON].
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« Chi bao @ sé& xuét hién & phia trén cung ctia man hinh dé cho biét
rang Verify dwoc bat.
« Thao tac nay sé xoa tat ca ndi dung cta cot f{x) va g(x) ciia man hinh

bang sb.
-]
| i fimd ELE
2 -0.5
2 u}
4 0.5
-1
2. Nhan & dé di chuyén con tréd dén hang dau tién cla cot flx).
« fiwd g(x?
é -IZI:S
3 u]
4 0.5
Enter Value
3. Nhap gia tri f{x) (1,5) twong &ng v&i x = 1.
Vo [ -]
True
1569
oK

« "True" dwoc hién thi néu gia tri nhap 1a dung.
« "False" dwoc hién thi néu gia tri nhap 1a sai. Nhan ®), @9, hoac @ dé
tré vé man hinh bang sb va nhap lai s6.
4. Néu "True" dwoc hién thi, nhan &), @), ho&c ©K.
« Thao tac nay sé tré vé man hinh bang sé va di chuyén con tré dén
hang tiép theo.

= fomd alxd
1 -1 1.5
2 -0.5| m—
&l u]
4] 0.5
Enter WYalue

« Ban c6 thé tiép tuc nhap cac gia tri f{x) va g(x) cho x. M&i l4n ban nhap
mot gia tri, may tinh sé xac dinh xem gia tri dé c6 dung hay khéng.

5. Dé tat Verify va két thac thao tac Verify, hdy nhan ¢ va sau dé chon
[Verify OFF].

« Thao tac nay sé lam cho chi bao @ bién méat khadi man hinh.

- D& biét chi tiét vé thao tac tat Verify, vui lbng xem "Dé tat Verify"
(trang 74).

« Bét ky thay dbi nao ban da thwc hién hodc gia tri méi ma ban da nhap
vao gia tri cdt x cia man hinh bang sé trong khi Verify duwoc bat sé
dwoc gilr lai. Khi ban tat Verify, cot f(x) va g(x) sé& dwoc tinh lai theo
cac gia tri trong cot x.
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Lwuy

+ Néu két qua kiém tra 1a "True", gia tri nhap vao cot f(x) hodc g(x) c6 thé dwoc lwu vao
bién. Vi du, néu thuc hién thao tac sau khi man hinh trong bwéc 4 & trén hién thi, may
s& Ivu 1,5 vao bién A: (M) €a) — [A=] > [Store]. D& biét chi tiét v& cac bién s, vui long
xem "Cac bién (A, B, C, D, E, F, x, y, )" (trang 38).

« Ban c6 thé thay déi gia tri trong & bang cach di chuyén con tré dén 6 trong cot x va
nhap gia tri mé&i. Viéc thay dbi gia tri trong & x s& lam cho gia tri trong cot f{x) va g(x) bi
xba.

+ Ban ciing c6 thé nhap gia tri vao 6 cot x dang khéng chira gia tri (néu chwa vuot qua

sb hang tdi da). D& biét thong tin vé s hang téi da, vui ldng xem "Sé hang t6i da

trong bang s6 theo Table Type" (trang 109).
« Thao tac nhan (%) trong khi Verify dwoc bat s& lam tét Verify va déng thoi xoa tat ca

d liéu hién dang nhap trong bang sb.

Dé x6a tat ca ndi dung ciia cot f(x) va g(x)

Khi Verify dwoc bat, ndi dung cla cot f(x) va g(x) cé thé dwoc xda hang
loat. Trén man hinh bang s6, thwc hién thao tac sau: — [Edit] > [Delete

f/g Columnl].

| Gitr lai dir liéu

Céc thao tac sau sé loai bd mét sb dir liéu va xéa mot sé cai dat cia ng

dung Table.

(1) Tré vé man hinh HOME va khéi chay trng dung may tinh khac.

(2 Nhan (.

(3) Thay dbéi cai d&t Input/Output véi menu SETTINGS.
(4) Thay déi cai dat Table Type v&i menu TOOLS.
Bang dwai day cho biét div liéu ndo dworc loai bé va dir liéu ndo dworc gily

lai.
Thao tac

Div lidu, ® @) ® @

Cai dat

D liéu bang sbé Puoc loai s .- | Puoc loai
(Ot x, (x), o(x)) bo Puoc loai bo | bwoc loai bo bo

Cai dat Table Range E)u%%loai Puoc gilv lai | Buoc gilr lai | Pwoc gilr lai
Cai dat Table Type Duoc gitr lai | Puwoc gitr lai | Bwoc gily lai --

Cac phuong trinh xac o - S e
dinh 1(x), g(x) DPuoc gilv lai | Pugc loai bd | BPwoc loai bo | Pugc gily lai
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Tinh toan phwong trinh

ng dung Equation bao gdm ba ham dwoc mé ta dwdi day. Sau khi khéi
dong ng dung, ban cé thé sir dung menu Equation xuét hién dé& chon
ham ban mudn.

Simul Equation

Polynomial
Solver

Simul Equation: Phuwong trinh tuyén tinh déng th&i véi tir hai dén bbn an
Polynomial: Phwong trinh bac cao hon tir bac 2 dén 4
Solver: Ham tim gia tri cGa b4t ky bién nao cé trong phwong trinh dau vao

| Phwong trinh tuyén tinh dong thoi

O day, chang téi gidi thich quy trinh chung dé giai phwong trinh ddng thoi
v&i vi du gidi mét phwong trinh tuyén tinh déng thei cé ba an.

X—y+z=2
x+y—z=0
—-x +y+z=4
1. Nh&n ©), chon biéu twong ng dung Equation, sau d6 nhan @&).
« Thao tac nay sé hién thi menu Equation.

Polynomial
Solver
2. Chon [Simul Equation], sau d6 nhan @®.
« Thao tac sé& nay hién thi menu sé an.
2 Unknowns |

3 Unknowns
4 Unknowns

3. Chon [3 Unknowns], sau d6 nhan ©%.
« Thao tac nay sé& hién thj B6 soan thao hé sb.

Vi [
I + Qv + 0z
= + Qv + 0z

s + 0w + 0z

4. Str dung B6 soan thdo hé s dé nhap céc gia tri hé s6.
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1D @1@26 [ - ™% . 1=
1@1@DO(C)1@0® | & 17 : 1 —
®O((-))1691 €91 @94 @9 4

« Thao tac nhan @9 trong khi B soan thao hé sb hién thj sé xoa tat ca
cac hé sbé thanh khong.
5. Nhan @9,
« Diéu nay sé hién thj nghiém.

¥ @ ¥

1

« Trong khi chi bao ¥ hién thi, méi thao tac nhadn &) (hodc @) sé& hién
thi mét nghiém khac.

¥ @ Ti

M (hodc @)

M (hoac @)

« Thao tdc nhan ® hoac ) trong khi chi bdo A hién thj sé& lam cho
nghiém hién thj tredc d6 xuét hién lai.

« Thao tac nhan @ trong khi nghiém cudi cung hién thj sé lam tré vé
B& soan thdo hé s6. Bé tré vé Bo soan thao hé sb trong khi bat ky
nghiém nao dwoc hién thi, nhan @0).

« Thao tac nhan ® trong khi B6 soan thao hé sb hién thj sé& lam tr& vé
menu sé an.

Lwuy

« Trong khi Bo soan thao hé sb hién thi, ban cé thé lwu gia tri dang dwoc danh dau vao
mot bién. Ngoai ra, trong khi nghiém dang hién thi, nghiém hién thi hién tai ciing c6
thé dwoc lwu vao bién. Dé biét chi tiét vé cac bién sb, vui long xem "Céac bién (A, B,
C,D,E, F x,y, 2)" (trang 38).

| Phwong trinh bac cao hon tir bac 2 dén 4

Khi ban giai phwong trinh bac cao hon v&i (’ng dung Equation, cac gia tri
sau day sé dwoc hién thj tuy theo bac ctia phwong trinh.

* Phwong trinh bac hai
Sau khi hién thi nghiém clia ax?>+bx+c=0, toa d6 nhé nhét (hoac I&n
nhét) (x, y) d6i v&i y=ax?+bx+c sé dwoc hién thi.
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* Phwong trinh bac ba
Sau khi hién thi nghiém clia ax3+bx?+cx+d=0, toa d6 (x, y) cta gia tri nhd
nhét (ho&c gia tri I&n nhat) cia y=ax3+bx?+cx+d sé& dwoc hién thi, chi
khi gia tri nhd nhat hoac gia tri I&n nhat cé ton tai. Trwong hop gia tri
nhd nhét hodc gia tri I&n nhat khdng ton tai, thao tac nhan @ trong khi
nghiém cudi cung dwoc hién thi s& lam xuat hién thong bao "No Local
Max/Min".

« Phwong trinh bac bén
Nghiém cla ax*+bx3+cx?+dx+e=0 dwoc hién thi.

O day, ching toi sé dwa ra vi du vé phwong trinh bac hai dé giai thich quy
trinh chung khi giai phwong trinh bac cao hon.

¥+2x-2=0
(Input/Output: Mathl/MathO)
1. Nh&n @), chon biéu twong &ng dung Equation, sau d6 nhan @&).
« Thao tac nay sé hién thj menu Equation.

Polvynomial
Solver

2. Chon [Polynomial], sau d6 nhan @).
« Thao tac nay sé hién thi menu sb bac.

ax3+bx2+cx+d
ax*+bx3+cx2+dx+te

3. Chon [ax?+bx+c], sau d6 nhan @X).
« Thao tac nay sé hién thj Bo6 soan thdo hé sb.

Vo [
auZ+h+c
I+ 0= + 1]

0
4. Sr dung B6 soan thao hé sb d& nhap céc gia tri hé sb.
¥or [ i
axZ+hu+c
1826 ® O((-))26 T —
-2

« Thao tac nhan @9 trong khi Bd soan thao hé sé hién thj sé xoa tat ca
céac hé sb thanh khoéng.
5. Nhan @,
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« Didu nay sé hién thj nghiém.

+o [ i
ax=+bx+c=0
X1=

-14+43

« Trong khi chi bao ¥ hién thi, méi thao tac nhan ¥ (hodc @) sé hién
thi két qua tinh toan (nghiém hodc toa dd) khac.

©(hodc €)
(Hién thi toa dd x nhd nhat clia y = x% + 2x — 2))

©(hodc @)
(Hién thj toa d6 y nhé nhat clia y = x% + 2x — 2.)

M (hoac @)

vor [ i Tih
ax2+bx+c=0
Xz=

-1-43

v [ i Ti
Min of y=ax=+bx+c
x:

-1

v [ i i
Hin of y=ax2+bx+c
y:

-3

« Thao tac nhan ® hodc ® trong khi chi bdo A hién thj s& lam cho két

qua tinh toan hién thj trwdc dé xuét hién lai.

« Thao tac nhan @ trong khi két qua tinh toan cudi cuing hién thj sé& lam
tr& vé Bo soan thdo hé sb. Dé tré vé Bo soan thao hé sb trong khi bét

ky két qua tinh toan nao hién thi, nhan @0,

« Thao tac nhan ® trong khi B6 soan thdo hé sb hién thj sé lam tré& vé

menu sb bac.

Lwuy

» Trong khi Bd soan thdo hé s6 hién thi, ban c6 thé lwu gia tri dang dwoc danh dau vao
mot bién. Ngoai ra, trong khi két qua tinh toan (nghiém hoac toa d6) hién thi, két qua
c6 thé dwoc lwu vao moét bién. Dé biét chi tiét vé cac bién sb, vui long xem "Cac bién

(A,B,C,D, E, F, x, y, z)" (trang 38).

Hién thi nghiém sé6 phirc (Complex Roots)

Céc phwong trinh bac cao hon cé thé c6 nghiém sb phirc. Khi Polynomial
dwoc chon trén menu Equation, ban c6 thé sir dung céc thao tac duéi day

dé bat hoac tat hién thj nghiém sé phurc.

— [Complex Roots] > [On]
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Bat hién thj nghiém sé phurc (cai dat mac dinh ban dau).

— [Complex Roots] > [Off]

T4t hién thj nghiém sé phtrc. Viéc nhap va tinh phwong trinh c6 mot
hodc nhiéu nghiém sé phirc sé chi lam théng bao "No Real Roots"

xuét hién.

2x°+3x+4=0

(Input/Output: Mathl/MathO, Complex Result: a+bi, Complex Roots: On)
1. Nhan ©), chon biéu twong ¢ng dung Equation, sau d6 nhan @&).
« Thao tac nay sé hién thi menu Equation.

2. Chon [Polynomial] > [ax?+bx+c].

« Thao tac nay sé hién thj Bo6 soan thdo hé sb.

Pol¥nomial
Solver

Vo [
AuLHhH+C
I+ 0w+ 1]

3. S dung B& soan thdo hé s6 dé nhap cac gia tri hé sb.

4. Nhén @.

« Diéu nay sé hién thj nghiém.

20936946

5. Hién thj cac gia tri nghiém va toa do khac.

M (hoac @)

& (hodc @)
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0
Yo [ i
uZ+hx+o
242+ 3
4
+o [ i L
ax2+bx+c=0
Xq=
-3+423 i
i
¥or [ i Tk
ax:+bx+c=0
Xaz=
-3—423 i

é

v [ i Ti
Min of y=ax=+bx+c
x:

|




Hiﬁﬂ%F y=5x=+b§+c
- y:

M (hodc @) 23

8

« Thao tac nhan @ trong khi két qua tinh toan cudi cuing hién thj sé& lam
tr& vé Bo soan thdo hé sb. Dé tré vé Bo soan thao hé sb trong khi bét
ky két qua tinh toan nao hién thi, nhan @0,

Chuyén déi nghiém s6 phirc thanh toa dé hinh chir nhat hoiac
toa d6 cuc

Ban c6 thé st dung menu FORMAT xuét hién khi nhan @ dé chuyén dbi
nghiém sé phirc sang dang thirc toa d6 hinh chir nhat hodc toa doé cuec.

Vi du 4: D& chuyén dbi nghiém sbé phirc hién thi trong Vi du 3 (trang 117)
sang dang thirc toa dd cuwc va sau dé chuyén sang dang thirc toa dd hinh
chr nhat

1. Thwe hién cac buéc 1 dén 4 cha Vi du 3 (trang 117).

L

+o [ i
ax®+bx+c=0

X1=
-3+423 i
|

2. Nhan @), chon [Polar Coord], sau d6 nhan @%.
« Thao tac nay sé chuyén déi nghiém sang dang thirc toa do cuc.

+or @ i L
ax2+bx+c=0
Xq=

{2 £122.0277601

3. Nhan @), chon [Rectangular Coord], sau d6 nhan @).
« Thao tac nay sé chuyén dbéi nghiém sang dang thirc toa d6 hinh chiy
nhat.

L

+o [ i
ax:+bx+c=0

X1=
-3+423 i
|

| St dung Solver

Solver dung phwong phap Newton dé tinh x4p xi nghiém phwong trinh.
Solver ho trg' nhap phwong trinh clia cac dang thire sau.
Vidu:y=x+5,x=sin(A), xy + C (Xem nhuw xy + C = 0)

Vi du 5:Dégiéix2—%=0timxkhi8=4

(Input/Output: Mathl/MathO)
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Lwuy

« Trwde khi giai x? - % = 0 tim x, 4 can phai dwoc lwu vao bién B. Viéc nay duoc thuc

hién trong bwéc 3 clia quy trinh dwdi day.

1. Nhan @), chon biéu twong &ng dung Equation, sau d6 nhan @).
« Thao tac nay sé hién thj menu Equation.
2. Chon [Solver], sau d6 nhan @%.
« Thao tac nay sé hién thi man hinh nhap phwong trinh Solver.
3. O budc nay, thwe hién lwu 4 vao bién B.

f=0
C=0 D=0
@ @ 4 @ E=0 F=0
x=0 =0
z=(1

« Thao tac nay cé thé duwoc thue hién bat ky lic nao trwéc bwdc 7 cla
quy trinh nay.
« Dé biét chi tiét vé cac bién s, vui ldng xem "Cac bién (A, B, C, D, E,
F, x, y, z)" (trang 38).
« Nhan ® dé tr& vé man hinh nhap phwong trinh Solver.
4. Nhap phuwong trinh.

DOODOE)®20 |x~E=o
®OE)0

* Ban ciing c6 thé sir dung thao tac sau dé nhap dau =: @ — [Equation]
> [=]
5. Nh4dn @ dé dang ky phwong trinh nhap vao.
6. Trén man hinh Solve Target xuat hién, xac nhan da chon [x] va nhan

@.

« Thao tac nay sé hién thi man hinh v&i gia tri ban dau cia x.

¥or [
Enter Initial
Value

OExecute

7. Nhap 1 lam gia tri ban dau cla x.

Yo E
Enter Initial
1@ |Value
x =1

8. Sau khi chéc chan rang [Execute] dwoc chon, nhin @ dé gidi phuong
trinh.
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x’ —%=EI

L-R

= 1.#14213552
I

(1) (2)

(1) Bién can duoc giai
(2) Nghiém
(3) Két qua (Bén trai) — (Bén phai)

* Nghiém bao gi¢’ cling duoc hién thj theo dang thtrc thép phan.
« Két qua (Bén trai) - (Bén phai) nay cang gan khéng, do chinh xac cua

nghiém cang cao.

9. Tiép theo, nhan phim thyc hién thao tac ban muén.

)

Pé l1am nhirng diéu sau:

Nhan phim:

Tré vé man hinh trong buéc 6.

@*

Lwu biéu thirc dau vao va tré vé man hinh &
buwéc 4.

@ hoac

* Gia tri ban d4u khi ban nhan phim nay sé tr& thanh gia tri ban dau ma

ban da s&r dung gan nh4t cho phép tinh.

Quan trong!

« Solver thwe hién hoi tu theo mot s6 1an dat sén. Néu
khong thé tim thay nghiém, may sé hién thi man hinh
xac nhan giébng nhw trong hinh bén dé xac nhan xem
ban c6 muén tiép tuc hay khéng. Nhan @K) trong khi
[Continue] dwoc chon dé tiép tuc hodc chon [Exit] va
nhan (@K dé hay thao tac Solver.

Exit

« Tuy thudc vao ndi dung ban nhap vao cho gia tri ban dau cho bién nghiém (x trong vi
du trén), Solver c6 thé khoéng thu dwoc nghiém. Néu diéu nay xay ra, hay tht thay dbi

gia tri ban dau sao cho gan véi nghiém hon.

+ Solver c6 thé khéng xac dinh dwoc nghiém ddng, ngay ca khi nghiém ton tai.
+ Solver str dung phwong phap Newton, vi vay ngay ca khi c¢é nhiéu nghiém, chi mot

trong s6 cac nghiém sé duoc tra ve.

+ Do gi&i han trong phuong phap Newton, nghiém cé xu huwéng kho thu dwoc dbi voi

cac phwong trinh nhw sau: y=sinx, y=¢*, y=vx.

| Str dung Verify véi trng dung Equation

ng dung Equation cho phép ban st dung Verify cho cac phwong trinh
ddng thei hodc bac cao hon. Viéc bat Verify véi ('ng dung Equation sé
lam xuét hién menu tréd I&i nhw hinh dwéi thay vi nghiém.
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]
Enter Solution

No Solution
Infinite Solution

Sau khi ban st¥ dung menu nay dé& nhap phan hdi (bang cach chon [Enter
Solution] va sau dé nhap vao mét nghiém, hoac chon [No Solution] hoac
[Infinite Solution]), may tinh sé& xac dinh xem phan hbi clia ban cé dung
hay khéng.

Lwuy

+ Menu trén sé& xuét hién trong trwéng hop clia Simul Equation. Mét menu khac sé xuét
hién trong trwong hop ctia Polynomial.

+ C6 thé str dung Verify v&i nhiéu trng dung may tinh khac nhau. Trwdc khi thwe hién
cac thao tac trong phan nay, vui ldng doc théng tin trong "Tong quan vé Verify"
(trang 73) truéece.

« Khong thé str dung Verify véi cac ham clia (rng dung Equation duéi day.

- [Simul Equation] > [3 Unknowns] hoac [4 Unknowns]

- [Polynomial] > [ax*+bx*+cx+d] hodc [ax*+bx>+cx?+dx+e]

- [Solver]

Thao tac chon bét ky mot trong cac muc menu & trén trén menu Equation trong khi
Verify dwoc bat sé& lam thong bao "Not Compatible with Verify" xu4t hién trén man
hinh.

Vi du vé thao tac Verify

Nhap hai nghiém (x1 = -1 + V3, x2 = -1 - ¥3) clia phwong trinh
x% + 2x - 2 = 0 da dwoc giai trong Vi du 2 (trang 115), va xac dinh xem
ching c6 dung hay khéng. Ngoai ra, chon xem phwong trinh nay co6 gia tri
tdi thiéu hodc gia tri ti da, nhap cac gia tri toa do (x, ), va xac dinh xem
cac gia tri do cé dung hay khong.
1. Thye hién cac buéc 1 dén 4 cha Vi du 2 (trang 115).

Vo [ i
AuLth+o
1HE+ 2x e

-2

2. Dé bat Verify, nhan &9 va sau do chon [Verify ON].
« Chi bao @ sé& xuét hién & phia trén cung ctia man hinh dé cho biét
rang Verify da dwoc bat.
3. Nhan @,
« Thao tac nay sé hién thi menu tra 1&i phwong trinh bac hai.
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¥

Solution
Max
Min

4. Xac nhan da chon [Solution], sau d6 nhan @R.
« Thao tac nay sé hién thi menu s nghiém.

&
1 Solution

2 Solutions

5. Tai day, chon [2 Solutions] va sau dé nhan @R.
6. Trén man hinh nhap nghiém xuét hién, nhap x1 va x».

DO D@30 | thxrest
®OO(NO@3Q® |x2:-1-¥(3)

7. Xac nhan da chon [Execute], sau d6 nhan @%).

+or [
True

Back to Egquation

Confirm Solution

« "True" sé& xuét hién trén man hinh néu sé lwong nghiém va tat ca
nghiém nhap vao la chinh xac.

« "False" s& xuét hién néu sé lwong nghiém hodc nghiém nhap vao la
sai. Nhdn ® hodc @8 dé tré& vé man hinh nhap nghiém va nhap lai
gia tri. D& thay dbi lwa chon vé sé lwong nghiém, nhdn ® trén man
hinh nhap nghiém va bét dau lai tlr buwéc 4.

8. Xac nhan da chon [Back To Equation], sau d6 nhan @%).

« Thao tac nay sé tré vé Bo soan thdo hé sb trong budc 1 cla quy trinh
nay.

9. Nhan @ dé hién thi menu tra I&i va sau d6 chon [Max] hoac [Min].

« Phuong trinh x2 + 2x - 2 = 0 c6 mét gia tri téi thiéu, vi vay ching ta sé
chon [Min] va sau d6 nhan @R.

10. Trén man hinh nhap gia tri toa do xuat hién, nhap x va y.

@ @((_))1 @ El?_m?f‘ y:aixzo-l-bxﬂ:

®O((-)3& [y _:-3

11. Xac nhan da chon [Execute], sau d6 nhan @%).

+o @ i L]
True

Back to Equation

Confirm Solution
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« "True" sé xuat hién trén man hinh khi lwa chon gia tri t6i da hoac tdi
thiéu va tat ca cac gia tri toa d® nhap vao déu chinh xac.

« "False" xuét hién khi lwa chon gia tri t6i da hodc tbi thiéu hoac gia tri
toa do nhap vao |a sai. Néu diéu nay xay ra, nhan & hodc @) dé tré
vé man hinh nhap gia tri toa d6 va nhap lai cac gia tri. Néu ban muén
thay ddi lwa chon gia tri téi da/téi thiéu, nhadn O trén man hinh nhap
gia tri toa do va bat dau lai tr buwéc 9.

12. Xac nhan da chon [Back To Equation], sau d6 nhan @X.

« Thao tac nay sé tré vé Bo soan thdo hé sb trong bwéc 1 clia quy trinh
nay.

13. Dé tat Verify va thoat khéi thao tac Verify, hdy nhan ¢ va sau dé chon
[Verify OFF].

« Thao tac nay sé& lam cho chi bao @ bién méat khdi man hinh.

« D& biét thdng tin vé cach tat Verify, vui Iong xem "Dé tat Verify"
(trang 74).

Lwuy

+ Ban c6 thé xem nghiém va gia tri tdi thiéu bang cach chon [Confirm Solution] & buwéc 8
hoac buéc 12 ctia quy trinh nay, sau d6 nhan @K). Man hinh sé& xuét hién va cac thao
tac co thé dwoc thwe hién gibng nhw & buéc 5 ctia Vi du 2 (trang 115).

Tinh toan bat phwong trinh

Ban c6 thé s& dung (rng dung Inequality dé giai bat phwong trinh bac 2, 3,
hoac 4.

| Quy trinh chung dé thwc hién tinh toan bat
phwong trinh

Pé gidix®+2x-320
1. Nhan ©), chon biéu twong &ng dung Inequality, sau d6 nhan ©X).
« Thao tac nay sé hién thi menu sb bac.

ax3+bx2+cx+d
ax*+bx3+cx2+dx+te

2. Chon [ax?+bx+c], sau d6 nhan @R,

ax2+bx+c<0
ax2+bx+c20
ax2+bx+c=0
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3. Trén menu xuét hién, chon kiéu va huwéng cho diu cla béat phwong
trinh (>,<, 2, S).
« O day chiing ta mudn giai x2 + 2x - 3 2 0, chon [ax2+bx+c=0] va sau
dé nhén @.

4. Trén Bo soan thdo hé sb xuat hién, nhap cac gia tri hé sb.

axﬂﬁgzﬂ
Z 4 >
169260 ® O((-))3@ ¥ 2 —
-3
5. Nhan @ .
« Thao tac nay sé hién thj nghiém.
v [

x<a, bsx

X%=-3, 1=x

« Dé tr& vé Bd soan thao hé sb trong khi nghiém dwoc hién thi, nhan
©), @), hodc €.

« Thao tac nhan ® trong khi B6 soan thdo hé sb hién thj sé lam tré vé
menu & bwéc 2.

« Thao tac nhan ® trong khi menu & buéc 2 hién thj sé lam tré vé
menu sb bAac.

Lwuy

» Cac nghiém dwoc hién thj nhw trong man hinh dwéi day khi khéng chon Mathl/MathO
cho cai dat Input/Output trén menu SETTINGS.

Vi [
Widebie
a= -3
b= 1

+ "No Solution" xuét hién trén man hinh nghiém khi b4t phwong trinh vé6 nghiém (chang
han nhw x? < 0).

« "All Real Numbers" xuét hién trén man hinh nghiém khi nghiém ctia bat phwong trinh
déu 1a sb (chang han nhw x? = 0).

Tinh toan so6 phrc

Dé thuc hién tinh toan sb phirc, trwdc tién hay khéi chay (rng dung
Complex.

Nhan ©), chon biéu twgng tng dung Complex, sau d6 nhan @).
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| Nhap s6 phire

Ban c6 thé dung toa dd hinh chir nhat (a+bi) hodc toa dé cuc (r20) dé
nhap s phtrc.

Vi du 1: D& nhap 2+3i

23® @3()* [2+3il

* Ban ciing c6 thé sir dung thao tac sau dé nhap i: @ — [Complex] > [i].

Vi du 2: D& nhap 5230

5 @ — [Complex] > [£] 30 [5301

| Vi du vé phép tinh dung trng dung Complex
Trwée khi thwe hién thao tac vi du

« Béi v6i cac vi du trong phan nay, hay sir dung menu SETTINGS dé
chon Mathl/MathO cho cai d&t Input/Output. CAu hinh cac cai dat khac
nhw dwoc trinh bay cho méi vi du.

« Két qua tinh toan sé phtrc dwoc hién thi theo cai dat Complex Result
trén menu SETTINGS.

« Néu ban dinh thwc hién nhap va hién thi két qua tinh toan theo dang
thre toa dé cue, hay xac dinh Angle Unit trén menu SETTINGS trwéc
khi bat d3u tinh toan.

« Gia tri 0 ctia két qua tinh toan dwoc hién thj trong mién -180° < 0 < 180°.

« Khi khéng chon Mathl/MathO, man hinh két qué tinh toan sé hién thj a
va bi (hoac r va 0) trén cac dong riéng biét.

Vidu3: (1+i*+(1-i2=-4-2i
(Complex Result: a+bi)

¥ @ i &

O1PE®@HO®4>® C1+E3 14+ ¢1-id2
OC1O®OHO@®

-4-2i

Lwuy

« Khi ting mét sb phirc 1én thanh Ity thira s6 nguyén béng cach st dung cu phap
(a+bi)", gia tri Ity thira c6 thé ndm trong khodng sau day: -1 x 10" < » < 1 x 10'°,

Vidu 4: 2245 =2 + \2i
(Angle Unit: Degree, Complex Result: a+bi)
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2 @ —[Complex] > [2] 45E%

2245

V2 +\2i=2,45
(Angle Unit: Degree, Complex Result: r26)

@20 P @20 ® @ (i)E

Pé thu dwoc sb phirc lién hop cla 2 + 3i
(Complex Result: a+bi)

— [Complex] > [Conjugate]
203®O>HOE®

Dé thu dwoc gia tri tuyét dbi va dbisbé cta 1 + i

(Angle Unit: Degree)

— [Numeric Calc] > [Absolute Value]
1D®OH)@®

— [Complex] > [Argument]
1D®@OHO®

Dé trich phan thwc va phan o cia 2 + 3i

— [Complex] > [Real Part]
2E3®@HOE®

— [Complex] > [Imaginary Part]
23 ®OHOE®

2 +42 &
+o [ &
{2+42 &
2245
¥ [ i &
Conjig{2+3i)
2-3i
v [ -
11+
{2
¥ [ .
Arg(1+i)
45
¥ [ i &
ReP(2+3i)
2
¥vor @ i .
ImP(2+3i)
3

Chuyén déi két qua tinh toan sé6 phirc thanh toa dé hinh chiv

nhat hoac toa do cwc

Ban c6 thé st dung menu FORMAT xuét hién khi ban nhan & dé chuyén
dbi két qua tinh toan sé phirc sang dang thirc toa dd hinh chir nhat hodc

toa do cuwc.
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Vidu 9: V2 + \2i = 2,45, 2,45 = 2 + \2i
(Angle Unit: Degree, Complex Result: a+bi)

Zze
@20 D@20 ® @ (i)E
{2+{2
iz "
— [Polar Coord]
2245
Zize
— [Rectangular Coord]
{2+{2

| S dung Verify v&i (rng dung Complex

Sau khi bat Verify trong 'ng dung Complex, ban cé thé kiém tra xem moét
phuwong trinh hay bt phwong trinh ¢é dung hay khéng. V&i ng dung
Complex, ban cé thé kiém tra xem phwong trinh cé chra sb phirc cé ding
hay khéng.

Lwuy

+ C6 thé st dung Verify véi nhiéu (r’ng dung may tinh khac nhau. Trwéc khi thuc hién
cac thao tac trong phan nay, vui ldng doc théng tin trong "Téng quan vé Verify"
(trang 73) truéece.

+ Khong thé xac dinh dwoc moét bat phwong trinh ¢ chira s6 phirc la dung hay sai
(Math ERROR).

« Khi Verify dwoc bat véi (rng dung Complex, cac muc sau day giéng véi cac muc cho
trng dung Calculate.

- "Biéu thirc c6 thé xac minh" (trang 75)

- "Thwe hién thao tac xac minh tuan tw & phia bén phai cta biéu thirc" (trang 75)

Vi du vé thao tac Verify

Vi du 10: Dé kiém tra xem i? = -1 ¢ dung hay khéng
1. Dé bat Verify, nhan va sau dé chon [Verify ON].
« Chibdo @ sé& xuét hién & phia trén cung ctia man hinh dé cho biét
rang Verify da dwoc bat.
2. Nhap i = -1 va kiém tra xem c6 dung hay khéng.

¥or [ i L] Y

®@ (@ |£="1
— [Verify] > [=] ® O((-))1€

True
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3. Dé tat Verify va thoat khai thao tac Verify, hdy nhan ¢ va sau dé chon
[Verify OFF].
« Thao tac nay sé lam cho chi bao @ bién méat khdi man hinh.
« D& biét thdng tin vé cach tat Verify, vui Iong xem "Dé tat Verify"
(trang 74).

Tinh toan co’ so n

Khi ban muén thuc hién cac phép tinh sir dung céc gia tri thap phan, thap
luc phan, nhi phan, va/hoac bat phan, hay khéi chay (rng dung Base-N.
Nhan @), chon biéu twong &ng dung Base-N, sau d6 nhan @. Cai dat
phuwong thirc sé mac dinh ban dau khi ban kh&i chay rng dung Base-N |a
thap phan.

[Decimall

Press [FORMAT]
to change format.

Sau khi kh&i chay ng dung Base-N, hay st dung @) dé chuyén ddi
phuong thirc sé.

Mbi 1an nhan @), may sé chuyén qua cac phwong thirc sé nhw trinh bay
duei day.

> (1) »(2) > (3) > (4)

(1) [Decimal] (2) [Hexadecimal] (3) [Binary] (4) [Octal]

Lwuy

+ Céc chir s6 dwdi dwoc thém vao cac gia tri dwoc trinh bay trong vi du thé hién co sb
(phwong thirc s6) cuia tirng gia tri.
Vidu: 1, ... Nhj phan 1; 14¢ ... Thap luc phan 1

Pé tinh 112 + 1,
1. S&r dung @ dé thay déi phwong thire sé thanh [Binary].
2. Thye hién phép tinh 112 + 15.

[
1

1M®1® | booo 0ooo 0000 D000
0000 0000 0000 0100

Dé tinh 1F 16 + 116 theo thap luc phan
1. S&r dung @ dé thay déi phwong thire sé thanh [Hexadecimal].
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2. Thwe hién phép tinh 1F16 + 146.

Egiﬁadecimall
1T®OF)D1E 00000020

Lwuy

+ Str dung cac phim sau dé nhap cac chir cai tir A dén F cho céc gia tri thap luc phan:
®@®W., ®B®E). ®©®C) ®DD), ®DE) ®GF).Bancing cb thé
nhap cac gia tri thap luc phan bang cach st dung cac muc menu CATALOG duwoc
trinh bay dudi day.

_ [Hex Value] > [A], [B], [C], [D], [E], hoac [F]

+ Lwu y rang néu ban nhap bat ky ky tw nao tir A dén F bang cach thao tac nhw dwdi
day, ky tw d6 s& dwoc xem nhuw tén bién, khéng phai gia tri thap luc phan.
(1) Nhan ¢2) d& hién thi man hinh danh sach bién sb.

(2) Chon [A=], [B=], [C=], [D=], [E=], hodc [F=], sau d6 nhan @R).
(3) Trén menu xuét hién, chon [Recall].

» Trong trng dung Base-N, khéng hé tro' nhap céc gia tri phan s6 va sd mi phan sb (s
thap phan). Néu két qua phép tinh cé phan phan sb thi phan nay sé bi cat mét.

« Chi tiét v& mi&n di¥ liéu dAu vao va mién de lidu dau ra (32 bits) duoc trinh bay dudi

day.
Co sd Mién
Duwong: 00000000000000000000000000000000 < x<
o 01111111111111111111111111111111
Nhi phan e
Am: 10000000000000000000000000000000 < x=<
11111111111111111111111111111111
i . Dwong: 00000000000 < x< 17777777777
Bat phan -
Am: 20000000000 < x< 37777777777
Thap phan -2147483648 < x < 2147483647
. . Dwong: 00000000 < x< 7FFFFFFF
Thap luc phan A
Am: 80000000 < x< FFFFFFFF

+ Math ERROR xuét hién khi két qua tinh toan ndm ngoai pham vi ap dung cho hé
thdng sé dang dwoc st dung.

| Xac dinh phwong thire so cua gia tri nhap dac biét

Ban c6 thé nhap mot 1énh déc biét ngay trwédc mot gia tri dé xac dinh
phuong thire sb cla gia tri d6. Cac Iénh dac biét 1a: d (thap phan), h (thap
luc phan), b (nhi phan), va o (bat phan).

Dé tinh 1010 + 1016 + 105 + 108 va hién thi két QUé la gié tri thép
phan
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1. Str dung @ dé thay déi phwong thirc sé thanh [Decimal).
2. Thye hién phép tinh 1019 + 1046 + 102 + 10s.

— [Base Prefix] > [Decimal(d)] 10® [;pecimal 1 y
— [Base Prefix] > [Hexadecimal(h)] 10@® |d1 0+b10+010 36

(
@- [Base Prefix] > [Binary(b)] 10®
— [Base Prefix] > [Octal(o)] 10@9

| Chuyén doi két qua phép tinh sang kiéu gia tri
khac

Ban c6 thé s dung @ dé chuyén ddi két qua phép tinh dang dwoc hién
thi sang kiéu gia tri khac.

Dé tinh 1510 x 3740 trong phwong thirc thap phan, rdi chuyén doi
két qua sang thap luc phan
1. Sir dung @ dé thay ddi phwong thirc sb thanh [Decimal].
2. Thyce hién phép tinh 1519 x 3710.

[Deci
15®37@ 1537 .

3. S dung @ dé thay ddi phwong thirc sb thanh [Hexadecimal].

decimall ‘
00D0D22EB

| Phép toan logic va pha dinh

Cac phép toan logic va phi dinh dwoc thwe hién bang cach nhan @ va
chon [Logic Operation], sau d6 chon Iénh mong muén (Neg, Not, and, or,
xor, xnor) tr menu xuét hién. Tat ca nhirng vi du sau déu dugc thuc hién
trong phuwong thiare nhi phan.

Dé xac dinh phép va logic AND cia 10102 va 11002 (10102 and
11002)

1010 lasnarua, o, -
— [Logic Operation] > [and] | hapo BA0G 0000 DOOO
11006 | 0000 0000 0000 1000

Dé xac dinh phan bu theo bit ctia 10102 (Not(101052))
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— [Logic Operation] > [Not] rﬁg%?
10100@ (1111

Lwuy

» Trong trwéng hop gia tri nhi phan, bat phan hoac thap luc phan am, may tinh chuyén
ddi gia tri nay sang nhi phan, 1y phan bu clia hai va sau d6 chuyén nguoc vé phuong
thirc sb gbe. Vi gia tri thap phan, may tinh tay don thuan thém dau tro.

Tinh toan ma tran

S dung rng dung Matrix dé thuwc hién cac phép tinh c6 chira ma tran, voi
t6i da 4 hang 4 cot.

| Quy trinh chung dé thwc hién tinh toan ma tran

Dé thuwc hién tinh toan ma tran, hay dung cac bién ma tran déc biét (MatA,
MatB, MatC, MatD) nhw trinh bay trong vi du du¢i day.

Vi du 1: D& tinh [i i x[_zl 21]

« D& nhan (Ma tran 1 x Ma tran 2), s lwong cot trong Ma tran 1 phai
khép véi sb lwong hang trong Ma tran 2. Néu khéng sé xay ra 16i.

1. Nhan ©), chon biéu twong ¢ng dung Matrix, sau d6 nhan @R.
« Thao tac nay sé hién thi man hinh tinh toan ma tran.

Press [TOOLS]
to define Matrix.

2. Nhén 6.

« Thao tac nay sé hién thj man hinh danh sach bién ma tran.

MatB:Hone

MatC:Mone
HatD:Hone

« Dé biét chi tiét vé& ndi dung man hinh danh sach bién ma tran, cach
lwu bién ma tran, chinh sira, hodc cac thao tac khac, vui ldng xem
"Man hinh danh sach bién ma tran" (trang 134).

3. Thuce hién cac budc dwéi day dé luu [?12 }] vao MatA.
(1) Chon [MatA:], sau d6 nhan @%).
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« Thao tac nay sé hién thj man hinh cai dat kich thwé'c ma tran (cai
dat mac dinh ban dau: 2 hang, 2 cot).

Matrix Size?

Columns 2 -
oConfirm

(2) O day, ching ta mudn lwu mét ma tran 2x2, vi vay chon [Confirm] va
sau dé nhan @X.
« Thao tac nay sé hién thi B6 soan thdo ma tran dé nhap cac phan tl
clia ma tran 2x2 vao MatA.

Math=

™=

(3) Nhap cac phan tlr ctia MatA.

Math=

2@1@1@1@ [ ?—11]

(4) Nhan ®, @0, hoac @® dé tré vé man hinh tinh toan ma tran.
4. Thyc hién cac budc dusi day dé luu 5 7] vao MatB.

(1) Nhan @9, chon [MatB:], sau d6 nhan @R.

(2) Chon [Confirm], sau d6 nhan @) .

(3) Nhap cac phan t& ctia MatB.

MatB=

2@®O(N@®O()@2@ | [ -7 mml

(4) Nhan ®), @), hodc @ dé tré vé man hinh tinh toan ma tran.
5. Nhap MatAxMatB.

— [Matrix] > [MatA] MatAxMatBl
X @ — [Matrix] > [MatB]

6. Nhan @.
* Thao tac nay sé hién thi man hinh MatAns (BO nh¢ tra Ioi ma tran)
voi két qua tinh toan.

O]
Mat.fns=
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« D& biét chi tiét vé& MatAns, vui lobng xem "B6 nhé tra I&i ma tran
(MatAns)" (trang 136).

« Thao tac nhan (&9 trong khi man hinh MatAns hién thj s& lam tr& vé
man hinh tinh todn ma tran va xoa biéu thic tinh toan. Thao tac nhan
® hodc @) sé& [am tré vé trang thai hoan tat nhap biéu thirc tinh toan
trong buéc 5 clia quy trinh nay.

Lwuy

* Trong khi man hinh B6 soan thdo ma tran hoac MatAns hién thi, ban cé thé lwu gia trj
dang dwgc danh dau vao mét bién. Trong khi man hinh tinh toan ma tran hién thj va
c6 mot gia tri k&t qua tinh toan & trén man hinh, ban cé thé lwu két qua tinh toan dwoc
hién thi vao bién. Dé biét chi tiét vé cac bién sd, vui long xem "Cac bién (A, B, C, D,
E, F, x, y, z)" (trang 38).

| Man hinh danh sach bién ma tran

Man hinh danh sach bién ma tran 1a cdng nhap ban nén s dung khi
mudn lwu modt ma tran vao bién ma tran MatA, MatB, MatC, hodc MatD,
hodc khi mudn chinh sira ma tran da dwoc lwu trwde dé. Trang thai cha
moi bién ma tran dwoc thé hién nhw trong cac vi du duéi day.

C—o-—=—u
MatB:2x2
MatC:Nonee (2)
MatD:None
(1) 2x2
Cho biét ma tran 2x2 dwoc lwu vao bién ma tran.
(2) None

Cho biét khéng c6 gi dwoc lwu vao bién ma tran.

Hién thi man hinh danh sach bién ma tran
Tay thuéc vao man hinh dang hién thi, hay thyc hién mot trong cac thao
tac bén duwéi.
« Khi man hinh tinh todn ma tran dwoc hién thi:
Nhan €.
« Khi man hinh Bo soan thao ma tran hodc MatAns dwoc hién thi:
Nhan €3, chon [Define Matrix], sau d6 nhan @X).

Lwu dir liéu méi vao bién ma tran

Vi du 2: D& lwu ma tran 2x3 [é 01 11]

1. Trong khi man hinh tinh toan ma tran hién thi, nhan ¢ dé hién thi man
hinh danh sach bién ma tran.
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2. Chon bién ma tran (MatA, MatB, MatC, hodc MatD) ma ban muén lwu
di¥ liéu m&i, sau d6 nhan ©K.
« Néu ban chon mét bién ma tran c6 trang thai 1a "None", hay chuyén
sang bwéc 4 cua quy trinh nay.
« Néu ban chon mét bién ma tran da cé ma tran dwoc lwu vao, man
hinh menu sé& xuét hién. Chuyén dén buéc 3.

Define New

3. Chon [Define New], sau d6 nhan @®.
4. Trén man hinh "Matrix Size?" xuat hién, chi dinh sé hang va cét trong

ma tran.

Matrix Size?

Columns 2 -
oConfirm

« D& chi dinh m6t ma tran 2x3, thwe hién cac bwéc dusi day.

(1) Chon [Rows] va sau d6 nhan @. Trén menu xuét hién, chon [2
Rows] va nhan @R.

(2) Chon [Columns] va nhan @. Trén menu xuét hién, chon [3 Columns]
va nhan @K).

5. Sau khi chi dinh cac théng s hang va cét nhu mong muédn, chon
[Confirm] va sau d6 nhan @.
« Thao tac nay sé hién thi B6 soan thdo ma tran.

Math=

[ & ]
0
6. Nhap cac phan t&r cGa bién ma tran.
1@0@DOO® | 1 2 ]
06 ® O ((-))1@91E ]

7. Nhan ®, @09, hodc @® dé tr& vé man hinh tinh toan ma tran.

Lwuy

« N&i dung bién ma tran dwoc lwu lai ngay ca khi ban nhan (7), thay ddi tng dung may
tinh, hoac tat may tinh. Viéc thwc hién mét trong cac thao tac sau day sé lam cho ndi
dung cua tat ca cac bién ma tran bj xda.

- @ — [Reset] > [Settings & Data]
- @ — [Reset] > [Initialize All]
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Soan thao dir liéu cho bién ma tran

1. Trong khi man hinh tinh toan ma tran hién thi, nhan 9 dé hién thi man
hinh danh sach bién ma tran.

2. Chon bién ma tran (MatA, MatB, MatC, hodc MatD) ban muén chinh
slra, sau d6 nhan @K,

3. Trén menu xuét hién, chon [Edit] va sau d6 nhan @%).
« Thao tac nay sé hién thi B soan thdo ma tran.

4. Str dung B6 soan thao ma tran dé chinh slra cac phan tlr clia ma tran.
« Chuyén con tré t&i 6 cé chira phan t& ban muén thay dbi, nhap gia tri

ma&i, sau dé nhan @,
5. Nhan ®, @09, hodc ©@® dé tr& vé man hinh tinh toan ma tran.

Sao chép ndi dung bién ma tran (hoic MatAns)

1. Hién thi man hinh B6 soan thdo ma tran hodc MatAns cla bién ma tran
ban muén st dung lam ngudn sao chép.
« D& hién thj Bd soan thdo ma tran, thwc hién cac bwéc 1, 2, va 3 trong
phan "Soan thao dir liéu cho bién ma tran" (trang 136).
« D& hién thi man hinh MatAns, thuc hién cac bwéc dwéi day trong khi
man hinh tinh toan ma tran dwoc hién thi.
— [Matrix] > [MatAns] €®
2. Lwa chon dich sao chép bién ma tran.
« Vi du, dé sao chép vao MatD, thyc hién thao tac sau: — [Store] >
[MatD].
« Thao tac nay sé hién thj B6 soan thdo ma tran véi ndi dung cua dich
sao cheép.
3. Nhan ®, @09, hodc @® dé tr& vé man hinh tinh toan ma tran.

| B6 nhé tra 1&i ma tran (MatAns)

B4t cr khi nao két qua clia phép tinh dwoc thue hién trong rng dung
Matrix 1& mét ma tran, man hinh MatAns sé xuét hién voi két qua. Két qua
nay cling sé dwoc lwu vao bién cé tén "MatAns".

Bién MatAns c6 thé dwoc dung trong tinh toan nhw dwgc mé ta duwdi day.

« D& chén bién MatAns vao mét phép tinh, thwc hién thao tac sau: @ —
[Matrix] > [MatAns].

« Thao tac nhan b4t ky phim nao sau day trong khi man hinh MatAns hién
thi s& lam chuyén dbi tw ddng sang man hinh tinh toan ma tran, véi
"MatAns" theo sau la toan ti hodc chirc ndng cia phim ban da nhan:

® 0,8 6,6 6 e ®@"H0) ®Ow).
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Lwuy

« Noi dung MatAns duoc lwu lai ngay ca khi ban nhan () hoac tat may tinh. Viéc thuc
hién moét trong cac thao tac dw¢i day sé lam cho néi dung MatAns bj x6a.
- Tr& vé man hinh HOME va khé&i chay (rng dung may tinh khac
- Thyc hién &) — [Reset] > [Settings & Datal]
- Thuc hién @ — [Reset] > [Initialize All]

| Vi du tinh ma tran

Vi du dusi day st dung MatA = [* 1], MatB = [2 3], MatC = R

1
1 2 3
4 5 6
7 8 9

MatD =

Vi du 3: Dé cong hai ma tran (MatA + MatB)

D]
Mat.fins=

— [Matrix] > [MatA] | [mm— 4
@® @ - [Matrix] > [MatB] @

i
Lwuy
+ Hai ma tran phai c6 cung kich thwéc dé cong hodc triv. L6i xay ra néu ban cb gang
cong hoac trir ma tran & cac kich thwédc khac nhau.
Vi du 4: Tinh binh phwong va 1ap phwong MatA (MatA2, MatA?®)
— [Matrix] > [MatA] @ — [Matrix] > Matﬁi .
[Matrix Calc] > [Matrix Squared] | [ & 2l
® 5
— [Matrix] > [MatA] @ — [Matrix] > Matﬁﬁg .
[Matrix Calc] > [Matrix Cubed] | [ & ]
® 13

Vi du 5: D& nghich dado MatA (MatA™)
- 1
@<

|: a22 _a12:|
_a21 a11

-1
[an a1z} _
Ay Ay A4105 — Q120
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Ay Gyp Qg |
Az U Uy
A3 Az (i
Uoollas = Upallza —(lialaz + Uialzz  Ayolaz — Ai3ls
—UyU33 + Uy3lzy  Aq1U33 — A4303y —U410z3 + Aq305¢
A1 Q3p = Applzy —A41Qzp + Q13 A410p — Q120

a11 a12 a13
det | Ay Gy Gy
a31 a32 a33

— [Matrix] > [MatA] @ — [Matrix] > |matans=" )
[Matrix Calc] > [Inverse Matrix] — 2]

&

Lwuy

« Chi c6 thé nghich dao ma tran vudng (cung sé hang va cot). Thao tac nghich dao mét
ma tran khéng vudng sé gay ra I6i.

+ M6t ma tran véi dinh thirc bang khong thi khéng thé nghich ddo. Thao tac nghich dao
mot ma tran vai dinh thire bang khdng sé gay ra 16i.

« D6 chinh x4c tinh toan bi anh hwéng ddi véi ma tran cé dinh thirc gan béng khong.

Vi du 6: Dé 14y dinh thirc clia MatA (Det(MatA))

det [an = U4y

Ay Ay
det = Q4103 — A0
Ay Ay

a11 a12 a13
det| Ay Qs Ao
a31 a32 a33

= a11a22a33 + a12a23a31 + a13a21a32 - a13a22a31
= a12a21a33 - a11a23a32

— [Matrix] > [Matrix Calc] > |pet Hata)
[Determinant] @ — [Matrix] > [MatA]

Oe

Lwuy
« Chi c6 thé 14y dwoc dinh thirc dbi véi ma tran vuéng (cuing sé hang va cot). Thao tac

lay dinh thirc dbi véi mot ma tran khong vudng sé gay ra 16i.

Vi du 7: Dé 14y chuyén vi cia MatC (Trn(MatC)).
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— [Matrix] > [Matrix Calc] > [watans=" ]
[Transposition] @ — [Matrix] > [MatC] [ Ik '}]
Q1) 1

Dé tao moét ma tran don vi 2 x 2 va cong né vao MatA (Identity(2)
+ MatA)

— [Matrix] > [Matrix Calc] > [Identity] Matﬁi 1
20® @ - Matrix] > Mata] | [0 2l
& 3

Lwuy

« Ban c6 thé chi dinh moét gia tri tir 1 t&i 4 1am dbi s6 cho Iénh Identity (sb chiéu).

Dé 14y duoc gia tri tuyét dbi ctia tivng phan tir cia MatC
(Abs(MatC))

— [Numeric Calc] > [Absolute Value] |wstans=" .
— [Matrix] > [MatC] [ 1 11
QI 1

Tinh toan véc-to

S dung rng dung Vector dé thuwc hién tinh toan véc-to’ hai chiéu va
véc-to ba chiéu.

| Quy trinh chung dé thwc hién tinh toan véc-to

Dé thuwc hién tinh toan véc-to, hay dung cac bién véc-to dic biét (VctA,
VctB, VctC, VctD) nhw trong vi du dudi day.

Pé tinh (1, 2) + (3, 4)
« Khi thye hién céng hodc trir hai véc-to, ca hai déu phai c6 cung sb
chiéu.
1. Nhan @), chon biéu twong &ng dung Vector, sau d6 nhan @K).
« Thao tac nay sé hién thi man hinh tinh toan véc-to.

Press [TOOLS]
to define Vector.

2. Nhén €.

« Thao tac nay sé hién thi man hinh danh sach bién véc-to.
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VctB:None
VctC:None
VctD:None

« D& biét chi tiét vé ndi dung man hinh danh sach bién véc-to, cach lwu
bién véc-to, chinh stra, hodc cac thao tac khac, vui ldbng xem "Man
hinh danh sach bién véc-to" (trang 141).

3. Thuc hién cac buwéc dudi day dé lwu (1, 2) vao VCtA.
(1) Chon [VctA:], sau d6 nhan @%).
* Thao tac nay sé hién thi man hinh cai dat chiéu véc-to (cai dat
mac dinh ban dau: 2 chiéu).

Vector Dimension?
Dimensions 2 >
oConfirm

(2) O day, chung ta mudn lwu véc-to hai chiéu, vi vay chon [Confirm] va
sau dé nhan @X.
« Thao tac nay sé hién thj Bo soan thdo véc-to d& nhap véc-to hai
chiéu cho VctA.

Veoth=
[*=]
0
(3) Nhap cac phan ti cla VctA.
Voth= .
1()2() [-m]
2
(4) Nhan ®), @0, hodc @ dé tré vé man hinh tinh toan véc-to.
4. Thuc hién cac budc dudi day dé luu (3, 4) vao VctB.
(1) Nhan &9, chon [VctB:], sau d6 nhan @X.
(2) Chon [Confirm], sau d6 nhan @.
(3) Nhap céac phan t&r ctia VctB.
VeotB= 2
3ED4E [ ]
4

(4) Nhan ®), @9, hoac @) dé tré vé man hinh tinh toan véc-to.
5. Nhap VctA+VctB.

_ [Vector] > [VctA] |YEtA+VCtHI
® @ — [Vector] > [VctB]
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6. Nhan @.
« Thao tac nay sé hién thj man hinh VctAns (B6 nho tra |&i véc-to) véi
két qua tinh toan.

D]
Vcthns=
E

« D& biét chi tiét vé VctAns, vui long xem "Bo nhé tra & véc-to
(VctAns)" (trang 143).

« Thao tac nhan @9 trong khi man hinh VctAns hién thi sé& [am tré vé
man hinh tinh toan véc-to va xoa biéu thirc tinh toan. Thao tac nhan
® hoédc @K sé& lam tré vé trang thai hoan tat nhap biéu thirc tinh toan
trong budc 5 clia quy trinh nay.

Lwuy

* Trong khi man hinh B soan thao véc-to hoac VctAns hién thi, ban c6 thé Iwu gia tri
dang duwoc danh dau vao mét bién. Trong khi man hinh tinh toén véc-to' hién thi va cé
gia tri k&t qua tinh toan trén man hinh, ban cé thé lwu két qua tinh toan dwoc hién thi
vao bién. D& biét chi tiét vé cac bién sb, vui long xem "Cac bién (A, B, C, D, E, F, x, y,
z)" (trang 38).

| Man hinh danh sach bién véc-to

Man hinh danh sach bién véc-to la cdng nhap ban nén st dung khi muén
lwu mot véc-to vao bién véc-to VctA, VetB, VctC, hodc VetD, hodc khi
mudn chinh sira véc-tor da dwoc lwu trude d6. Trang thai ctia méi bién
véc-to dwoc thé hién nhw trong cac vi du dwdi day.

O (1)
VetB:2
VctC:Nonee (2)
VctD:None

(1) 2

Cho biét rang véc-to hai chiéu dwoc lwu vao bién véc-to.
(2) None

Cho biét rang khéng c6 gi dwoc lwu vao bién véc-to.

Hién thi man hinh danh sach bién véc-to
Tuy thudc vao man hinh dang hién thij, hay thwc hién mét trong cac thao
tac bén dudi.

« Khi man hinh tinh toan véc-to dwoc hién thi:

Nhan 9.
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« Khi man hinh B soan thao véc-to hodc VctAns dwoc hién thi:
Nhan €3, chon [Define Vector], sau dé nhan @R.

Lwu dir liéu méi vao bién véc-to
Pé& Iwu véc-to ba chidu (1, 2, 3)
1. Trong khi man hinh tinh toan véc-to hién thi, nhan €9 dé hién thj man
hinh danh séach bién véc-to.
2. Chon bién véc-to (VctA, VctB, VctC, hoac VetD) ma ban mudn lwu div
liéu m&i, sau d6 nhan @R,
« Néu ban chon mét bién véc-to cé trang thai la "None", hay chuyén
sang buwdc 4 cda quy trinh nay.
« Néu ban chon mot bién véc-to da cé véc-to dwoce Iwu vao, man hinh
menu sé& xuét hién. Chuyén dén budc 3.

Define New

3. Chon [Define New], sau d6 nhan @.
4. Trén man hinh "Vector Dimension?" xuat hién, hay chi dinh sé chiéu

véc-to.

Vector Dimension?
Dimensions 2 -
oConfirm

« Dé chi dinh ba chiéu, thwc hién cac buwéc dwdi day.
(1) Chon [Dimensions] va nhan @X).
(2) Trén menu xuéat hién, chon [3 Dimensions] va nhan @X.
5. Sau khi chi dinh théng sb chiéu nhw mong mudn, chon [Confirm] va sau

dé nhan ©X.

« Thao tac nay sé hién thi B6 soan thdo véc-to.

=
VctC=
)
u]
1]
6. Nhap céac phan t&r cia bién véc-to.
Votil= :
182638 | | ]
3

7.Nhéan @, @0, hodc @) dé tré vé man hinh tinh toan véc-to.
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Lwuy

« Noi dung bién véc-to dwoc lwu lai ngay ca khi ban nhan (1), thay déi ting dung may
tinh, hodc tat may tinh. Viéc thwc hién mét trong cac thao tac dudi day sé lam cho ndi
dung cua tat ca cac bién véc-to bj xda.

- @ — [Reset] > [Settings & Data]
- @ - [Reset] > [Initialize All]

Soan thao dir liéu cho bién véc-to

1. Trong khi man hinh tinh toan véc-to hién thi, nhan €9 dé hién thj man
hinh danh séach bién véc-to.

2. Chon bién véc-to (VctA, VctB, VctC, hodc VetD) ban mudn chinh sira,
sau dé nhan @K,

3. Trén menu xuét hién, chon [Edit] va sau d6 nhan @%).
* Thao tac nay sé hién thi B soan thao véc-to.

4. Str dung B6 soan thdo véc-to dé chinh stra cac phan t&r cla véc-to.
« Chuyén con tré t&i 6 ¢é chira phan t& ban mubn thay déi, nhap gia tri

mé&i, sau d6 nhan @9,
5. Nhan ®, &0, hodc @® dé tr& v& man hinh tinh toan véc-to.

Sao chép ndi dung bién véc-to (hodc VctAns)

1. Hién thi man hinh B soan thdo véc-to hodc VctAns cla bién véc-to
ban muén st dung lam ngudn sao chép.
« D& hién thj B soan thdo véc-to, thwe hién cac bwdc 1, 2, va 3 trong
phan "Soan thao dir liéu cho bién véc-to™ (trang 143).
« Dé hién thi man hinh VctAns, thwe hién cac budc dudi day trong khi
man hinh tinh toan véc-to dwoc hién thi.
— [Vector] > [VctAns] @
2. Chon dich sao chép bién véc-to.
« Vi du, dé sao chép vao VctD, thyc hién thao tac sau: — [Store] >
[VctD].
« Thao tac nay sé hién thj B6 soan thdo véc-to véi ndi dung cla dich
sao chép.
3. Nhan ®), @, hodc @ dé tr& vé man hinh tinh toan véc-to.

| B6 nhé tra 16 véc-to (VctAns)

Bét ctv khi nao két qua ctia phép tinh dworc thue hién trong (rng dung
Vector |a mét véc-to, man hinh VcAns sé xuét hién véi két qua. Két qua
nay cling sé duoc lwu vao bién cé tén "VctAns".

Bién VctAns cé thé dwoc dung trong tinh toan nhu dwoc mé ta sau day.

143



« D& chén bién VctAns vao mot phép tinh, thue hién thao tac sau: @ —

[Vector] > [VctAns].

« Thao tac nhan bét ky phim nao sau day trong khi man hinh VctAns

hién thj s& lam chuyén déi tw déng sang man hinh tinh toan véc-to, véi

"\/ctAns" theo sau la toan tir hodc chirc ndng cia phim ban da nhan:

® 0,8 6,6 6 e ®@"H0) ®Ow).

Lwuy

« N&i dung VctAns dwoc lwu lai ngay ca khi ban nhan () hoac tat may tinh. Viéc thuc
hién moét trong cac thao tac dwdi day sé lam cho néi dung VctAns bi xoa.

- Tr& vé man hinh HOME va khé&i chay (rng dung may tinh khac
- Thyc hién &) — [Reset] > [Settings & Datal]
- Thuc hién @ — [Reset] > [Initialize All]

| Vi du tinh véc-to

Céc vi du dwéi day st dung VCtA = (1, 2) va VetB = (3, 4), va VetC = (2,

-1, 2).
Vi du 3: VctA « VctB (Tich vo hwéng véc-to)

(a4, ay)- (bv bz) = a1b1 + azbz
(as, a,, as)* (bv bzy bs) = a1b1 + azbz + asbs

— [Vector] > [VctA] |vetA-vetB

— [Vector] > [Vector Calc] > [Dot Product]
— [Vector] > [VctB] @

11

Lwuy

» Khi tinh tich vé6 huéng, sé chiéu cla hai véc-to phai giéng nhau.

Vi du 4: VctA x VctB (Tich cé huwdng véc-to)

(ay, ay) X (by, b)) = (0, 0, a,b, - a,b)
(ah az; as) X (bh bZ’ bS)
= (azbs - asbzy a3b1 - a1b3; a1b2 - a2b1)

D]
— [Vector] > [VCtA] |vetans=

— [Vector] > [Vector Calc] > [Cross Product]
— [Vector] > [VctB] @9

-2

Lwuy

« Khi tinh tich c6 hwéng, sé chiéu cla hai véc-to phai gibng nhau.
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Vi du 5: D& xac dinh géc tao béi VctA va VetB chinh xac dén ba chi sé
thap phan. (Number Format: Fix 3, Angle Unit: Degree)

— [Vector] > [Vector Calc] > [Angle] |angle¢Vcta, Vers)

— [Vector] > [VctA]
® O(,)® - [Vector] > [VctB]O) @

Lwuy

« Khi tinh géc tao béi hai véc-to, sé chiéu cla hai véc-to phai gibng nhau.

Vi du 6: D& chuan hoa VctB

O]
Vothns=

— [Vector] > [Vector Calc] > [Unit Vector] [ —
— [Vector] > [VctB]O) @

0.6
Vi du 7: Dé thu dwoc gia tri tuyét dbi ctia VctC
Abs(a,, a;) =~\a’ + a;’
AbS(y, @y, a3) =~a> +a,” + a;
— [Numeric Calc] > [Absolute Value] |abs {yctC) ;

— [Vector] > [VctC]
Ol

Tinh toan ty lé

(Yng dung Ratio cho phép ban xac dinh gia tri ciia X trong biéu thirc ty 1&

A:B = X: D (hoac A : B = C : X) khi gia tri cia A, B, C va D déu da biét.
| Quy trinh chung dé thwc hién tinh toan ty 1é

Vi du 1: D& gii 3: 8 = X : 12 tim X
1. Nhan ©), chon biéu twong ng dung Ratio, sau d6 nhan @).
2. Trén menu xuét hién, chon [A:B=X:D] hoéc [A:B=C:X].

« O day chung ta mudn giai 3 : 8 = X : 12 tim X, vi vay chon [A:B=X:D],

sau dé nhan @K,
3. Trén Bd soan thao hé sé xuét hién, nhap céac gia tri hé sé.
« O day chung ta nhap vao cac hé sb sau day: A=3,B=8,D=12.

¥ B

3e08@D12@) | = 8- 10

12

4. Sau khi diéu chinh tat ca cac gia tri theo y muén clia ban, nhan @%.
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« Thao tac nay sé hién thj nghiém (gia tri ctia X).

« Nhan B, @0, hodc @® dé tré vé B soan thao hé sb.

Lwuy

+ Math ERROR sé& xay ra néu ban thyc hién tinh toan trong khi 0 1a dau vao cho hé sé.

+ Thuc hién cac bwédc dudi day sé dat lai tAt ca cac hé sb trong Bo soan thao hé sb

thanh 0.

- Trong khi B6 soan thao hé sé hién thj, nhan (5), @9, @), hodc ().
- Khi nghiém hién thi, nhan @) hoac (V).

Ban c6 thé lwu két qua tinh toan dang duorc hién thj vao mét bién. Vi du, néu thuc

hién thao tac sau khi man hinh trong buwéc 4 & trén hién thi, may sé lwu két qua tinh
toan vao bién A: ¢2) — [A=] > [Store]. D& biét chi tiét vé& cac bién sb, vui long xem

"Cac bién (A, B, C, D, E, F, x, y, 2)" (trang 38).

Dé thay déi loai biéu thirc ty lé

1. Trong khi B6 soan thao hé sé hién thi, nhdn ©.

2. Trén menu xuét hién, chon loai biéu thirc ty I& ban mudn.

| Vi du vé phép tinh

Vi du 2: Dé tinh toan X theo ti1é 1: 2 =X : 10

© - [Ratio] > [A:B=X:D]
169260910E0

St dung Math Box

¥or B
W=
3
2
¥ [
S O - I
10
_-A"ETfm
2

Yng dung Math Box c6 cac chirc ndng hé tro hoc tap sau day.
Dice Roll: Dice Roll [ chirc ndng mé phdng xac suét xuc xac.
Coin Toss: Coin Toss la chirc nang md phdng xac suét tung déng xu.
Number Line: Number Line d&ng ky t6i da ba phwong trinh hodc bat

phwong trinh va hién thj cac truc sé cla chung.
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Circle: Circle s&r dung db thj Unit Circle ho&c Half Circle dé hién thj cac
gia trj goc va lwong giac. Ban ciing c6 thé st dung d6 thj Clock dé hién thi
goc.

| Dice Roll

Dice Roll thuc hién mé phéng mét, hai, hodc ba xic xac do tung mot sb
lan xac dinh. Ban c6 thé chon mét trong hai man hinh sau day dbi véi két
qua.

N D
] E C Sum
i i = 4 11
2 4 3 & 13
32 2 5 1 39
d 1 & & 13

Man hinh List

Suéﬁﬁggq Fe=l Fr
" dEnmmg;aempts

2 33 O.14
C: 1| o.1z4
g

39 0136

0.184
Man hinh Relative Freq

Quy trinh thao tac chung cua Dice Roll

Dé& mé phdng 100 1an tung cla hai xtc x&c. Dbi v&i vi du nay, man
hinh Relative Freq dwoc str dung cho két qué mé phang, hién thi s6 1an
xuét hién (tan sb) va tan sb twong ddi trong sw khac biét vé con sé (0, 1,
2, 3, 4, 5) gitra hai vién xic xac méi lan tung.

1. Nhan ©), chon biéu twong ¢ng dung Math Box, sau d6 nhan @R,
« Thao tac nay sé hién thi menu Math Box.

mDice Roll
@Coin Toss
~Number Line
&Circle

2. Chon [Dice Roll], sau d6 nhan @%.
« Thao tac nay sé hién thj man hinh nhap tham sé.

+T [
Attempts == T
Same Result :0ffe
oExecute

Dice: Chon s6 lwgng xuc xac la 1, 2, hodc 3.
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Attempts: Nhap s6 1an tung xuc x&c (sé 1an thir) dwéi dang gia tri tr 1
dén 250.
Same Result: Cai dat nay thwong 1a Off (cai dat mac dinh ban dau). Dé
biét chi tiét, vui Ibng xem "Cai dat Same Result" (trang 150).
. Chon tirng cai dat menu va céu hinh theo cach ban mudn.
(1) Chon [Dice] va nhan @). Trén menu xuét hién, chon [2 Dice] va nhan
©8).
(2) Chon [Attempts] va nhan @. Trén man hinh nhap xuét hién, nhap
100 va nhan @X. Chon [Confirm] va nhin @R.
(3) D& nguyén [Same Result] 1a Off (cai dat mac dinh ban dau).
. Sau khi tt ca cac cai dat dwoc dat theo cach ban mudn, chon [Execute]
va nhan @K).
« Man hinh hién thj viéc thwc hién mé phdng sé xuat hién, va sau dé
man hinh sé& chuyén sang menu Result Type.

Result Type
List
Relative Freqg L

List: Hién thi danh sach két qua cla ting lan tung (1an tha).*"

Relative Freq: Hién thj sé 1an xuat hién dwa trén két qua tung*? va tan

sb twong dbi cha chang.

*1 Khi ¢6 hai xuc xac, két qua ctia méi lan tung dwoc hién thi cung véi
tdng va hiéu sb ctia méi 1an tung. Khi cé ba xutc xac, két qua cta mbi
lan tung dworc hién thi cung véi tbng s6 ctia méi lan tung.

*2 Két qua (1 dén 6) trong trwdrng hop mot xic xac, tdng (2 dén 12)
hodc hiéu (0 dén 5) clia két qua trong trwong hop hai xdc xac, va
tdng (3 dén 18) cla két qua trong trwerng hop ba xuc xac.

. S dung menu Result Type dé chon dang thirc hién thj két qua.
(1) O day, chung ta mudn hién thj s6 1an xuét hién va tan sé twong ddi,
vi vay chon [Relative Freq] va nhan @R.
« Thao tac nay sé hién thi menu lwa chon [Sum] hoéc [Difference].
(2) O day, chiing ta mudn hién thj hiéu sé trong két qua ctia méi lan
tung, vi vay chon [Difference] va nhan @%.
« Két qua moé phdng dwoc hién thi trén man hinh Relative Freq.

¥t [
Diff|Frea

Attempts
100

Fel Fr
L. 14

28
18
21

0.28
0.1%8

D) M) ==

0.2

0.14

(M&i 1an thuwc hién sé cho két qua khac nhau.)

« D& biét chi tiét vé man hinh két qua mé phdng, vui long xem
"Man hinh két qua Dice Roll" (trang 149).

6. Dé hién thj két qua bang dang thirc khac, hién thi man hinh két qua va

sau dé nhan ®.
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« Thao tac nay sé tré vé menu Result Type, vi vay ban c6 thé I&p lai
bwdc 5 ctia quy trinh nay va thay ddi dang thire hién thj két qua.
7. Néu ban muén thwc hién mé phéng véi cac cai dat khac, nhan O trong
khi menu Result Type dwoc hién thi.
« Thao tac nay sé x6a két qua mé phdng va tré vé man hinh nhap tham
sb. Thwe hién lai quy trinh tlr bwéc 3.
8. Bé thoat Dice Roll, nhdn ® trong khi man hinh nhap tham sé hién thj.
« Thao tac nay sé tré vé menu Math Box.

Lwuy

* Trén man hinh Relative Freq, ban co thé lwu gia tri trong 6 c6t Rel Fr vao bién. Vi du,
néu thwc hién thao tac sau trong buwéc 5 & trén, may sé lwu gia tri trong hang dau tién
clia cot "Rel Fr" vao bién A: €3 — [A=] > [Store]. D& biét chi tiét vé& cac bién sb, vui
ldng xem "Cac bién (A, B, C, D, E, F, x, y, z)" (trang 38).

Man hinh két qua Dice Roll

* Man hinh List

(1) (2)

T

=
1=

-+
-+

B k=
b i T g
B G G 0D

c
ool
(m AL N

(1) M&i hang thé hién moét 1an tung theo tuan tw. Vi du, 1 1a Ian tung dau
tién, 2 1a 1an tung th hai, v.v...

(2) A, B, va C cho biét méi xuic xac dang dwoc st dung. "Sum" |a téng
két qua va "Diff" Ia hiéu sb gitra két qua clia hai xtc xac. Cac cot
xuét hién trén man hinh phu thudc vao sb lwong xdc xac dang duoc
st dung.

1 xUc xac: Chi cot A.
2 xuc xac: Cac cot A, B, Sum, va Diff.
3 xuic xac: Cac cot A, B, C, va Sum.

* Man hinh Relative Freq
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(1) 2) ©)

 suniFrecRel Fri
e e PLTEMPTS

a5 0,14 2500—1(4)

] Pl
diff F9 0. 156,
0. 1845 (5)

(1) Sum ho&c Diff: Thé hién két qua mot xtc xac (Sum: 1 dén 6), tdng
két qua hai xuc xac (Sum: 2 dén 12) hoac hiéu (Diff: 0 dén 5), hodc
tdng két qua ba xuc xac (Sum: 3 dén 18).

(2) Freq: Thé hién s6 1an xuét hién (tan sb) ciia méi két qua tung.

(3) Rel Fr: Thé hién tan sé twong déi (tAn sb chia cho sb 1an tung) cla
két qua tung.

(4) S6 13n thir

(5) Gia tri ctia 6 Rel Fr dwoc danh dau

Cai dat Same Result

Khi thyec hién mé phdng Dice Roll hoac Coin Toss vé&i Same Result & cai
d&t mac dinh ban dau (Off), méi 1an thwc hién sé hién thi két qua (ngau
nhién) khac nhau. Néu cai dat Same Result dwoc thay dbi khac vai Off,
két qua hién thi la két qua duwoc xac dinh b&i may tinh. St dung cai d&t
#1, #2, hoac #3 s& hiru ich khi ban mudn tat ca cac may tinh sinh vién st
dung trong I&p hién thi cing mot két qua.

Lwuy

+ D& c6 nhiéu may tinh hién thi cing mot két qua, hay dam bao ring cac cai dat dudi
day gibng nhau trén tat ca cac may tinh.
- S6 lwong xtc xac hodc ddng xu
- S6 lan thr (tung xUc xac ho&c tung ddng xu)
- Cai dat Same Result (#1, #2, hoac #3)

| Coin Toss

Coin Toss thwc hién mé phdng mét, hai, hodc ba déng xu do tung mot sé
lan xac dinh. Ban c6 thé chon moét trong hai man hinh sau day déi voi két
qua.

Vo @
& E C .
i [m] [ ] [ ] =2
2 - - o 2
3 o o L 1
A [m] [m] [m] 0
Man hinh List
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o [
Side|Frea|Rel Fr
oo e g | AL tEMP LS

1| 0| o.26|250

.. 95 0.38
.3 34| 0.136

0.124
Man hinh Relative Freq

Man hinh sé& hién thj mat nglra 1a ® vamatsipla O.

Quy trinh thao tac chung cua Coin Toss

Dé& mo phdng 100 1an tung ba déng xu. Dbi v&i vi du nay, man hinh
Relative Freq dwoc str dung cho két qua mé phdng, thé hién sé lwong céac
mat nglra (0, 1, 2, 3) va tan sé twong dbi clia cac mét nglra cia méi lan
tung.

1. Nhan ©), chon biéu twong ng dung Math Box, sau d6 nhan @R,
« Thao tac nay sé hién thi menu Math Box.

mDice Roll
@Coin Toss
~Number Line
&Circle

2. Chon [Coin Toss], sau d6 nhan @R,
« Thao tac nay sé hién thj man hinh nhap tham sé.

T [

Coins 1T -
Attempts 5 -
Same Result :0ffe
oExecute

Coins: Chon sb lwgng dong xu la 1, 2, ho&c 3.
Attempts: Nhap s6 lan tung ddng xu (sé 1an thir) dwdi dang gia tri tir 1
dén 250.
Same Result: Cai dat nay thuwdong la Off (cai dat mac dinh ban déu). pé
biét chi tiét, vui long xem "Cai dat Same Result" (trang 150).
3. Chon tirng cai d&t menu va cau hinh theo cach ban muédn.
(1) Chon [Coins] va sau d6 nhan @. Trén menu xuét hién, chon [3
Coins] va sau d6 nhan @X.
(2) Chon [Attempts] va nhan @. Khi man hinh nhap xuét hién, nhap 100
va nhan @). Chon [Confirm] va nhan @R.
(3) D& nguyén [Same Result] 14 Off (cai dat mac dinh ban dau).
4. Sau khi tat ca cac cai dat dwoc dat theo cach ban mudn, chon [Execute]
va nhén @).
« Man hinh hién thj viéc thwc hién mé phdng sé xuét hién, va sau do
man hinh sé& chuyén sang menu Result Type.
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Result Type
List
Relative Freq

List: Hién thj danh sach cac mat ngtra hodc mat sap*! dbi véi méi 1an

tung (1an thar).

Relative Freq: Hién thj sb 1an xay ra dbi véi mbi déng xu xuét hién mat

nglra,*? va tan sb twong dbi ctia chang.

*1 Khi c6 hai hodc ba ddng xu thi sé& hién thi s lwong déng xu xuét hién
mat ngtra méi lan tung.

*2 Pbi véi hai hoac ba déng xu. Khi cé mét ddng xu, man hinh nay sé
hién thi tAn sb cia mé&t nglra va mat sap va tan sé twong déi.

5. St dung menu Result Type dé chon dang thirc hién thj két qua.

O day chung ta mudn hién thi s6 14n xuét hién va tan sé twong dbi, vi

vay chon [Relative Freq] va nhan @%).

« Két qua mod phéng dwoc thé hién trén man hinh Relative Freq.

]
Side|Frea|Rel Fr

Attempts
100

0.33
0.47

0.1

0.09

(M&i 1an thuc hién sé cho két qua khac nhau.)

« D& biét chi tiét vé man hinh két qua mé phdng, vui ldng xem "Man
hinh két qua Coin Toss" (trang 152).
6. Dé hién thj két qua bang dang thirc khac, hién thi man hinh két qua va
sau dé nhan ®.
« Thao tac nay sé tré vé menu Result Type, vi vay ban c6 thé 13p lai
bwdc 5 cta quy trinh nay va thay ddi dang thirc hién thi két qua.
7. Néu ban mudn thwc hién mé phéng véi cac cai dat khac, nhan S trong
khi menu Result Type dwoc hién thi.
« Thao tac nay sé xda két qua mé phdng va tré vé man hinh nhap tham
sb. Thwe hién lai quy trinh tlr bwdce 3.
8. Dé thoat Coin Toss, nhan 3 trong khi man hinh nhap tham sé hién thi.
« Thao tac nay sé tré vé menu Math Box.

Lwuy

« Trén man hinh Relative Freq, ban c6 thé lwu gia tri trong 6 cot Rel Fr vao bién. Vi du,
néu thyc hién thao tac sau trong buwéc 5 & trén, may sé lwu gia tri trong hang dau tién
cla cot "Rel Fr" vao bién A: @ — [A=] > [Store].

Man hinh két qua Coin Toss

* Man hinh List
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WD [

i A B C L
i o L] ] 2
2 0w ] u] 2
ap o ] " 1
ap o o o u]

(1) M&i hang thé hién mét [an tung theo tuan tw. Vi du, 1 1a lan tung dau
tién, 2 la 1an tung the hai, v.v...

(2) A, B, va C cho biét méi ddng xu dang duoc st dung. Khi st dung
hai hodc ba ddng xu, cot @ bén phai sé hién thj sé lwong dong xu
xuét hién mat ngtra.

* Man hinh Relative Freq

(1 @) @)

: e @0 :
iSideg;Fr‘e-zl:Hel Fr;' Attempts
oil N os50e— |- (4)

P e.2if 95 O.3&
P o3l 341 00136
0.124%(5)
(1) Side: Khi chi str dung mét ddng xu thi " @ " biéu thi m&t nglra trong
khi " O" biéu thi m&t sap. Khi str dung hai hodc ba déng xu, cot nay
sé& hién thj s mat ngtra (0 dén 3).
(2) Freq: Thé hién s6 1an xuét hién (tan sb) ciia méi két qua tung.
(3) Rel Fr: Thé hién tan sé twong déi (tan sé chia cho sb 1an tung) cla
két qua tung.
(4) S6 13n ther
(5) Gia tri ctia 6 Rel Fr dwoc danh dau

| Number Line

Number Line d&ng ky t6i da ba phwong trinh hoac bat phwong trinh va
hién thj cac biéu dé truc sb clia chung. Dwdi day |a cac loai biéu thire co
thé dwoc chon.

x<a, x<a, x=a, x>a, x=a, a<x<b, asx<b, a<x<b, a<x<b
Céc gia tri ban nhap vao cho a va b trong cac biéu thirc & trén phai nam
trong mién nhw dwoc xac dinh duéi day.

-1x10'° < a2 < 1x10"°

-1x10'° < b < 1x10"°

Quy trinh thao tac chung ciaa Number Line
Vi du: D& dang ky ba bat phwong trinh sau va hién thi biéu dé truc sé cta

chung: x<-1,5, x>-1,0, -2,0<x<-0,5
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1. Nh&n ©), chon biéu twong &ng dung Math Box, sau d6 nhan @%.
« Thao tac nay sé hién thi menu Math Box.

mDice Roll
@Coin Toss
~Number Line
#Circle

2. Chon [Number Line], sau dé nhan @¥).
« Thao tac nay sé hién thi man hinh déng ky biéu thirc.

Yo [
B:
cC:
@Execute

¥y

3. Thwc hién cac buéc dusi day dé dang ky x<-1,5 cho Truc A.
(1) Chon [A:], sau d6 nhan ©X.
(2) Trén danh sach loai biéu thirc xuét hién, chon [x<a] va nhan @®.

Yo E
XZa

eConfirm

(3) Nhép -1,5 cho a.

v E
®%a

OOENO®

(4) Sau khi chac chan rang [Confirm] dwoc chon, nhan @),

Vo O
Aix%-1.5

¥

0

L4

OExecute

4. Str dung céac buwdec trinh bay trong buéc 3 dé dang ky x>-1,0 cho Truc B
va -2,0<x<-0,5 cho Truc C.

Vo @

B]> [>al g %3715
DO OB ® [

OExecute

T R

@G[)C:P[gﬁ:] S:fi’-}.g
((-)200@® [Bix>-1.0 -
®O(()005® ® |rar e E—

LA

5. Sau khi ban hoan tat d&ng ky tat ca cac biéu thirc, chon [Execute] trén
man hinh dang ky biéu thirc, sau d6 nhan @&).
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« Thao tac nay sé hién thj man hinh biéu db truc sé. Ban c6 thé st
dung < va & dé cudn biéu dé truc sb sang trai hoac phai.

AL |:
! * . ' |: (1)
NI R nd'ﬁ;: (2)
Aix<9TS |

(3)

(1) Thé hién céc truc sé cla cac phwong trinh hodc bat phwong trinh
dwoc dang ky trong cac truc A, B, va C theo thr tw tv trén xudng
dwéi. Y nghia ctia mii tén («—, —) va vong tron (@, O) hién thj &
mot trong hai dau cla truc sé dwoc mo ta dwdi day.

«— Cho biét su tiép tuc ciia mot mién nhd hon a trong bat phwong
trinh x<a, hodc moét mién nhd hon hodc bang a trong x<a.
— Cho biét sw tiép tuc ctia mot mién Ién hon a trong bat phwong
trinh x>a hodc moét mién Ién hon hodc bang a trong x>a.
@ Cho biét gia tri nay (trong trworng hop phuwong trinh) hodc cé bao
gdm gia tri nay (trong trwdng hop bat phwong trinh).
O Cho biét khdng c6 bao gom gia tri nay (trong trwéng hop béat
phwong trinh).
(2) Truc x. Truc nay hién thj gia tri trung tam va mét trong hai gia tri du.
(3) Hién thj cac phwong trinh hodc bat phwong trinh cda truc sé dang
chon (truc sé dang dwoc hién thi in dam). D& hién thi mét biéu thirc
truc sé khac, st dung ® va » dé di chuyén phan té6 dam dén truc
so ¢ biéu thiee ban mubn xem.
6. Dé thay dbi biéu thire, hay hién thi man hinh biéu db truc s va sau do
nhan .

« Thao tac nay sé tré vé& man hinh dang ky biéu thirc. Ban chi c6 thé
thay ddi gia tri cia mét biéu thirc da dang ky, hodc ban c6 thé dang
ky lai loai biéu thirc khac. Dé biét thong tin vé cach thuc hién thao tac
nay, vui ldng xem "Stra déi biéu thirc da ding ky" (trang 155).

7. Dé thoat Number Line, nhan ® trén man hinh dang ky biéu thac.

« Thao tac nay sé x6a biéu thirc da dang ky va tré lai menu Math Box.

Quan trong!
+ Néu ban thay dbi cai d&t Angle Unit trén menu SETTINGS, tat ca cac biéu thirc da

dang ky trong Number Line sé bj xéa.

Stra d6i biéu thirc da dang ky

Dé stra déi biéu thirc da ding ky
Vi du: Dé thay dbi biéu thirc trong Truc C (-2,0<x<-0,5) thanh -1,5<x<0,5
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1. Trén man hinh dang ky biéu thirc, chon Truc C va sau d6 nhan @&).
2. Trén menu xuét hién, chon [Edit] va sau d6 nhan @R,
3. Nhap -1,5 cho a va 0,5 cho b.

®O((-))1O5@050

4. Sau khi chac chan rang [Confirm] dwoc chon, nhan @R,

Pé dang ky lai loai biéu thirc khac
Vi du: Bé thay ddi biéu thirc trong Truc A (x<-1,5) thanh x=-1,5
1. Trén man hinh dang ky biéu thirc, chon Truc A va sau d6 nhan @X).
2. Trén menu xuét hién, chon [Define New] va sau d6 nhan @X.
3. Trén danh séach loai biéu thirc xuat hién, chon [x=a] va nhéan @).
4. Nhap -1,5 cho a.
®O((MNMO5®

5. Sau khi chac chan rang [Confirm] dwoc chon, nhan @K).

Dé xo6a biéu thirc da dang ky
Trén man hinh dang ky biéu thirc, chon biéu thirc da dang ky ma ban
mudn x6a, sau d6 nhan @.

Thay d6i pham vi hién thi ctia man hinh biéu dé truc sé (View-
Window)

Khi ban dang ky mét biéu thire va hién thi man hinh biéu d6 truc sb, cac
cai d&t pham vi hién thj tdi wu s& dwoc cu hinh ty déng. Ban cé thé thay
ddi pham vi hién thj bang cach thay dbi cai dat Center (1) va Scale (2) cua
truc x. St dung man hinh View-Window dé thay dbi cai dat pham vi hién
thi.

"I T T
-2.6 1.2 Y 0.d

Aix<-1.5

(2)

Vi du: Dé thay dbi cai dat Scale cta truc x thanh 1 va cai dat Center thanh
2, va hién thi biéu dd truc sbé

1. Hién thi man hinh biéu db truc sé.
2. Nhan €9, chon [View-Window], sau d6 nhan @R.
« Thao tac nay sé hién thi man hinh View-Window.

+o [
Scale :0.72
Center:-1.2
OExecute
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3. Nhap 1 cho [Scale] va 2 cho [Center].

+o [
Scale :1

Center:2
1020

4. Sau khi chdc chan rang [Execute] dwoc chon, nhan @R.

I i
»
1A
1
—
n

Lwuy

« Gia tri tbi da va t6i thiéu cho truc x phu thudc vao cai dat Center va Scale nhw trinh
bay duéi day.
Gié trj toi da: (Gia tri Center) + (Gia tri Scale) x 8
Gia trj toi thiéu: (Gia tri Center) - (Gia tri Scale) x 8
« Sau khi thay déi cai d&t View-Window, ban c6 thé khéi phuc cai dat Center va Scale
vé cai dat pham vi hién thi dwoc ciu hinh tw déng bang cach thuc hién thao tac: =
[View-Reset].
« Céc gia tri ban nhap cho Scale va Center phai nam trong pham vi dwoc xac dinh dudi
day.
1%x107° < Scale < 1x10°
-1x10'% < Center < 1x10™°

| Circle

Circle cung cép cac ham dwgc md ta sau day, co thé dwoc st dung dé tim
hiéu vé géc va cac ham lwong giac.

« D6 thi Unit Circle va Half Circle

D6 thj Unit Circle hién thi dwong tron hoan chinh véi ban kinh 1, trong khi
dd thi Half Circle hién thi mét ntra dwdng tron véi ban kinh 1. Ca dwong
tron hoan chinh va mét nlra dwéorng tron déu cé tam la gbe toa dd hinh chi
nhat. Cac hinh bén dwdi thé hién tirng loai dwéng tron véi cac goc 61 va
62, cung v&i cac gia tri ham lwgng giac.

Vi [
g1 sin@1=l021.2
cosal=l2) 42
* tandl=1
81:45
Unit Circle
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g Sing1=lC21.2
? cosAl=l021.2
* tand1=1

81:45

Half Circle

« P4 thi Clock
D4 thi Clock c6 thé dwoc str dung dé hién thi hai géc ma kim gi® va kim
phat hinh thanh tay thudc vao thdi gian trong ngay. Hinh bén duéi thé
hién d6 thi ddng hd v&i cac goc 91 va 62. Trong dd thi nay, vi tri ctia kim
phut dwoc ¢b dinh tai 12 gio.
Vo @

+ 3:00
81:90
82:270
81=62

Clock

Quy trinh thao tac chung cua Circle

1. Nh&n ©), chon biéu twong ng dung Math Box, sau d6 nhan @%.
« Thao tac nay sé hién thi menu Math Box.

=Dice Roll
3Coin Toss
~Number Line
#Circle

2. CAu hinh cai d&t Angle Unit theo yéu cau.

« Ban c6 thé chon mét trong cac don vi sau day dé nhap gia tri goc:
Degree, Radian, Gradian. Vui ldbng xem "Thay déi cai dat cia may
tinh" (trang 21).

3. Chon [Circle], sau d6 nhan @).
« Thao tac nay sé hién thi man hinh nhap tham sé.

¥ [
Type:Unit Circler
81 :

82

eExecute

« Néu ban mudn chon Unit Circle cho quy trinh nay, ban c6 thé tién
hanh truc tiép dén budc 5. (Trong trwdng hop nay, nhan ) dé chon
[01] & budc 5.)
4. Chon loai Circle ban muén st dung.
(1) Chon [Type], sau d6 nhan @).
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(2) Trong danh séach loai xuat hién, chon [Unit Circle], [Half Circle], hodc
[Clock] va sau d6 nhan @R.
« Néu ban da chon [Unit Circle] ho&c [Half Circle], ban c6 thé tién
hanh truc tiép dén budc 5.
« Néu ban chon [Clock], hay thyc hién buéc 6.
5. Nhap cac goc [91] va [62].
+ Khi nhap mét gia tri géc, str dung don vi cho cai dat Angle Unit dang
chon.
« Vi du, thue hién thao tac dwéi day dé nhap 45° cho [91] va 135° cho
[602] (Angle Unit: Degree).

v [
Type:lUnit Circler

81 :45
45@1350 82 135

« V& mién dau vao cho phép dbi véi cac gia tri géc, vui long xem "Lwu
y" bén duei.
6. Sau khi chic chan rang [Execute] dwoc chon, nhan @R.
« Thao tac nay sé hién thj man hinh dé thi.

+o @

Py 51 BINE1=T020.2
cosal=l02) 42
- > tandl=1
81:45

« Tham khao cac phan duéi day dé biét théng tin vé cach xem man
hinh d6 thj va thwc hién thao tac.
"Man hinh dé thi Unit Circle va Half Circle" (trang 160)
"Man hinh dé thj Clock" (trang 160)
7. Nhéan (® dé tré vé man hinh nhap tham sé tr man hinh dé thi.
8. Dé thoat Circle, hay hién thi man hinh nhap tham sb va sau d6 nhan ®.
« Thao tac nay sé tré vé menu Math Box.

Lwuy

+ Bang dwéi day thé hién mién dau vao cho phép ddi véi cac gia tri ban nhap vao &
buwéc 5 & trén.

Cai dat Angle Unit Unit Circle Half Circle
Degree 0<0=<180
Radian -10000 < 6 < 10000 0<f=sr*

Gradian 0<6<200

* 3,1415926535897932384626
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Man hinh d6 thi Unit Circle va Half Circle

Unit Circle va Half Circle sé& xu4t hién nhw hinh dwdi day. Phan hién thi
mau dwdi day 1a khi cac gia tri cho cé 01 va 62 da dwoc nhap vao.

T ——

Py g iSing1=ri2oa
icosg1=rc23.2 O——(3)
#-t> itang=] =

e1:45¢
|

(1) (2)
Unit Circle

o lsingl=ro2aaz
| icosgl=rc2r2 O——(3)
ST tangt=1 ’

1:45¢
|

(1) (2)
Half Circle

(1) Cac dudng tao thanh goc [01] va [02]. Pwdng dang dwoc chon dam
hon dwéng con lai. Ban c6 thé thay dbi chon gitra 81 va 62 bang
cach nhan ® hodc V.

(2) Gia tri géc ctia goc cua dwong dang dugc chon (61 hoac 62).

(3) Cac gia tri ham lwgng giac ctia goéc cua dwong dang dwoc chon (61
hoac 62).

Lwuy

« Khi chi nhap mét géc duy nhét (91 hodc 62), mot dwdng dam duy nhat sé dwoc hién
thi dé tao thanh géc. Trong trwd'ng hop nay, gia tri géc ctia goc duy nhat dwoc hién thi
cho (2), va céac gia tri ham lwong giac ctia géc dwoc hién thi cho (3).

« Trén man hinh db thi, cac gia tri cha cac ham lwgng giac dwoc hién thi theo nhw cac
cai dat cta Input/Output va Angle Unit.

» Khi Mathl/MathO hoac Mathl/DecimalO dwgc chon cho Input/Output, cac gia tri lwgng
giac c6 thé bao gém gia tri phan sb hodc V' néu thich hop.

Vi du: sin (45) = V2/2, cos (30) = V3/2 (Angle Unit: Degree)

Man hinh d6 thi Clock
Vi du dwéi day thé hién man hinh dé thj Clock.
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(T)

* 3:000—(2

8190
82:270 ¢ 1O
81<52

(1) D6 thi ddng hé. Clock ban dau ludn biéu thi 12 gio.

Nhan ® dé tang kim gi® thém mét gio hodc ) dé i tré lai.
(2) Thoi gian dwoc thé hién béi ddng ho.
(3) 01: Géc nhé hon gilra kim gio va kim phat.

62: Goc lon hon gitrba kim gi& va kim phat.

Lwuy

« Gi4 tri géc dwoc hién thj theo cai dat Input/Output va Angle Unit.
« Néu Radian dwoc chon cho Angle Unit va Mathl/MathO dwgc chon cho Input/Output,
gia tri goc sé duoc hién thi & dang thirc 7.
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Thong tin ky thuat

LOi

May tinh sé& hién thi théng bao 16i mdi khi 16i xuat hién b&i bat ky ly do nao
trong qua trinh tinh toan.
| Hién thi vi tri 16i

Khi thédng bao 16i hién thi, nhan @), 5, hodc @9 dé tré& vé man hinh hién
thi ngay truéc khi théng bao 16i xuét hién. Con tré sé dwoc dinh vj tai vi tri
noi 16i xuét hién, sén sang cho viéc nhap. Hay thuc hién nhirng sira chiva
can thiét cho tinh toan va thwc hién lai phép tinh.

Khi ban nhap nham 14 + 0 x 2 thay vi 14 + 10 x 2.

7 O
Math ERROR

140269 &
Back |

14<0Kk2
@ (hodc ® hoac ®0)

=g
14--10%2

1@

| Théng bao 16i

Syntax ERROR

Nguyén nhan:

« C6 van dé véi dang thire clia tinh toan ban dang thuwc hién.
Hanh dong:

« Thwc hién thao tac stra chira can thiét.

Math ERROR

Nguyén nhan:

« Két qua trung gian hay cudi cuing clia tinh toan ban dang thwc hién
vuot qua mién tinh toan cho phép.

« D4u vao cla ban vuot qua mién dau vao cho phép (dac biét khi dung
cac ham).
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* Tinh toan ban dang thwc hién chira thao tac toan hoc khéng hgp thirc
(nhw chia cho khong).

« Trong khi st dung &ng dung khéng hd tro s phirc hodc khi man hinh
khéng chap nhan nhap sb phirc dwoc hién thj, ban da cb thwc hién
phép tinh chira mét bién c6 lwu sé phurc.

« Khi Verify dwoc bat (Verify ON) trong khi str dung trng dung Complex,
ban da nhap vao moét bat phwong trinh cé chiva sé phurc.

Hanh dong:

« Kiém tra cac gia tri nhap, giam bét sb chir sb, va thi lai.

« Khi dung mét bién lam dbi sé cho ham, hay chac chan rang gia tri
bién nam trong mién cho phép dbi véi ham dé.

« D& thuc hién phép tinh bao gdm moét bién c6 lwu sé phirc, khi st
dung &ng dung khéng hd tro' s phirc hodc khi man hinh khéng chap
nhan nhap sb phirc dwoc hién thi, hay thay dbi gia tri dwoc lwu cho
bién thanh sé thuec.

« Ban khong thé s&r dung Verify trong rng dung Complex dé xac dinh
xem mot bat phwong trinh chira sé phirc cé dung hay khéng. Ban cé
thé xac dinh tinh dung dan ctia mét phwong trinh cé sé phirc.

Stack ERROR

Nguyén nhan:

« Tinh toan ban dang thwc hién da lam dung lvgng chéng sb hoac
chong lénh bi vuot qua.

 Tinh toan ban dang thwc hién da lam cho dung lvgng chéng ma tran
hodc chéng véc-to bi vwot qua.

Hanh déng:

« Don gidn hoa biéu thirc tinh toan dé khong vuwot qua dung lwong
chéng.

« Thir chia phép tinh thanh hai hay nhiéu phan.

Argument ERROR

Nguyén nhan:

« C6 van dé véi dbi sé ciia phép tinh ban dang thuc hién.
Hanh dong:

« Thwc hién thao tac stra chira can thiét.

Dimension ERROR (Chi c6 & cac irng dung Matrix va Vector)

Nguyén nhan:
« Ban dang c6 gang thyc hién tinh toan véi ma tran hay véc-to ¢é chiéu
khéng dwoc phép cho kiéu tinh toan dé.
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Hanh dong:
« Kiém tra cac chiéu dwoc xac dinh cho ma tran hay véc-to' dé xem liéu
chung co twong hep voi tinh toan khéng.

Variable ERROR (Chi c6 & tinh nang Solver cua trng dung
Equation)

Nguyén nhan:

« Cb gang thuc hién Solver cho dau vao biéu thirc khéng chiva bét ky
bién nao.

Hanh déng:

« Nhap biéu thirc cé chira mot bién.

Cannot Solve (Chi c6 & tinh nang Solver cua trng dung
Equation)

Nguyén nhan:

« May tinh khéng thé thu dwoc nghiém.

Hanh déng:

« Kiém tra cac 16i trong phwong trinh ban nhap.

« Dwa vao moét gia trj cho bién nghiém gan véi nghiém dwoc mong doi
va thir lai.

Range ERROR

Nguyén nhan (trng dung Table):

« Cb gang tao ra bang sb trong &rng dung Table v&i diéu kién 1am cho
bang vuwot qua sé hang tdi da cho phép.

Hanh déng:

« Thu hep mién tinh toan cta bang bang cach thay dbi Start, End, va
nhirng gia tri Step, réi thi lai lan nia.

Nguyén nhan (rng dung Spreadsheet):

« Trong qué trinh nhap hang loat trong &ng dung Spreadsheet, dau vao
cho Range nam ngoai mién cho phép hoac 1a tén 6 khong tén tai.

Hanh déng:

« D6i v&i Range, nhap mét tén 6 trong mién t A1 dén E45, st dung cu
phap: "A1:A1".

Nguyén nhan (irng dung Math Box):

« Gia tri dau vao nhuw Attempts (s6 1an thir) cho Dice Roll hodc Coin
Toss ndm ngoai mién cho phép hoac 1a gia tri khdng phai sé nguyén.

« Gié tri dau vao trén man hinh dang ky biéu thirc cia Number Line
nam ngoai mién cho phép, hodc ban da nhap mét bat phuwong trinh
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véi mbi quan hé gia tri &n nhét - gia tri nhé nhat khéng hop 1& (nhw
10 <x < 5).

« Gia tri dau vao trén man hinh View-Window ctia Number Line ndm
ngoai mién cho phép.

Hanh déng:

- Déi v&i Attempts, nhap mét gia tri sé nguyén nam trong mién cho
phép.

« Trén man hinh dang ky biéu thirc, nhap gia tri nam trong mién cho
phép. Trong trwdng hop bat phwong trinh da nhap c6 mébi quan hé
gia tri I&n nhét - gia tri nhd nhat khdng hop 18, hay stra bat phuong
trinh dé diéu chinh méi quan hé gia tri I&n nhét - gia tri nhé nhét.

« Trén man hinh View-Window, nhap cac gia tri ndm trong mién cho
phép.

Time Out

Nguyén nhan (tinh toan vi phan hoac tich phan):

« Két thuc tinh toan vi phan hay tich phan hién tai ma khéng dap (ng
du diéu kién két thuc.

Hanh dong:

« Thir tdng gia tri tol 1&n. Lwu y rang diéu nay cling lam gidm dé chinh
xac cua nghiém.

Nguyén nhan (rng dung Distribution):

« Két thuc tinh toan phan phd hién théi chdm dit ma khéng dap rng dd
diéu kién két thuc.

Hanh dong:

« Thay déi gia tri cGa tirng tham sé.

Circular ERROR

Nguyén nhan (tinh nang f{(x) va g(x)):

« Tham chiéu vong xay ra trong ham hop da dang ky ("Pang ky ham
hop" (trang 71)).

Hanh déng:

* Khéng dwoc nhap g(x) vao f(x), va nhap f(x) vao g(x) cung mét luc.

Nguyén nhan (rng dung Spreadsheet):

« C6 tham chiéu vong (chang han nhuw "=A1" & & A1) trong bang tinh.

Hanh dong:

« Thay dbi néi dung trong & dé loai bd tham chiéu vong.
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Memory ERROR (chi c6 & trng dung Spreadsheet)

Nguyén nhan:

« Ban dang cb nhap di¥ liéu vwot qua dung lwong dau vao cho phép
(1.700 byte).

« Ban dang cb nhap di¥ liéu d&n dén mét chudi tham chiéu 6 lién tiép
(nhw 6 A2 tham chiéu tr 6 A1, 6 A3 tham chiéu tor 6 A2, v.v...) Loai
dau vao nay ludn gay ra 16i trén, ngay ca khi khédng vwot qua dung
lwong bd nhé (1.700 byte).

Hanh dong:

« X6a di¥ liéu khéng can thiét va nhap lai di liéu.

« Han ché téi da dir lieu dau vao dan dén mot chudi tham chiéu 6 lién
tiep.

No Operator (chi cé & irng dung Calculate va Complex)

Nguyén nhan:

« Ban da nhap mét biéu thirc khéng chira toan tlr va cb gang xac dinh
xem co dung hay khong.

Hanh déng:

« Nhap mét phwong trinh hodc bat phwong trinh, sau dé xac dinh xem
c6 dung hay khong.

Not Defined

Nguyén nhan (tinh nang f{x) va g(x)):

« Ban da cb tinh f{x) hodc g(x) v&i fix)/g(x) khdng xac dinh.

Hanh ddng:

» Xac dinh f{x) hoac g(x) truwdc khi tinh f{x)/g(x).

Nguyén nhan (rng dung Matrix va Vector):

* Ma trén hay véc-to ban dang dinh dung trong tinh toan da dwoc dwa
vao ma khéng xac dinh chiéu cta no.

Hanh déng:

« Xac dinh chiéu ctia ma tran hay véc-to’ va réi thuc hién lai tinh toan.

Trwée khi xac dinh may tinh gap truc
trac...

Lwu y réng ban phai sao chép di liéu quan trong thanh cac ban sao riéng
trwde khi thwe hién cac bwdc nay.
1. Kiém tra biéu thirc tinh toan dé dam bao rang né khéng chira 16i ndo.
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2. Dam bdo rang ban dang dung ding tng dung may tinh cho kiéu phép
tinh ban mudn thwc hién.

« D& kiém tra ’ng dung may tinh ban dang st dung, nhan @. Thao tac
nay sé& danh dau biéu twong ctia 'ng dung may tinh hién dang duoc
st dung.

3. Néu cac budc trén khong gidi quyét dwoc van dé cia ban, nhan phim
O.

* Thao tac nay sé lam cho may tinh thyec hién mot quy trinh kiem tra
xem cdac chirc nang tinh toan c6 hoat ddng chinh xac hay khéng. Néu
may tinh phat hién bat ky b4t thwéng nao, may sé tw khéi dong trng
dung may tinh va x6a néi dung b6 nho.

4. Pwa céac cai dat cia may tinh (ngoai trir Contrast, Auto Power Off, va
Language) vé cai dat mac dinh ban dau bang cach thwe hién quy trinh
dwdi day.

(1) Nhan ©®), chon biéu twong rng dung may tinh, sau dé nhan @R.
(2) Nhidn ®), sau d6 chon [Reset] > [Settings & Data] > [Yes].

Thay thé pin

Néu man hinh hién thi dwéi day xuét hién ngay sau khi ban bat nguén, cé
nghia la ngudn pin con lai yéu.

AW

Pin yéu dwoc chi bao b&i hién thi me, cho du da diéu chinh d6 twong
phan, hay dwoc chi bao bdi viéc khéng hién hinh trén man hinh hién thj
ngay sau khi ban bat may tinh.

Néu diéu nay xay ra hodc man hinh trén xuét hién, hay thay pin bang pin
mai.

Quan trong!

» Viéc thao pin sé& lam cho tat ca ndi dung bd nhé ctia may bj xéa.

1. Nhan ® @9 (OFF) dé tat may tinh.
« D& dam bao réng ban khéng tinh c& bat nguén 1én trong khi thay pin,
hay gan nap trwdc vao phia trwdc clia may tinh.
2. Thuc hién nhu thé hién trong hinh minh hoa, hay thao nép pin, thao pin,
sau d6 1&p mét pin méi dung cuc dwong (+) va cwc am (-).
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3. Lap lai nap pin.

4. Nhan ( dé bat may tinh.

5. Kh&i ddng may tinh.
(1) Nhéan @), chon biéu twong (rng dung may tinh, sau d6 nhan @&).
(2) Nhadn @), sau d6 chon [Reset] > [Initialize All] > [Yes].
» Brng boé qua cac buérc trén!

Trinh tw wu tién tinh toan

May tinh thie hién cac phép tinh theo trinh tw wu tién tinh toan.

« V& co ban, cac phép tinh dwoc thye hién ti trai sang phai.
« C4c biéu thirc trong ddu ngodc don cé mirc wu tién cao nhéat.
« Sau day la trinh tw wu tién cho méi Iénh riéng 1é.

1 Biéu thirc trong ngoéc don
Céac ham cé dau ngoac don (sin(, log(, f(, g(, V.v..., cac ham
2 c6 dbi s6 & bén phai, cac ham can c6 dau ngodc déng sau
d6i sb)
Céac ham di sau gia tri nhap (x%, x, x7, x!, 7, °, ", 8, %, »1),
3 cac ky hiéu ky thuat (m, x4, n, p, f, k, M, G, T, P, E), lly thtra
(x¥), can (VD)
4 Phan sb
5 D4u am ((-)), Base Prefix (d, h, b, o)
6 Cac Iénh chuyén déi don vi (cmwin, v.v...), Cac gia tri wéc

lwong trong (rng dung Statistics (x, 7, X1, X2)
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7 Phép nhan bé di dadu nhan

Phép hoan vi (nPr), phép t6 hop (nCr), ky hiéu toa dd cuc sb
phic (2)

9 Tich vb6 huwéng (¢)

10 Phép nhan (x), phép chia (+), phép tinh sb dv (+R)

11 Phép cbéng (+), phép trwr (-)

12 and (toan t& logic)

13 or, xor, xnor (toan tt logic)

Néu phép tinh chtra gia tri &m, ban cé thé can phai dat gia tri am trong
d4u ngoéc don. Vi du, néu ban mudn binh phwong gia tri bang -2, ban
can nhap: (-2)2. Ly do Ia vi x2 1a ham di sau mét gia tri (W tién 3, & trén),
c6 mirc wu tién Ién hon dau am, 1a mét ky hiéu tién t6 (Uu tién 5).

®O((-)2@ e -22=-4
O®ONRO@E® (-2)>=4

Mien tinh toan, s6 chir s6 va do
chinh xac

Mién tinh toan, s chir sé dwoc dung cho tinh toan ndi bod, va dd chinh xac
ctia phép tinh phu thudc vao kiéu phép tinh ban dang thwc hién.

| Mién tinh toan va do chinh xac

s i +1 x 1099 d@én +9,999999999 x 10%° hoic
Mién tinh toan

0

S6 chi¥ sé cho tinh toan L.

A 23 chir sO

ndi bd
N6i chung, +1 & chir s6 th& 10 cho mét
tinh toan don. PO chinh xac cho hién thj

D6 chinh xac s6 mii la 1 chi¥ s it quan trong nhét.
L&i tich 10y trong trwdng hop tinh toan lién
tiép.
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| Mién dau vao tinh toan ham va dé chinh xac

Ham Mién dau vao
Degree 0<|x| <9 x10°
sinx .
Radian 0 < |x| < 157079632,7
CoSx
Gradian 0<|x|]<1x10"
Nhw sinx, ngoai trtr khi |x| =
Degree
(2n - 1) x 90.
, Nhw sinx, ngoai trwe khi |x| =
tanx Radian
(2n-1) x /2.
. Nhw sinx, ngoai trt khi |x| =
Gradian
(2n - 1) x 100.
sin"'x, cos™'x 0<|x|<1

tan™'x 0 < |x| < 9,999999999 x 10%
sinhx, coshx 0 < |x| =230,2585092
sinh™x 0 < x| < 4,999999999 x 10%
cosh'x 1 <x<4,999999999 x 10%°
tanhx 0 < |x| £9,999999999 x 1099
tanh™'x 0 < |x| £9,999999999 x 10"
logx, Inx 0 < x <9,999999999 x 10%°
10° -9,999999999 x 10% < x < 99,99999999
Vx 0<x<1x1010

2 x| < 1 x 1050

X! | < 1 x 10190 x # 0

x! 0 <x <69 (x Ia s6 nguyén)
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b 0<n<1x10' 0<r<n(n rlacac sd nguyén)
e 1< {nl(n- )} <1 x 1010
c 0<n<1x10' 0<r<n(n rlacac sd nguyén)
- 1<nll! <1 % 10" hodic 1 < nlf(n - ) < 1 x 10100
Pol(e. ) Ix], [v] < 9,999999999 x 10%
e W2 + 2 < 9,999999999 x 10%
R p 0 < r<9,999999999 x 10%°
ectr, 0) 0: Nhw sinx
la|, b, c <1 % 101%0: 0 < b, ¢
a’b’c” Gia tri giay hién thi c6 sai sb + 1 & vi tri thap phan
thr hai.
0°0’0” < |x| £ 9999999°59°59”
a’b'c’ =x Gia tri luc thap phan ndm ngoai mién trén sé
duwoc ty déng xem la gia tri thap phan.
x> 0:-1x 10" < ylogx < 100
x=0:y>0
¥ <0:p=n, =2 (m, nla cac sb nguyén)
X y n, 2”1 + 1 m, n g y
Tuy nhién: -1 x 10'% < ylog |x| < 100
y>0:x#0,-1% 10" < 1/x logy < 100
y=0:x>0
% y<0:x=2n+1,2”n:1(m;eo;m,nlacécsé
nguyén)
Tuy nhién: -1 x 1019 < 1/x log [y] < 100
b, Toan bd sb nguyén, tir s6 va mau sbé phaila 10
a C ~ X ’ R > « X ~ 7
chir sO hay it hon (ké ca bieu twgng phan tach).
RanInt#(a, b) a<b:lal, [b] <110 b-q<1x10%
GCD(a, b) lal, |b] <1 % 10" (a, b 1a cac s6 nguyén)
LCM(a, b) 0<a,b<1x10' (g, b 1a cac sb nguyén)

« D6 chinh xac vé can ban la nhw da mo ta tai "Mién tinh toan va doé chinh
xac" & trén.
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« Cac ham dang ", \y, x!, nPr, nCr can tinh toan ndi b lién tiép, co thé
tao ra sy tich Idy 16i xuat hién v&i méi tinh toan.

« Sai sb duoc tich luy cé xu huwéng tdng 1én trong 1an can cla diém ki dj
va diém udn ctia ham.

« Mién cho céac két qué tinh toan cé thé dwoc hién thi duwdi dang « khi
Mathl/MathO dwgc chon cho Input/Output trén menu SETTINGS Ia |x| <
108. Tuy nhién, lwu y rdng sai s tinh toan bén trong co6 thé gay ra viéc
khéng hién thi dworc mét sb két qua tinh toan dwéi dang 7. N6 ciing c6
thé 1am cho két qua tinh toan 18 ra phai & dang thap phan lai xuét hién
dwdi dang =.

Pac ta

Yéu cau nguén:
Pin c&@ AAA RO3 x 1

Tuébi tho pin xap xi:
2 nam (trén co s& mot gi® 1am viéc moi ngay)

Tiéu thu dién nang:
0,0008 W

Nhiét do van hanh:
0°C dén 40°C

Kich thwérc:
13,8 (C) x 77 (R) x 162 (D) mm

Trong lwong xap xi:
100 g ké ca pin
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Cau héi thwong gap

Cau haéi thwong gap

m Lam cach nao dé t6i cé thé thay doi két qua dang thirc phan sé
dworc tao b&i phép chia thanh dang thirc thap phan?

— Khi két qua tinh toan dang phan sé dwoc hién thi, nhan @ rdi chon
[Decimal], hodc nhdn ® @) (=). D& két qua tinh toan ban dau xuat hién
dwi dang gia tri thap phan, hay thay dbi cai dat Input/Output trén menu
SETTINGS thanh Mathl/DecimalO.

m Diém khac biét giira bé nhé& Ans, bd nh& PreAns, va bd nhé bién la
gi?

— M@i loai bd nhé trén day déu hoat déng giébng nhw "hdp chira" dé lwu
trir tam thei mot gia tri duy nhét.
B6 nh& Ans: Luu triv két qua ctia phép tinh cubi cung dwoc thuc hién.
Dung bd nhé nay d& mang két qué ctia phép tinh nay sang phép tinh
khac.
B6 nh& PreAns: Luu triv két qua ctia phép tinh dwoc thwe hién truéc
phép tinh cudi cung. B& nhé PreAns chi cé thé duwgc st dung trong trng
dung Calculate.
Bién: B6 nhé nay hiru ich khi ban can st dung cting mét gia tri nhiéu
lan trong mét hodc nhiéu phép tinh.

m Lam cach nao dé toi c6 thé tim thdy mét ham ma téi dang str dung
v&i mau may tinh CASIO cii hon trén may tinh nay?

— C6 thé truy cap cac ham ca may tinh nay tr menu CATALOG xuét
hién khi ban nhdn @. Dé biét chi tiét, vui Idng xem cac phan bén duéi.
"Sr dung Menu CATALOG" (trang 26)

"Tinh toan nang cao" (trang 51)

m V&i mau may tinh cii hon, téi da nhan dé thay déi dang thirc
hién thi két qua tinh toan. Téi nén thao tac thé nao trén may tinh
nay?

— Khi két qua tinh toan dwoc hién thi, nhadn & . St dung menu xuét hién
dé chon dang thirc hién thi ban muén. D& biét chi tiét, vui long xem
"Thay d6i dang thirc két qua tinh toan" (trang 42).

m Lam thé nao dé toi c6 thé tim ra trng dung may tinh té6i dang st
dung?

— Nhan ©). Thao tac nay sé lam cho biéu twong cta (rng dung may tinh
ban dang s&r dung duwgc té6 dam.
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m Lam cach nao dé tinh sin? x

— Vi du, dé tinh sin? 30 = l, hay nhap phép tinh bén duoi.

sif{mamz
300 @ @

1
4

m Tai sao t6i khong thé nhap ® (9 (i) hoac tinh toan mét s6 phirc?
— Ban khéng thé dung (rng dung Calculate d& nhap i hoac thwc hién tinh
toan s phirc. Hay st dung (rng dung Complex cho céc tinh toan nhw

vay.

m Tai sao chi bao Verify (&) khong bién mat?

— Dé& chi bao @ xuét hién trong khi Verify dwoc bat (Verify ON) bién mét,
thwe hién thao tac sau: ¢ — [Verify OFF].
Dé biét thém thdng tin vé Verify, vui long xem "Str dung Verify" (trang
73).

m Tai sao biéu twong pin (C5) xuat hién ngay sau khi bat may tinh?

— Biéu twong pin cho biét nguén pin yéu. Néu ban nhin thay biéu twong
nay, hay thay pin cang s&m cang tét. Dé biét chi tiét vé viéc thay pin, vui
long xem "Thay thé pin" (trang 167).

m Lam sao dé dwa may tinh tré vé cai dat mic dinh ban dau?

— Thuwe hién quy trinh dwéi day dé khéi chay cac cai dat ctia may tinh
(ngoai trir Contrast, Auto Power Off, va Language).
(1) Nh4n ©®), chon biéu twong rng dung may tinh, sau dé nhan @R,
(2) Nhdn ®), sau d6 chon [Reset] > [Settings & Data] > [Yes].
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